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40inch Telescope 

Overview

In the early 1960s, the Australian National University established a new 
astronomical site at Siding Spring in central New South Wales, partly in the 
expectation that it would provide somewhat clearer skies than those at Mount 
Stromlo, and partly to escape the increasing light pollution of the growing 
Canberra. The selection of Siding Spring followed an extensive site-testing 
programme organized by the then Director, Bart Bok. The new site was 
instrumented with three reflectors of modest size, all made by Boller & Chivens. 
The 40-inch is the largest of these, the other two being a 24-inch and a 16-inch. 
The 40-inch is heavily scheduled, and it has proved a useful instrument 
especially for photometric and imaging work.

Specifications

40inch (1.0m), f/5 primary
Ritchey-Chritien optics
Secondaries for f/8 and f/18 Cassegrain imaging ( ~8100mm and 
~18300mm focal length )
German Equatorial mount

Telescope Control

ETS Manual (24,30 & 40in)
Instrument Computer link to ETS

Instruments

Direct Imaging
"Wide Field Imager (WFI)"

Andrew Jacob User Notes
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J. van Harmelen, 17-NOV-1988, V3.1
J. van Harmelen, 1993, V4.0 View Command added
J. van Harmelen, 25 October 1996, V4.1 Configure Command added, general review.
J. van Harmelen, 7 July 1999 V4.2 Other Telescope Commands added
                Autoguide Command added, Status Command added
J. van Harmelen, 12 July 2000 V4.3 Added “Halt” command for small telescope control systems
 

 
 

SPECIFICATION OF A CONNECTION BETWEEN TELESCOPE AND INSTRUMENT
COMPUTERS

          (ETS_LINK)
 
 

 

 

1. SCOPE
This document relates to the connection of stand alone instrument control computers to telescope control computers for the purpose
of conveying telescope coordinate and time information. Other information and control commands have been added to the list of
commands.

It does not concern instrument control by VAX computers, either by the telescope computer itself, or by other networked VAX’s,
as user programs have access to telescope data and can control the telescope by the methods described in the 2.3m Telescope
Observer’s Manual (Chapter 12).
 
The use of a dedicated serial line for this purpose should be regarded as a simple and convenient solution for the desired data
exchange. At a later time network connection will considered.

2. HARDWARE
The Telescope and Instrument computers are to be connected by R5232 ports, operating at 9600 bps, no parity, one stop bit.
 
On a VAX this will be a general purpose terminal port, on a PDP11/24 port SLU2:, on other PDPll’s a comparable port with the
same address as SLU2:, on other computers a convenient serial port.

3. DATA EXCHANGE PROTOCOL
All data exchange will be in ASCII format.
 
The Instrument computer is the master of the datalink: it requests information when needed, by sending a command to the
Telescope computer, which will then reply with the requested data, or with an error message.
 
The Telescope computer is available for exchange of information at any time while the telescope system is running. When the
telescope system is not running, there will be no reply from the telescope computer to any Instrument computer commands. The
instrument computer software shall implement a time-out to cope with this condition.
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4. COMMAND AND DATA FORMATS
The command and reply repertoire described below is thought to cover the requirements of most existing instruments which are
controlled by their own computer systems, but may need future extension. The CONFIGURE and VIEW commands are two such
extensions.
 
The VAX Telescope computers use DCL parse routines and will generate the error message "UNRECOGNISED COMMAND" if
the commands can not be recognised. Other types of telescope control computers shall mimic the behaviour of a VAX/VMS
machine as much as possible. All systems implement as a minimum the TELESCOPE, COORDINATES, TIME and VIEW
commands. Commands which control the telescope are only implemented on a needs basis.
 
A command or qualifier can be abbreviated to the minimum number of characters necessary to uniquely identify it, but not to less
than two characters, and has to be terminated with a carriage return <CR>. No more than four characters shall be required to
uniquely identify a command or qualifier. The command strings are not case sensitive.
 
All replies are terminated with a <CR><LF> combination. All alphabetic information in the reply messages will be in capitals.
 
The commands TELESCOPE, COORDINATES, TIME, VIEW and CONFIGURE are available together with qualifiers to indicate
which coordinates or time are required, and whether the reply values will be in ’string’ or ’real’ format.
 
4.1 CONFIGURE

The command:          CONFIGURE  configuration_variable  value
 
shall be accepted by the telescope system as if it were issued on the command line at the telescope control terminal, or the
equivalent information entered in the configuration dialog in menu driven systems. Refer to the Telescope Manuals for further
details. 
 
A <CR><LF> reply indicates successful completion of the command, any error is signalled with the reply:                  
UNRECOGNISED COMMAND.
 
A special case is the control of the Dome_Control configuration variable, which on successful completion reports the previous
value:
 
          DOME_CONTROL WAS MANUAL  or  DOME_CONTROL WAS AUTOMATIC
 
This addition to the command repertoire introduced in version 4.1 has only been implemented on the 74” and 50” telescope
systems. Other systems will be revised as need for this command arises.

 
4.2 COORDINATES

 If the telescope is tracking, this command causes the telescope computer to reply with the message:
 
          "object name"  ra  dec  equinoxstring
 
The object name is only included if available, and is always in capitals and enclosed in double quotation marks.
 
The format of RA and DEC variables depends on the format qualifiers and is described in detail under the /REAL and /STRING
headers.
 
The equinox string contains seven or eight characters: the FK4/FK5 identifier "B" or "J", followed by the epoch as "yyyy.y"
(seven characters), or the string "APPARENT" (eight characters) when   apparent place is selected for the telescope display.
 
If the telescope is not tracking, an error message is generated:
          TELESCOPE NOT TRACKING
 
If the coordinate data are inaccessible or suspect, the reply is:
         DATA ACCESS ERROR
 

/BASE
The requested coordinates are Base Coordinates (refer to 2.3m Telescope Observer’s Manual for definition).  (Not available on
telescopes which do not support the TRACK command)
 

/FILE
The requested coordinates are File Coordinates (refer to 2.3m Telescope Observer’s Manual for definition). (Not available on
telescopes which do not support the TRACK command)
 

/TRACK (default)
The requested coordinates are the current telescope Tracking Coordinates (refer to 2.3m Telescope Observer’s Manual for
definition). 
 

/REAL
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RA and Dec are supplied in ASCII representation of their floating point values:
                0 < RA  < 2*PI,                  format: r.rrrrrr
          -PI/2 < Dec < PI/2,               format: sd.dddddd (s=sign)
 
The sign is only included if it is negative.
 

/STRING (default)
RA and Dec are supplied in string format:
 
          RA:     hh mm ss.d          Dec:    sdd mm ss (first s=sign)
 
If the information is inaccessible or suspect, the reply is:
          DATA ACCESS ERROR

 
4.3 TIME

This command causes the telescope computer to reply with the message:
 
          mjd  sidereal_time  selected_time  selected_date
 
"mjd" is the Modified Julian Date (defined as JD - 2400000.5) in the format: ddddd.dddddd
"sidereal_time" is Local Apparent Sidereal Time
"selected_time" is either Universal Time or Civil Time as specified by the qualifiers /UT and /CT.
      
The format of "sidereal_time" and "selected_time" variables depends on the format qualifiers and is described in detail under
the /REAL and /STRING headers.
 
"selected_date" is either UT Date or Civil Date as specified by the qualifiers /UT and /CT.
The "selected_date" is returned in string format:
 
          dd-mmm-yyyy
 
If the time information is inaccessible or suspect, the reply is:
          DATA ACCESS ERROR
 

/CT
The "selected time" variable is returned as Civil Time: Australian Eastern Standard Time or Australian Eastern Daylightsaving
Time as applicable (UT + 10, resp UT + 11 hours).
 

/UT (default)
The "selected time" variable is returned as Universal Time.

 
/REAL

selected_time and sidereal time are supplied in ASCII representation of their floating point values:
 
           0 < time < 2*PI format: t.tttttt
 

/STRING (default)
selected time, which is UT or Civil Time depending on the /UT and /CT qualifiers, and sidereal time are returned in string
format:
 
          hh:mm:ss.s     in the range 0 to 24 hours.

 
4.4 TELESCOPE

 This command causes the telescope computer to reply with an identification message:
 
              tel_id_string  astr_latitude  astr_east_longitude  height_AMSL
 
"tel_id_string" is the site and telescope identifier, a fixed length string of fifteen characters left justified, in the format:                
SSO 2.3METRE or MSO 74INCH etc.
 
"astr_latitude" and " astr_east_longitude " are the astronomical latitude and east longitude in decimal degrees in the format:
 
              sdd.ddddd and ddd.ddddd (s=sign)
 
"height_AMSL" is the integer value of the height above sea level of the telescope in metres: hhhhh
 

4.5 VIEW
The VIEW command permits an observer to see the value of any telescope display variable
(even if it is not currently featured on one of the display screens).
 
The command:          VIEW variablename [,...]
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causes the names, values (and units where appropriate) of the specified display variable(s) to be returned. A list of display
variable names for your telescope can be found in the chapter ’Telescope Display’ in your Telescope Observer ’s Manual. The
details of the format of the returned data vary with the type of data requested. Rather than trying to detail all possible cases here,
it is recommended to obtain the data by typing in the VIEW command at the control terminal of the 2.3m, 74” or 50”
telescopes.

 
Examples:
   command:           reply:
 
   TELESCOPE                                          SSO 2.3METRE     -31.27336 149.06119 1149
   TEL                                                MSO 74INCH       -35.32065 149.02433 768
   COORDINATES                                 "B CENT" 14 03 00.3 -60 19 05 51988.5
   COORD/REAL        "BCENT" 3.678281 -1.052749 J1988.5
   COORD                                              12 34 56.7 +06 54 32 B1950.0
   COORD                                              TELESCOPE NOT TRACKING
   TIME                                               47465.711806 05:41:57.1 17:05:00.0 31-OCT-1988
   TIME/CT                                            47465.711806 05:41:57.1 04:05:00.0 1-NOV-1988
   TIME/REAL/CT      47465.711806 1.492038 1.060288 1-NOV-1988
 
4.6 OTHER TELESCOPE COMMANDS (2.3m, 74” and 50”)

Any telescope command can be given and will be executed. The reply for successful commands is just a <CR>, for unsuccessful
commands the error message UNRECOGNISED COMMAND plus the body of the VMS error message generated by the control
system. On the 2.3m problems with the delivery of error messages have not yet been solved. It is not possible to discern a
command failure.
 

4.7 TRACK/COORDINATE, OFFSET[/BASE] and HALT COMMANDS (40”, 30” and 24”)
For those small telescopes which operate under computer control (40”and 24” to be implemented in winter 2000), the
following telescope commands are supported: “TRACK/COORDINATE coordinates” (in standard MSSSO format),
“OFFSET ra dec”, “OFFSET/BASE ra dec”, and HALT.   The reply for successful commands is just a <CR>, for
unsuccessful commands the error message UNRECOGNISED COMMAND plus the body of the VMS style error message
generated by the control system.
 

4.8 AUTOGUIDE COMMAND (2.3m only)
The “AUTOGUIDE ew ns” command puts the sky offsets supplied into the autoguider offset fields of the control database. The
telescope will react to this on the next control loop.
 
4.9 STATUS COMMAND
The telescope control system will reply to the “STATUS” command with one of the following strings indicating the current
telescope status: “OFF”, “FAULT”, “HALTED”, “WAITING”, “SLEWING”, “TRACKING”. External systems
controlling the telescope should use this command to determine when to continue with the next phase of their control program.
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5. IMPLEMENTATION ON THE TELESCOPE COMPUTERS
The implementation of the instrument connection on the VAX Telescope computers takes the form of a process as part of the
telescope system. The designated serial port is allocated to this process. The process reads from the port and waits till a command
arrives. DCL parse routines are used to decode the command, the reply string is assembled from information taken from the
telescope database, where necessary using the telescope library routines to do data conversions, and then written out to the port.
 
On other telescope computer types the actions of the VAX computers shall be imitated as closely as possible. The communication
port used shall be polled frequently enough not to produce any noticeable delay in reply or be interrupt driven.

6. IMPLEMENTATION ON INSTRUMENT COMPUTERS
The implementation of the instrument connection on PDP11 Instrument computers uses an RT11 device handler to communicate
with the serial port. The instrument control program will contain a subroutine which writes the required commands to the port and
decodes from the received reply string the
information it requires.
 
On other types of instrument computers there is no prescribed method of implementation. The use of reply parsing routines which
are character position dependent is to be discouraged. Small differences in replies between types of telescope computers are
possible and should be coped with. Examples of these differences are the number of significant digits in scientific notation of
variable values returned by the VIEW command and the number of spaces separating fields.
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40inch Direct Imager 

This manual describes the operation and specifications of the direct imager on the 40inch telescope at SSO.

The imager is suitable for optical imaging at pixel scales of 0.4-0.6"/pixel, depending on the CCD. The MSO
Detector Lab has a list of currently available CCDs. The automated 6-position filter wheel is normally used
with standard UBVRI filters, but can be loaded with observer-provided 50??mm filters if required.

A f/18 secondary is also available, however the focal scale (0.2-0.3"/pixel) and typical SSO seeing mean that
it seldom used.

Instrument Capabilities 
Overview
Filters
Sensitivity

Observing
Getting Going Quickly 
The AutoGuider
Observing Procedures
Fault reports
Observing Report

Software Commands
Instrument Control
Detector Control
Telescope Control

Data Reduction
Imaging

Resources
Photometric Standards
Terrestrial Atmospheric Transmission

Imager Hardware
Optical Design
Detector
Electronic Control System
Mechanical Design

Intrument Capabilities
Overview
The imager is suitable for optical imaging at pixel scales of 0.4-0.6"/pixel, depending on the CCD. The MSO
Detector Lab has a list of currently available CCDs. A f/18 secondary is also available, however the focal
scale (0.2-0.3"/pixel) and typical SSO seeing mean that it seldom used.

Filters
The filter wheel can hold six 50??mm filters and is normally used with standard UBVRI(+clear) filters. It can
be loaded with observer-provided filters if required. The filter wheel is fully controllable from the observing
software, Cicada.
A f/18 secondary is also available, however the focal scale (0.2-0.3"/pixel) and typical SSO seeing mean that
it seldom used.

Sensitivity
Sensitivity data is sparse. Measurements made in late 1993 indicate about 20 and 15 electrons/sec for a 20th
magnitude star, in V and I respectively. Figures for newer CCDs are unknown.
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Dewar numbers Dn indicate re-furbished heads.

Detector
 

Dewar
 

Type Frame 
Format

Pixel 
Size

Read 
Noise(e) Details

SiTE 2k D10 Tek 2048x2048 24um 12 thinned, on 40" 
f/8

E2V 
CCD4210 D11 E2V

Imaging: 
2048x512

Frame: 
2148x562

13.5um
(Full 
Well

~120ke)

3.5(G=2)
4.65(G=3)

thinned, R/O 
time 7s, 
on 2.3m

telescope
New DBS-B

(Old Tek 1kx1k)

E2V 
CCD4240 D6 E2V

Imaging: 
2048x2048

Frame: 
2148x2148

13.5um
(Full 
Well

~120ke)

4.4(G=2)
3.6(G=1)

thinned, R/O 
time 15s, 
on 2.3m

telescope 
New Imager

(Old EEV 
2kx1k)

E2V 
CCD4210 D7 E2V

Imaging: 
2048x512

Frame: 
2148x562

13.5um
(Full 
Well

~120ke)

3.5(G=2)
4.65(G=3)

thinned, R/O 
time 7s, 
on 2.3m

telescope
Science 

Detector will 
be installed on

May 9th
Commissioning: 

Delayed till 
early June

New DBS-R
(Old Tek 

1752x532)

DBS-R D9 SiTE 1752x532 15um 5

grade 1, DBS 
only.

This head to be 
retired

E2V Imager Timing Files and Gain Settings
For the Imager, fast = medm = slow, the detector is read-out at 
the same speed i.e. about 15 seconds. There is now NO slow or 
medium speed with the new Imager.
So the DEFAULT, 2.4e/adu lod file is - fast.lod 
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The GAIN setting of the Imager may now be changed using the 
GAIN option on the Cicada Menu, rather than re-loading a timimg file

The gain settings and noise are as follows

GAIN CDS Gain System Gain
(e/adu) Noise(e) Bias Comment

0 9.5 0.53 4 -- Very Hi Gain

1 4.75 1.1 3.6 1343 Hi Gain

2 2 2.4 4.4 1190 Default

3 1 5.6 6.8 -- Low Gain

DBSB Timing Files and Gain Settings
For the DBSB, fast = medm = slow, 
the detector is read-out at the same speed i.e. about 7 seconds. 
There is now NO slow and medium speed with the new DBSB (or DBSR) 
So the DEFAULT, 1.04e/adu lod file is - fast.lod

However, the GAIN setting of the system may be changed according 
to the table below -

The gain settings and noise are as follows

GAIN CDS Gain System Gain
(e/adu) Noise(e) Bias Comment

1 4.75 0.45 9 -- Hi Gain

2 2 1.04 3.5 1230 Default

3 1 2.35 4.65 1241 Low Gain

Enquiries about Current Detector Information?
detman@mso.anu.edu.au
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A short user’s guide to the 40-inch and its CCD-camera system

April 1999

This document describes the basics of the use of the 40-inch for CCD imaging. It is recommended that it be
read in its entirety before the observing run commences.

1  Before you start

Some things which should be done early in the afternoon before you start your run:

Check that the CCD/Dewar you want is on the telescope and is cold.1.
Check that the LN2 dewar is in the dome and full enough to do a couple of fills. If it is Friday it will

need to last over the weekend. Hold times for the large dewars is 18-22 hours, the smaller ones hold for
up to 12 hours.

2.

Check that the filters that you need have been installed in the filter wheel in their correct positions.3.
Check that you can run CICADA (see Section 3) and can write files to the data disk.4.
Make sure you have tapes and can write to them with the tape drive.5.
Check that the CCD sees light. Verify that the gain and readout speed is what you want and that the
bias levels and RON are reasonable (bias is typically 600-1200 ADU).

6.

Check that the telescope computer and TCS is running and reading the coordinates.7.
Check that you can move the telescope. (see Section 2). Check that when the telescope is tracking and 
you do an exposure that the FILTER and RA and DEC are written to the fits headers of your files.

8.

In all cases, if you have problems - contact the technicians as early as possible.

2  Starting up and using the telescope

3  Starting up and using Cicada

4  Shutting things down

Once your flats and biases are taken:

replace the telescope lid, and close the dome slit.1.
TURN OFF THE TRACKING so the telescope doesn’t run into the floor.2.
fill the CCD dewar so you don’t have to get up just to fill it before the vacuum is degraded.3.
write in the weather log book, and dim the lights.4.
submit any faults to the so the technicians can work on it during the morning.5.
watch the sunrise, go to the lodge, and go to sleep.6.

5  General Tips about observing with the 40’’

6  Troubleshooting

Loud alarm goes off while slewing

You’ve slewed past the RA axis limit.
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Hit alarm off button (the sound yet won’t stop yet)1.
Hold down the top of the horizontal limit button while2.
slewing in the direction opposite to what got you in trouble in the first place. Once the telescope
is back within the limits, the alarm will stop.

3.

Dome won’t rotate

Dome being domes, get stuck sometimes.

Try rotating the dome back in the opposite direction until it gets unstuck, then try again.1.
If the dome is completely stuck, the circuit-breakers might have tripped. To check, try the
flourescent switch under the dome shutter - if the lights don’t go on then you have to reset the
circuit breakers. Go to the ground floor and check all the breakers in the loading dock area.

2.

If that didnt work, fuses might be blown or worse, and the technicians will have to fix it.3.

You can’t find any of your objects, well-known bright stars, globular clusters nor even the Moon.

The telescope pointing calibration is bad.

If you used the 1996 Astronomical Almanac Bright Stars section to calibrate your pointing, go
back and do it again using a *different* year’s edition of the Astronomical Almanac. The 1996
Almanac Bright Star coordinates are incorrect.

1.

see section on Pointing2.
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CICADA PROJECT DOCUMENTATION

 Requirements Specification

 Functional Specification

 CICADA Design

 CICADA V3.1 User’s Manual  (postcript)

 CICADA V3.1 Writing Plug-Ins 
(postscript)

 CICADA V3.1 Configuration Manual 
(postscript)

 Graphing and Imaging Tool V3.0 User’s 
Manual  (postscript)

 CICADA ADASS ’96 Paper

 CICADA ADASS ’98 Paper  (postscipt)

 CICADA System Documentation (in prep)

 Cicada binaries

 GSFind Manual V2.0  (postscript)

 AAO 6dF V1.0  (postscript)

 Pipeline Manual V1.0  (postscript)

 Pipeline ADASS 1998 Paper  (postscript)

 Developer Notes

 Configuration 
Manager

 Testing

 Versions
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MOUNT STROMLO & SIDING SPRING OBSERVATORIES CCD/2.2 
Computer Section 
  2.2

  
17 June, 1994

CCD User Interface Software -- Requirements Specification

Purpose
The CCD User Interface System (CUIS) will provide access to, control of, and retrieval of data from, the
CCD detectors attached to instruments mounted on observatory telescopes. User access will be in the context
of a scheme whereby users will access software at the telescope through a workstation similar to those used
for data reduction at MSO. [This scheme will be specified in a separate paper.]

Rationale
The existing situation with the CCD systems is that they are controlled through i386 or i486 systems running
Interactive Unix. The observer enters commands into these systems via keyboard and tablet, views output on
two monitors (image and data). This system has a number of shortcomings relating to the specific hardware
(tablet, and monitors) that are required. There is also a proliferation of keyboards and monitors in the
observing rooms. The user interface is quite specific to the Astromed controller, and would need to be
replaced when a controller from another source was introduced.

CUIS will allow the observer to operate the CCD from a standard workstation through a window-based
interface, using a keyboard and mouse for input. The same workstation will be used for other tasks, such as
data reduction, telescope control, and more mundane tasks such as email.

The observer will be dealing with a computer system much like that in his office, and will have fewer
(ideally, one) workstations to access.

Capabilities
The CUIS will:

Be the point from which the observer will enter commands to be transmitted to the CCD controller.1.
Provide the observer with a means of monitoring the CCD.2.
Collect data from the CCD, storing it on both disk and removable media.3.
Provide technical staff with a means of testing the CCD.4.
Provide the above capabilities for multiple CCD systems on a given telescope.5.
Be designed to adapt to future CCD controllers, while presenting the same interfact to users.6.

[ The CUIS will not provide data analysis capabilities. These will be provided by standard analysis packages ,
such as IRAF or Figaro.]
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Technical Constraints

Throughput

Data throughput will be comparable to or better than that of the Astromed system in use in October 1993,
with regard to

read out1.
display2.
file archiving3.

External Standards

Data files written to tape, or to disk for access by other software systems, will be in FITS format.1.
Windowing will be based on X. OpenWindows may be used initially; Motif at a later stage.2.

Configuration

Hardware

The present CCD controller is an EISA card in a i386 or i486 system, which is connected to the
workstation is via ethernet. Future controllers may operate through an S-bus card on the ethernet, or
other similar configuration.

1.

The CUIS will run on a Sun (or similar Unix-based) workstation. Currently Sun IPC’s are used.2.

Operating System

The workstation will run Unix. Currently SunOS 4.1.3 is used. The system will operate under Solaris
2.3 as well. The design will anticipate the possibility of Unix from other vendors.

1.

The ix86 systems run Unix.2.
The windowing software will be based on X11.3.

Third-Party Software

The present CCD controller on the ix86 uses software provided by Astromed. Future controllers will
probably be supplied by the manufacturer with low-level software.

1.

IRAF - compatible image display software (e.g. SAOimage or Ximtool.)2.

Users
The CUIS will be used by observers -- both MSO staff and visitors. All users can be assumed to be frequent
computer users, and have familiarity with some windowing systems, but they will vary widely in the depth of
their knowledge of Unix and X11. Furthermore there will be a wide range in knowledge of the functioning of
the CCDs themselves.

The CUIS will be used by people who have been up all night and may not be too wide awake. Appropriate
fail-safe features will be included.

Tasks
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The CUIS will provide the tools for the user to perform a number of tasks, including initialising the CCD,
setting exposure parameters, initiating exposures, monitoring the system, and archiving data. The complete
list of tasks is given in the Functional Specification (CCD/1).

Documentation
Documentation will include

On-line manual pages in the standard Unix format.1.
Tutorial documentation available in hard copy at the telescopes, aimed especially at casual users.2.
On-line help available from window system menus. These will incorporate hypertext cross-referencing
where appropriate.

3.

Technical Risks
[This section itemises those areas where problems may arise which would make it difficult to meet the
requirements.]

Technical difficulties

The Unix implementation on the ix86 (Interactive Unix v 2.x) is not robust.

External Dependencies

The system depends on the Astromed software and controller.

Certainty of requirements

The CUIS will be used by observers with a range of requirements. Some of these requirements may not be
identified or articulated until the system is put into use.
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About this document ...

Introduction
This document describes the required functionality of the CCD User Interface System (CUIS)
which is to be developed by the MSSSO Computing Section. The operation of each
component of the system is described in general terms -- the details of how each operation is
to be implemented are beyond the scope of this document. However, it is envisaged that the
software will be written in C++ and/or C with code written for CCD controllers as required.
The eventual aim is that the system will run under Solaris 2 on a Sun workstation with the
graphical part of the interface built using the Motif widget set.

Required features of the MSSSO CCD User 
Interface System
This section lists, in no particular order, those features of any CCD user interface which
would be required before such a system could be considered useful to observers using
MSSSO CCDs.

General Requirements
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The following requirements are taken from the CUIS Requirements Specification.

provide a common interface to all CCD systems regardless of CCD-vendor supplied hardware or
software
deliver the images to the image tool, disk and/or tape in similar amount of time to the current Astromed
3200 system.
a Graphical User Interface (GUI) which adheres to de-facto standards for the ‘‘look and feel’’ of such
an interface. The idea being that observers are presented with an interface which operates in a way
familiar to users of Openwindows.
provide on-line ‘‘help’’
provide LARGE exposure counters, audible end-of-exposure alarms
use colour coded windows and widgets adhering to Australian Standards for layout and colour of
control panels. This will ensure that the CCD interface and the telescope control system will be using
the same colour codings for warnings, errors, OK status, etc.

Set up and Data Acquisition

provide facilities for technical staff to test CCDs and fine tune the hardware setup of CCD controllers
provide a focussing ‘‘mode’’. (e.g. the system takes a series of exposures at different focus settings
allowing the observer to see the results of each exposure. During the focus exposures the telescope
focus is altered manually or automatically depending on the observers preference and/or the
sophistication of the CCD system/Telescope Control system interface.) Software must be provided
which will calculate Point Spread Functions and assist the observer to obtain the best focus.
ability to define and read out regions of the CCD. Interaction (using the mouse) with the Image Display
Tool will allow for rectangular regions to be specified on a previously taken image. The number of
regions which can be specified will be limited by the capabilities of the CCD controller.
ability to alter the row and column binning of CCD pixels. This will permit different binning in
different regions where the CCD controller allows this
initialise the CCD hardware.
provide a facility to perform drift-scan exposures. This will mean being able to read out one row of the
CCD upon receipt of a signal from the telescope control system.
provide facilities for performing time-resolved imaging and spectroscopy
allow for control of multiple CCD systems (e.g. as in operation at the DBS). This will require
synchronising the start of exposures on multiple CCD controllers. Status information from the multiple
controllers will be required. Multiple fits files will be written. (For the DBS, allowance will be made
for use of only one side of the DBS and for different exposure times to be specified for each CCD
controller.)
allow for exposures to be interrupted and restarted or aborted and allow for exposure times to be
changed when an exposure has been ‘‘paused’’
allow for exposures to be automatically repeated. The number of such exposures will be set by the
observer.
provide the observer with the facility to vary the number of flushes performed before each exposure
Allow for the use of table-driven sequences of instructions (e.g. a series of exposures, changing filters
between exposures). The system will provide a standard set of such tables and allow the observer to
specify new sequences.
provide filter wheel control where this is available on the CCD controller.
provide basic graphical image analysis tools to help with checking data quality, calculation of required
exposure times, etc. Such tools will include summing a number of rows or columns and producing a
plot of the data.
provide facility to save and reload an individual observer’s set-up files. Data such as default image
directories, optional fits header keywords, the observer’s own sets of instruction sequences, observer
defined CCD regions will be held in such a file

Data Output

write fits files with header information obtained from the telescope and the observer. This will include
object name (from the telescope system) where possible
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allow for all hardware set-up information to be included in fits headers.
allow observer to select from all available possible fits header keywords. There will be a minimum set
of ‘ ‘mandatory’ ’  keywords (e.g. RA, Dec, dates) and many specialised keywords (e.g. CCD hardware
info) from which the observer can choose. The set of required keywords will be stored in the users
set-up file.
place fits files in a user specified directory. This will allow the observer to place images in the /home
area or on one of MSSSO’s data or book disks
allow the observer to specify a fits filename to which <run number>.fits will be appended.
display details of available disk space

System Status Information

provide feedback on system status. This includes such things as voltages and temperatures as well as
the ‘ ‘dead or alive’ ’  status of any software sub-processes
provide feedback on progress of exposures, readouts, initialisation (even when window is ‘ ‘ iconified’ ’ )
provide a restart facility should any part of the system fail. This will include advice to the observer that
an error has occurred and that part or all of the system should be restarted. Of course, wherever
possible, any error recovery will be carried out without requiring any action on the part of the observer.
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About this document ...

Introduction
This guide describes the MSSSO CICADA software system design from a programmer’s point of view. Other
documentation describes the rationale for developing the system, this instead will concentrate on describing
the techniques adopted to develop the software.

Description
The aim of CICADA is to build on the techniques developed during the CCD system prototype [#!ref1!#]
That is, to extend the CCD prototype to be a general MSSSO telescope instrument interface using the X
Window system from an observers Unix workstation.

As shown in Fig 1, CICADA consists of a process group running on the observers workstation and potentially
more than one process group running on perhaps more than one instrument computer (which may also be the
observers workstation).
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Figure 1: CICADA Block Diagram

Note that the block diagram is drawn in a way that illustrates the hierarchy in the process chain. A process
box which encloses other process boxes is a parent to those enclosed and has responsibility for organizing
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their execution (starting, stopping and ensuring they are still alive when required).

Inter process communication (IPC) between processes on the same machine is achieved by using standard
Unix SysV IPC routines (see [#!ref2!#] ), while communication between the two machines is by Remote
Procedure Call (RPC) routines (see [#!ref3!#]) across an ethernet link.

The basic functioning of the system requires that an observer sitting at the Sun workstation be able to issue a
command to the instrument and receive feedback (image data or status information) at the workstation
without having to know anything about the instrument computer at all. The image data needs to be displayed
and then archived as FITS files in real time (limited by the speed of the ethernet link). Full functionality is
described in the Functional Specification (see [#!ref4!#]).

This basic functionality is extended to allow the observer to monitor more than one instrument at, possibly,
more than one intrument computer simultaneously. Obviously this model is constrained be hardware at the
CPU, display and communication levels, but should not be constrained by software.

Component description

The observer computer runs the process Instrument Control which spawns processes Database Manager, 
Graphical Tool and RPC Server. When the observer selects an instrument Instrument Control will spawn a 
Controller process which in turn makes contact with the instrument computer and starts up a remote RPC 
Server and remote Controller process. This group of processes form the link between observer and instrument
and are the essential components of the system. The following pseudocode algorithms describe the specific
functionality of each of these components:

Instrument Control

        Start ‘‘Database Manager’’, ‘‘Graphical Tool’’ and ‘‘RPC Server’’.
        Establish mailbox.
        Loop
         Wait on observer requests and mailbox messages.
         If new instrument requested start instrument ‘‘Controller’’.
         otherwise post requests to instrument ‘‘Controller’’ mailbox.
        Endloop

Database Manager

        Establish mailbox.
        Loop
         Wait on requests for data from mailbox.
         Collect data from telescope or cache, update cache if necessary.
         Post data to requesting process’s mailbox.             
        Endloop

Graphical Tool

        Establish mailbox.
        Loop
         Wait on requests from observer for graphical analysis of image
          data.
         Connect to image in virtual memory, do computation and display
          results.              
        Endloop

RPC Server

        Establish mailbox.
        Loop
         Listen for RPC image data requests on network, and watch for 
          mailbox messages fron ‘‘Instrument Control’’.
         Interpret request and post to appropriate ‘‘Controller’’ 
          process which will be a ‘‘Displayer’’ sub-process.
        Endloop

Remote RPC Server

        Loop
         Listen for RPC instrument requests on network.
         Interpret request and post to appropriate ‘‘Remote 
          Controller’’ process depending on instrument. That is,
          if Instrument Computer hosts more than one instrument, the
          ‘‘Remote RPC Server’’ needs to pass requests to the 
          correct ‘‘Remote Controller’’ process.
         Start and restart ‘‘Remote Controller’’ processes as
          appropriate, ie, monitor that they are still alive.
        Endloop

Controller

        Establish mailbox.
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        Start sub-processes ‘‘Archiver’’, ‘‘Displayer’’ and ‘‘Remote’’.
        Start remote ‘‘RPC Server’’ and ‘‘Remote Controller’’.
        Establish a shared memory segment for status.
        Loop
         Check for user requests from mailbox.
         If any requests current, monitor progress and sub-process status.
         Restart any sub-processes or remote processes if failed.
         If new request pass on to sub-processes. ‘‘Remote’’ handles
          requests to instrument, ‘‘Displayer’’ handles requests to 
          get data from the image display and ‘‘Archiver’’ takes
          requests to create new FITS files (memory mapped).
         Display progress and status information.
        Endloop

Remote Controller

        Establish mailbox.
        Start sub-processes ‘‘Slave’’, and ‘‘Data’’.
        Establish shared memory segments for status and image data.
        Loop
         Check for user requests from mailbox.
         If any requests current, monitor progress and sub-process status.
         Restart any sub-processes if failed.
         If new request pass on to process ‘‘Slave’’.
         Post status and progress requests back to ‘‘RPC Server’’ on the 
          Observer Computer.
        Endloop

Archiver

        Establish mailbox.
        Establish interrupt handler (can be interrupted by ‘‘Controller’’).
        Connect to the status shared memory segment.
        Loop
         Check for requests in mailbox from ‘‘Controller’’.
         Requests will be either to create a new FITS file, gather
          telescope information (post request to ‘‘Database Manager’’
          to construct the FITS header and close the FITS file.
         Post a ‘‘ready’’ message to the ‘‘Displayer’’ process when
          FITS file ready for data. (Or use semaphore to control access)
         Place regular heatbeat signal onto status memory.
        Endloop

Displayer

        Establish mailbox.
        Establish interrupt handler (can be interrupted by ‘‘Controller’’).
        Connect to the status shared memory segment.
        Loop
         Check for requests in mailbox from ‘‘RPC Server’’ to display
          and store image data from the instrument.
         Requests will be either to start a new image, build on an already
          started image or to close it off.
         If the request is to start a new image then wait for a ‘‘ready’’
          message from the ‘‘Archiver’’ process (or wait on semaphore)
          before copying data to virtual memory FITS file.
         Place regular heatbeat signal onto status memory.
        Endloop

Remote

        Establish mailbox.
        Establish interrupt handler (can be interrupted by ‘‘Controller’’).
        Connect to the status shared memory segment.
        Loop
         Check for requests in mailbox from ‘‘Controller’’ to formulate
          RPC requests to the instrument computer (or, if the instrument
          is local, post mailbox messages to the ‘‘Remote Controller’’).
         Post results of status requests onto the status memory.
         Place regular heatbeat signal onto status memory.
        Endloop

Slave

        Establish mailbox.
        Establish interrupt handler (can be interrupted by ‘‘Remote 
         Controller’’).
        Connect to the status shared memory segment.
        Connect to the image shared memory segment.
        Loop
         Check for requests in mailbox from ‘‘Remote Controller’’ for
          instrument action requests.
         Instrument requests will involve loading the controller with
          appropriate commands, starting, pausing, resuming, aborting
          the controller and retrieving data from the controller.
         Post regular progress information onto status memory during
          an instrument request, otherwise post heartbeat information.
         Image data retrieved from the controller is placed into the 
          image shared memory when ready (Either wait for ‘‘ready’’
          message in mailbox from ‘‘Data’’ or wait on semaphore).
          Signal ‘‘Data’’ that new data is ready.
        Endloop

Data
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        Establish mailbox.
        Establish interrupt handler (can be interrupted by ‘‘Remote 
         Controller’’).
        Connect to the status shared memory segment.
        Connect to the image shared memory segment.
        Loop
         Wait for requests in mailbox from ‘‘Slave’’ for new image 
          data (or wait on semaphore).
         Formulate RPC request to Observer Computer with the image data.
          (or if on same computer post mailbox message to 
          ‘‘Displayer’’).
         Post regular heartbeat information to status memory.
        Endloop

Error Handling

In a distributed processing environment like CICADA it is easy for the error locality and the notification
interface to become detached thus making reporting difficult. In CICADA it is proposed that the Local
Controller process for each instrument be responsible for reporting all error conditions. Therefore any errors
generated by child processes (local and remote) should be propagated back, through the IPC interface, to the
Local Controller for reporting.

Within a process, the C++ exception handling facilities [#!ref5!#] will be used to concentrate error processing
at one location in the code thus eliminating the need for explicit error handling right through. Size and
complexity of the code is, hence, also reduced.

For example the pseudocode version for the slave process, rewritten with exception handling, becomes:

        try {
         Establish mailbox.
         Establish interrupt handler (can be interrupted by ‘‘Remote 
          Controller’’).
         Connect to the status shared memory segment.
         Connect to the image shared memory segment.
         Loop
          try {
           Check for requests in mailbox from ‘‘Remote Controller’’ for
            instrument action requests.
           Instrument requests will involve loading the controller with
            appropriate commands, starting, pausing, resuming, aborting
            the controller and retrieving data from the controller.
           Post regular progress information onto status memory during
            an instrument request, otherwise post heartbeat information.
           Image data retrieved from the controller is placed into the 
            image shared memory when ready (Either wait for ‘‘ready’’
            message in mailbox from ‘‘Data’’ or wait on semaphore).
            Signal ‘‘Data’’ that new data is ready.
          }
          catch(CICADA_error E) {
           Post error condition to status memory, or rethrow to outer
           error handlers.
          }
         Endloop
        }
        catch(CICADA_error E) {
          Post error condition to status memory
        }
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Introduction
This manual describes the operation of the CICADA system (Configurable Instrument Control and Data
Acquisition). This version of the manual accompanies release 3.1 of CICADA. To find out what changes
have been made since earlier releases, select What’s New from the CICADA main window Help menu.

Version 3 of CICADA supports the Astromed 3200 controller and the SDSU Generation 1 and Generation 2
controllers.

CICADA features
The aim of the CICADA system is to provide a common interface to many different CCDs and several
different types of CCD controllers. It has been designed and built to be as flexible as possible so that new
CCDs can easily be incorporated into the system and the support of new controller types can be provided in a
relatively straightforward manner. Version 3 furthers gains made with version 2 - the code has, again, been
extensively re-worked to provide a more general software solution for multi-part instruments and CCD
mosaics. It also supports the simple control of instrumentation associated with a CCD camera.

The system is comprised of several unix processes each of which handles one aspect of the data acquisition
and control process. These processes are divided into two groups - observer control and instrument control,
and may run on one or more computers. For example, in the observer control group there is a process which
displays images, another which writes FITS files, and a graphical user interface (GUI) with which the
observer monitors and controls the system. In the instrument group, there is a slave process which
communicates with the CCD controller, a data process which moves image data and a director process for
managing operations. More than one instrument group is possible allowing for the control of multiple-part
instruments. The use of several processes allows a certain amount of ‘‘parallelism’’ in the process of taking
an exposure (e.g. a section of an image is displayed while the next section is being read out) resulting in some
system performance gains. Further parallelism is achieved through the use of multi-threading in the internals
of these sub-processes where appropriate.

For a complete description of the CICADA design, refer to CICADA technical documentation at
http://www.mso.anu.edu.au/computing/cicada/

Getting Started

Quick Start Guide
CICADA is predominantly GUI-based observing software with a familiar ‘‘look-and-feel’’ and an intuitive
interface. If you want to start up CICADA and get going quickly without first reading the rest of this manual,
do the following (presuming CICADA hardware configuration has already been performed):

type cicada and press <Return>
once the CICADA menu-bar appears, select Start Ximtool from the Tools pull-down menu
select the Telescope/Instrument you are observing at from the Start Observing pull-down menu
optionally select Start GIT from the Tools pull-down menu
set your desired exposure options and start observing.

You will now be taking data and FITS files will be written to a default location (probably your home area).
You may wish to alter your output directory via Preferences from the Options pull-down menu.
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Use the Start Teldisk option of the Tools pull-down menu to clear the previous observer’s data from any
‘‘observer’s’’ disk and create a directory for your data. This will depend on the disk configuration at your
site.

Requirements
To run CICADA, you will need an account and sufficient disk space to store captured images. Start CICADA
by using the command cicada, you will then be presented with a menu bar from which an instrument and
configuration can be selected. CICADA runs in conjunction with the Graphing and Imaging Tool (GIT) and a
modified version of Ximtool - these must be started from within CICADA so that correct environments and
interconnections are set up. Use the Start Ximtool option of the Tools pull-down menu (if you forget to do 
this, CICADA will automatically start Ximtool the first time you start an exposure).

CICADA can also run in conjunction with its own (IRAF based) data reduction pipeline. Use the Start 
Pipeline option to get this going - refer to the Pipeline User’s Manual for more information.

Take Care
NOTE: CICADA and GIT can be very memory hungry! How much memory the system requires depends on
the size of images you are taking. Both programs indicate when memory is getting low, so please take note of
these warnings as performance can be affected. In particular,

Limit running of non-CICADA processes. Other utilities and packages such as Netscape and IRAF can 
compete with CICADA for system resources - try to run these on other hosts on the network.
Stop and restart CICADA if in trouble. If system resources have been drained - it is fast and simple to
stop and restart the observing window. This will recover system resources to the starting point,
provided no other memory hungry processes are running.

Configuring fonts and colours
Setting up fonts and colours for X windows applications can be a complicated process. X applications use
‘‘resources’’ to determine the fonts and colours they should use when displayed on the screen. If you wish to
change the default colours and fonts for CICADA, you will need to add the following lines to your
.Xdefaults file:

cicada*fontList: -*-lucida sans-medium-r-*-*-*-100-*-*-*-*-*-*=TAG1,\
                 -*-lucida sans-bold-r-*-*-*-110-*-*-*-*-*-*=TAG2
cicada*background: wheat
cicada*foreground: black
cicada*selectColor:   yellow

To select a font you like, use the program xfontsel which allows you to preview various fonts and then cut
and paste your chosen font descriptor into your .Xdefaults file. Note that there are two fonts listed in the
fontlist resource. CICADA uses the first font for most of the labels in all windows. The second font is used
to highlight various buttons and text fields such as the status indicators. You do not need to specify a second
font as CICADA will use the first font you specify for all labels and text if no second font is in the fontlist.
Note the syntax of the fontlist resource as the =TAG1 and =TAG2 are very important.

The cicada*background resource sets the colour of all window, button, etc. backgrounds. Text on buttons and
labels will be in the colour specified by the cicada*foreground resource. cicada*selectColor sets the colour
used by toggle buttons when they are turned ‘‘on’’.

Similar selections may be made for other CICADA tools, that is, GIT, Pipeline. GSFind and Teldisk.

CICADA Main Menu Bar
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Figure 3.1 shows the CICADA Main Menu Bar. This is the first window the observer will see upon starting
CICADA.

Figure 3.1: CICADA startup window

Start Observing
This pull-down menu contains a list of possible telescope/instrument configurations. The observer selects the
particular telescope/instrument for which they have been scheduled. CICADA has an internal table which is
configured by technical staff that indicates to the system such things as the CCD in use on the selected
instrument, the controlling computer, the controller type, etc. After selecting the appropriate item, an
observing window will appear.

Data Archiving

As part of supporting the archiving of RSAA’s Wide Field Imager data, version 3 of CICADA can optionally
request the observer to provide name and proposal ID details for inclusion in FITS headers. These details can
be used for retrieving data from an archive at a later date. The proposal ID will be matched with a password
and used as part of a system to restrict access to data in the archive. Figure 3.2 shows the Proposal ID 
confirmation window. This window will appear if the instrument has been configured to support archiving of
data. If for some reason the details are incorrect, this window provides the observer with an opportunity to
correct the error. It is also possible for the observer to select not to archive any FITS data.

Figure 3.2: CICADA startup window

Tools
This menu has items for starting the Graphing and Imaging Tool (GIT), Ximtool, Pipeline, Teldisk and
GSFind.
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GIT provides ‘‘quick look’’ plotting and data reduction tools - see the GIT User’s Manual for full details.

Ximtool is used for displaying the image as it is read out. You may either start Ximtool manually via this
menu option or it will be started automatically if display mode is set when taking an exposure. CICADA uses 
a modified version of Ximtool and it MUST be started from within CICADA

Pipeline is a data reduction pipeline that can run stand-alone or closely integrated with CICADA. It uses the
IRAF ccdred and mscred packages for performing the actual work. The idea behind Pipeline is that it
provides an automated way of performing simple recipe reduction on a collection of images.

GSFind is a Guide Star Finder that uses the Guide Star Catalogue and a description of the
instrument/telescope to assist with locating guide stars. It is loosely coupled with CICADA and can also run
in standalone mode.

The other option available under Tools is Start Teldisk. Teldisk allows the current observer to clear the 
previous observer’s data from the ‘‘Observer Data disk’’ and create a new directory for storing FITS files.
The configuration of disks is site dependent, so talk to the local Systems Managers about disk space for
observers.

Options

Preferences

Preferences are user configurable parameters which affect the operation of CICADA. CICADA Preferences
are stored in the observer’s home area in a file called .cicadarc-hostname. The file is read once at CICADA
startup time. This file is host name differentiated because of the possibility that a user might run more that
one session of CICADA at a site with multiple instruments and CICADA observer hosts. It is important that
these files are not mixed.

General Preferences

Figure 3.3 shows the Preferences window with the General Preferences displayed.
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Figure 3.3: General Preferences

Use these preferences to specify the default filename prefix, suffix and location (output directory) for FITS
files. There are also options here to:

use the large counter in a separate window as well as using an exposure counter in the progress display
of the observing window. Turn the toggle ‘‘on’’ to use the large counter in a separate window.
show messages window at startup will cause the CICADA messages window to be displayed and
positioned below the observing window when the first status messages are received from a CICADA
sub-process (i.e. there may be a delay after the observing window has appeared before the messages
window is seen).
reset the Number of exposures field to 1 after running a sequence of exposures. e.g. (with this toggle
‘‘on’’) the observer enters ‘‘5’’ in Number of exposures and selects Expose. The five exposures are run
and at the end of the last one, Number of exposures is automatically reset to 1.
toggle binning when switching between Save and No-Save modes. e.g. the observer bins 4x4 while
positioning the science object on the CCD and using Display Only mode. However, the observer uses
1x1 binning during data acquisition with Save and Display mode. With this toggle ‘‘on’’, CICADA
will remember the two different binning factors and toggle the binning whenever the observer switches
between Save and Display and Display Only modes.
The number of CCD flushes to perform when doing an exposure.
X window screen numbers to display each CICADA tool - only applicable for multi-screen
workstations. By setting the screen number here, each of the tools will be started on the preferred
screen.
Automated focusing parameters. See section 4.9 on automated focusing for a description of how this
works. Set the following parameters for running the sequence.

Focusing steps - the number of focus steps to perform in the sequence.
Value of the first focus position in the sequence.
The focus position step size. This can be used for systems that have a computer controlled
focusing mechanism. The focus position is adjusted by this amount each successive step in the
sequence.
The radius (in pixels) from the star centroid to use for fitting a gaussian.

Image Display & Scaling Preferences

Figure 3.4 shows the Preferences window with the Image Display and Scaling Preferences displayed.
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Figure 3.4: Image Display and Scaling Preferences

These property items affect the way in which images are displayed as they are read out:

Clear display before next image will cause the image display to be cleared before the next image is
displayed. When not selected, a following image will gradually overwrite the currently displayed
image. This may be useful in focussing or positioning the science object on the CCD.
Highlight saturated pixels will cause any pixels with a value greater than that specified in the
‘‘saturation value’’ field to be highlighted in red on the image display.
Display distinct image regions in separate frames,... This option affects the way images are displayed
from CCD mosaics, multi-amplifier CCDs and multi-region readouts. If ‘‘on’’, each separate region is
displayed in a separate frame of the image tool. If ‘‘off’’ all regions are displayed in one image tool
frame in ‘‘detector’’ coordinates.
Use approximate integer maths for scaling... Uses shift division for placing each pixel into its display
bin (for Ximtool this is a maximum of 200 levels). This, if used in conjunction with the Ultra Sparc
VIS instruction set (see General options), can speed up image display by nearly 4x for most images.
Wait for image display during readout... sets the maximum amount of time CICADA will wait for the
image display to show a chunk of data before sending the next one. Small values will result in ‘‘gaps’’
in the image display, but does NOT mean data has been lost. The default value will result in good
performance and zero or minimal gaps in the display.
Adaptive scaling will calculate appropriate minimum and maximum image display values as each
‘‘chunk’’ of image is read out. Depending on the settings of ‘‘% of image to readout before rescaling’’
and ‘‘Num SDs tolerance before rescaling’’ the range is re-calculated after each chunk and the entire
image redisplayed. Minimum and maximum values are calculated as a weighted deviation from the
median or mode after sampling a proportion of the pixels. Better performance, but perhaps poorer
scaling will result from decreasing the number of pixels to sample. The min/max range can be modified
by altering the contrast adjustment value between 0 and 1.
Fixed scaling allows the observer to specify the range of image display values to be used by the image
display. This may be necessary in certain situations where adaptive scaling is not giving the desired
results.

Sounds Preferences

These preferences control the number of beeps issued by Cicada at certain key points during an exposure.
The observer can set the number of beeps to be heard when the shutter opens, the shutter closes and when
readout finishes.
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Expert

These preferences control the following:

Whether or not the observer is warned at startup if CICADA cannot allocate a colour. CICADA uses a
small number of colours on the GUI for highlighting buttons and warning of error conditions. If the
observer is running a colour-hungry application such as Netscape, it is possible that CICADA may not
be able to use one or more colours and so the software will try to find an alternative. If an alternative is
needed or no colour can be found, a warning will be displayed at startup if this preference is ‘‘on’’.
Write an observations log. When ‘‘on’’ CICADA will write a log of each image taken showing RA,
Dec, run number, exposure time, sidereal time, object.
Show timestamps in messages window. Whether or not to show a timestamp with every line in the
CICADA Messages Window.
Show Balloon Help. Turns on and off the ‘‘balloon help’’ on toolbar items
Show toolbar items as text, not pictures
Use the Ultra Sparc VIS instruction set. For improved performance in some operations. (eg byte
swapping or image display).
Write a temperature log. Selecting this option will allow a CCD temperature log be kept for the run.

Help

Send Comments

This will pop-up a window allowing the observer to enter a message which will be sent to the local CICADA
administrators. Use this to report problems, ask questions or request changes/new features. CICADA is
configured to have an email address of the local CICADA administrator. At RSAA this is staff of the
Computer Section who will endeavour to respond promptly to your submission with a resolution or an
estimation of when a resolution can be made.

What’s New

This will popup a window showing a revision history of CICADA which outlines the major changes between
versions.

About Cicada

Well, everyone else has one of these...

The CICADA Observing Window
Figure 4.1 shows the CICADA observing window. It is from this window that the observer initiates and
controls data acquisition. The appearance of this window is largely the same irrespective of the particular
controller used to drive the CCD (e.g. AM3200, SDSU Generation 1). Of course, each controller has certain
unique features and these are accessed via a pull-down menu on the observing window. e.g. when using the
AM3200 controller, the pull-down menu will be called AM3200 and will have items such as ‘‘Edit Gain 
Values’’ and ‘‘Continuous Flush & Read Temps’’.
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Figure 4.1: CICADA observing window

Menu Options

Actions menu

Initialise CCD Hardware

Selecting this action will cause hardware initialisation of the CCD controller to be performed. During
initialisation status messages will be displayed in the Cicada Messages Window and progress will be shown in 
the status indicators of the Observing Window (see below).

Run CICADA Script...

This action will pop-up a file selection box allowing the observer to select a file containing a TCL script to be
executed. The script must be a valid TCL script with CICADA commands. See Chapter 8 for further details.

Repeat Last Script

This item will become active once a script has been run and when selected will re-run the most recently
executed script.

Do Focus Sequence...

A focus sequence consists of a series of exposures run with different telescope focus settings followed by
analysis of the resultant image to determine the optimal setting. Focus settings are either set manually by the
observer when prompted or, if the capability exists, automatically through the telescope control interface. A
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plot of the calculated optimal setting (a quadratic fit through the set of points) is produced at the end of the
sequence. The user is required to select a small region around a single star before performing the focus
sequence.

Quit Observing Window

Close the Observing Window and shutdown all sub-processes. The observer should use this action when
finished observing or if a restart of the CICADA sub-processes is required.

Tools

This pull-down menu is a copy of the Tools menu of the CICADA Main window and has items for starting
GIT, Ximtool, Teldisk, Pipeline and GSFind.

Options menu

Preferences

Select this to pop-up the User Preferences window

Exposure Time Unit

Use this pull-right menu to change the time unit used when specifying exposures.

Show Regions Window

Selecting this will pop-up the Regions window allowing the observer to specify regions of interest on the
CCD

Show Messages Window

This option will pop-up a messages window. Certain parts of the CICADA software send messages to this
window and it may be useful to the observer to see these messages - for example, during a hardware
initialisation.

Show Counter

The observer can use this option to re-display the counter window if it has been dismissed during an exposure
countdown.

Show FITS Keyword Window

This will display a window where the user can enter any extra keyword/value pairs they would like to add to
their FITS files. See section 4.8 at the end of this Chapter for more information on the FITS keyword
window.

Hide Toolbar

Selecting this option will remove the toolbar from the observing window. The Toolbar can be redisplayed by
selecting Show Toolbar from the Options menu (the Hide button changes to Show and vice versa as
appropriate).

Controller menu
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This menu will appear on the menu bar with a name such as AM3200 or SDSU and holds all hardware 
specific actions and options for a particular controller type. See the relevant chapter in this manual for
information about this menu item for specific controller types.

Instrument Controls menu

Note: This menu item will only appear if the CICADA instrument description includes site instrument
control or filter control specifications.

Simple instrument controls are optionally configured for an instrument. This facility is provided as part of
CICADA’s ‘‘plug-in’’ capability. Each of the items under this menu is built as a simple instrument GUI
plug-in - see the CICADA plug-in reference manual for further information.

An example simple control plug-in is one for a filter wheel (See Figure 4.2).

Figure 4.2: A Filter Control GUI

This popup window displays the current filter wheel position by highlighting the current position in green.
The filter wheel is moved to another position by selecting the item corresponding to the desired filter. The
selected position will flash orange while the filter wheel moves and will be highlighted in green once the
wheel is locked into position.

Another example is one for telescope control (See Figure 4.3).
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Figure 4.3: A Telescope Control GUI

Toolbar
The Toolbar is intended to give one-button-click access to some of the more commonly used items from the
pull-down menus. ‘‘Balloon Help’’ will pop-up under the Toolbar item if the cursor is positioned in the
Toolbar. (To turn off the balloon help see the Expert section of the Preferences window)

There are buttons in the Toolbar for Hardware Initialisation, Run CICADA Script, Repeat last script, show
Preferences, show FITS keyword window, show Temperatures window, show Regions window and Read
Regions from Image Display (See Figure 4.4).
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Figure 4.4: GUI Toolbar Buttons

Image naming and displaying options
This section of the window displays the destination directory the observer has selected along with a filename
prefix, suffix and run number which will be used to create a filename for the FITS file. There are also fields
for entering a comment and object name to be added to the FITS header. CICADA stores up to 20 object
names and comments. Use the down arrow next to the object name or comment field to select from
previously used names and comments . New items can be added to these lists by simply entering a new value
in the text field and hitting <Enter> or by entering a new value and taking an exposure. To delete an item,
blank it out and hit <Enter>. These lists of names will be remembered by CICADA between runs (they are
kept in the .cicadarc-hostname file in your home area Note that the list of objects and comments may grow
longer than 20 during one invocation of CICADA - but only 20 will be stored when the observer quits.

If a filter is in use, the filter name will be displayed next to the object name.

Before the exposure is carried out, the system checks to see if a file already exists with the same name as the
one about to be generated. If such a file is found, the observer is prompted with a pop-up window asking if
this existing image should be overwritten. If the observer responds that the image should be overwritten,
THE EXISTING FILE IS IMMEDIATELY REMOVED. Note also that NO EXPOSURE is happening
while the prompt is displayed.

Exposure Type

The setting of these toggles affects the value of the IMAGETYP FITS keyword. In addition, when BIAS is
selected, CICADA sets the exposure time to zero. The previous exposure time is restored when an option
other than BIAS is subsequently selected.

The Expose button will change to the orange warning colour and the Exposure Type label will flash orange 
when anything other than Object is selected.

Save and Display options

Images read out from the CCD can optionally be displayed and optionally written to disk. Appropriate
warnings are displayed on the GUI if the observer chooses NOT to save images. There is also a button in this
section of the window which will allow the observer to save the last image taken when taking images in ‘‘no
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save’’ mode. This might be useful if the observer was taking a series of frames of the science object while
focusing the telescope. Images are discarded until a good frame is taken, when pressing the Save Image
button will write the last image to disk.

Exposure options
This section of the window is where the observer specifies exposure time and the number of exposures to be
taken once the Expose button is selected.

No pre-flush and No Readout toggles

Normally, an exposure consists of a flush, followed by integration and readout. The observer can alter this
sequence with these two toggles by choosing to omit the pre-flush and/or the readout. The Expose button will
change to the orange warning colour when this toggle is selected and the selected toggle(s) will flash orange.
If No readout is selected, No pre-flush is also automatically selected.

Status indicators
These indicators give the observer some feedback as to the state the system is in at any particular moment.
The upper left-hand indicator will read one of Idle, Running or Paused and indicates the state of the process
responsible for communicating with the CCD controller. The upper right-hand indicator gives more detail of
the particular function currently being carried out. This indicator will display such messages as Initialising, 
Shutter Open, Shutter Closed, Reading Out. In addition to these messages, this indicator will show a green
background when the shutter is closed and an orange background when the shutter is open (NOTE: this
indicator is not controlled by any hardware and reflects only a status of the software. Therefore, if the shutter
mechanism were to jam open or closed, this indicator WILL BE INCORRECT). 
This indicator is also where an exposure counter will be shown if the observer has de-selected the CICADA
preference Display exposure counter. During CCD readout, this indicator will show progress as a number of
rows read out against the total to be read.

Also in this section of the window are three indicators displaying free disk space on the observer’s chosen
output disk, free memory available in the workstation and the current CCD temperature.

The free disk space indicator will flash orange when there is not enough space for two full readouts of
the CCD. When there is a warning about low disk space, either free some space on the disk by
removing files or select another output directory via Preferences from the CICADA Options pull-down 
menu.

The free memory display will flash orange when there is less than 16 Mb of free memory in the
workstation. When there is a warning about low memory, quit some applications running on the same
host as CICADA. In this situation, it might also be a good idea to quit and restart CICADA and GIT if
you are using it.
The CCD temperature indicator will display HWinit needed if the temperature has not been read or if
the controller hardware needs re-initialising. The behaviour of this indicator is controller dependent.
Additionally, the temperature indicator will change to an orange background if any focalplane
temperature sensors measure a temperature which is out of range (the name of the sensor will appear in
this indicator should this happen). Choose Show Temperatures from the controller-specific menu in the
observing window (e.g. the menu labelled AM3200 or SDSU) to see all temperature sensors for the
current instrument (or click on the thermometer button in the toolbar).

Buttons
Here is a brief description of the function of each button:
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Expose: Start an exposure using the various fields in the GUI for exposure parameters, file name,
destination directory. This button will be orange if the observer has selected an option in the GUI
which may result in no data being written to disk or if some other non-standard exposure option has
been chosen (e.g. dark frame, no readout, no pre-flush). CICADA will check to see if there is already
an image with the same name as the one about to be created and prompt the observer to ask if the
existing file should be overwritten. CICADA will also check to make sure there is sufficient disk space
for the new image and sufficient free memory in the workstation for the readout to be completed.
Readout: Read out the CCD, display the image and save the FITS file (if save to disk has been
selected).
Pause: Pause the exposure by closing the shutter and stopping the counter. The observer may then
continue the exposure by selecting the Resume button. It is also possible to change the exposure time
and number of exposures while paused and these new values will be used when the exposure is
resumed. Note that even though the shutter is closed, dark current and cosmic rays are still being
accumulated on the CCD.
Resume: Continue the paused exposure
Flush: Flush the CCD
Abort: Stop whatever is happening (eg. exposure, readout). Note that aborting an action may take 
from a few seconds to several 10’s of seconds. This is because, depending on the controller, some
actions cannot be immediately interrupted and must finish before the abort request can be
carried out and the GUI reset to allow further action.

The Regions Window

Figure 4.5: CICADA Regions window
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The Regions Window is where the observer can specify the region(s) of the CCD or CCD mosaic to be read
out and saved to disk. There are also fields in this window for changing the row and column binning factors
and for specifying row and column overscan.

The window has five main sections:

The Region Diagram This diagram shows the layout of the CCD(s) on the focal plane and will display
a shaded area indicating the currently selected region(s) of interest. The diagram will be updated as
changes to the region of interest are made in other section of the window.

User Defined regions This section can be used to manually key in a region of interest. However, a
simpler way to set the values in these fields is to have CICADA do it via the Read Regions from Image 
Tool feature. To use this, first do a full readout of the CCD or mosaic, then mark the region of interest
by drawing a box on the image display (click mouse-button 1 and drag in the Ximtool window), then
select Read regions from imtool from the Actions menu in the Regions window. There is also a button
on the observing window toolbar to perform this function. It is possible to mark either one or two
regions in this way.

Also in this section of the window are settings which allow the observer to specify which of the two
regions is to be read out (both regions can be selected simultaneously). Attempting to turn ‘‘off’’ the
only ‘‘on’’ toggle will automatically turn ‘‘on’’ the other toggle and display that region.

Pre-defined regions This section allows the observer to select from the following regions of interest:
Entire detector
A region in the centre of the detector. The size is selected using the option button. The sizes
available are determined dynamically by CICADA based on the size of the entire detector
A region in the centre of each CCD. The size is selected using the option button. The sizes
available are determined dynamically by CICADA based on the size of each CCD.
selected CCDs. The numbers in this section correspond to the numbers shown in the Regions
Diagram. This ‘‘masking’’ can be used in conjunction with selecting a region in the centre of
each CCD

Binning and Overscan This section contains input fields where the observer can specify row and
column binning and also the amount of row and column overscan. Note that when overscan is
specified, it will NOT be shown in the image display for CCD mosaics if the display is showing the
entire mosaic (overscan will be seen if each CCD is shown in a separate frame of the image display).
The overscan IS written to the FITS file, regardless of what the display is showing.

Actions pull-down menu The Actions menu at the top of the window has buttons which allow the
observer to:

Read the region(s) marked on the image display
reset the region values to their initial state (full CCD for region 1 and nothing for region 2)
Save the currently defined regions to a file
Load regions from an existing regions file (e.g. to use the regions from a previous observing run)

The FITS Keyword Window
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Figure 4.6: CICADA FITS keyword window

The FITS Keyword Window (Figure 4.6) allows the observer to enter keyword/value pairs to be added to the
header of each FITS file written by CICADA. These keywords are in addition to any standard keywords
provided by CICADA (e.g. EXPTIME) or by any telescope system (e.g. AIRMASS). The intention of this
window is to allow CICADA users to enter keywords that the system does not supply (e.g. where there is no
telescope computer or only a manual filter wheel).

Keywords and values can simply be typed into the text fields. CICADA will remember up to six items for
each keyword and value field. Use the down-arrow to the right of the field to see a list of previously entered
items and click on an item to select it. The list may grow longer than six items during one invocation of
CICADA, but upon exit, CICADA will only store the six most recently used items.

NOTE: Changes made in these text fields will not propagate into FITS files unless the Apply button is 
pressed. Visual confirmation that your changes have been communicated to the CICADA sub-processes will
be in the form of a command string in the CICADA Messages Window. Provided the Apply button is pressed 
before a readout starts, it is possible to modify these values during an exposure and have these modified
values appear in the FITS file about to be produced.

Each keyword/value pair has a toggle next to them labelled ‘‘Include in next FITS header’’. This toggle can
be used to stop a keyword/value pair from being added to a FITS header. Turning all these toggles off will
disable all user-specified FITS keywords. Remember to press the Apply button if you change these toggles.

CICADA stores any keywords and values that the observer enters in the .cicadarc-hostname file in the 
observer’s home area so that they remain available after a restart of the CICADA software. When an
observing window starts up, CICADA will check to see if there are any ‘‘active’’ user-specified FITS
keyword/value pairs left-over from a previous CICADA run. If any are found, CICADA will prompt the
observer to either view these keywords (and then press Apply if they are to be used) or decide not to use them
at all.

FITS keywords are edited by CICADA to make sure they have no leading or embedded blanks and that they
are uppercase. Embedded blanks will be replaced by a hyphen (‘‘-’’).

If the keyword ‘‘FILTER’’ is specified, the value associated with this keyword is displayed next to the object
name in the observing window.

A full description of CICADA FITS file construction is contained in chapter 7.

Automated Focusing
An automated focus sequence consists of a series of exposures taken of a star with incremental focus shifts
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made between each exposure. These exposures are stacked together to form a composite image to which a
focus fitting routine is applied. The FWHM of each star is measured and then a quadratic is fitted to
determine the optimal focus position. This fitted curve is then plotted and an indication of the minimum is
displayed.

When Do Focus Sequence... is chosen from the Actions menu the window shown in figure 4.7 is shown.

Figure 4.7: CICADA Automated Focusing
Parameters

Select the number of focus steps to make and the initial focus position. CICADA will then expose the
selected region (this should be a small region around a star) for the required exposure time. After the
exposure, depending on whether the telescope has computer controlled focus setting or not, CICADA will
prompt for the next focus position. The observer should set the focus position and enter the value in the
dialog box before proceeding with the next exposure in the sequence. The composite image will then look
like figure 4.8.

Figure 4.8: CICADA Focus
Image
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CICADA will then calculate the star centroid and fit a gaussian using the user preferences. The result will be
a quadratic fit of FWHM and focus position which is then displayed. See figure 4.9.

Figure 4.9: CICADA Focus Fit

The SDSU controller

Initialisation of the SDSU
CICADA will not initialise the SDSU controller when the observing window starts up. This is because
re-initialising will mean resetting the controller electronics and possibly destabilising the CCDs. However,
the observer can re-initialise the controller at any time using the Initialise CCD Hardware option from the 
Actions menu of the Observing Window. This should only be performed as a last resort when all other
remedies for restoring normal operation have failed. Progress of an initialisation will be shown in the Cicada 
Messages Window.

The SDSU menu
These are the SDSU specific menu items appearing under the SDSU menu button in the Observing Window:

Readout modes

The SDSU controller has been set up to allow the selection of different readout modes. These are selected
from the SDSU menu on the observing window. There is a menu item Readout mode which is a ‘‘pull-right’’
menu from which it is possible to select Fast, Medium or Slow. Once a selection is made, the mode will be
shown in the exposure options section of the observing window. See

Figure 5.1
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Figure 5.1: SDSU readout mode display

Show Temperatures

Selecting this item will popup a window showing the last read values for all active temperature sensors. Press
the Read Temperatures button to begin reading temperatures at an interval specified in the Read 
Temperatures every ... field. When idle, CICADA will read temperatures at this interval automatically. While
CICADA is busy taking data it may not always be possible for the temperatures to be read. In this case, the
software waits until the system is idle before updating the temperatures window and the temperature display
on the observing window. Figure 5.2 shows available options.

Figure 5.2: Temperature Display and Control
Window

CICADA can perform a controlled rate warmup of a CCD - parameters for controlling this operation are set
dynamically from this window and are loaded, by default, from the Cicada focalplane configuration. This is
an engineering mode only operation.

Progressive plots showing temperatures for those sensors configured can also be viewed. These plots will
only show values read back since the plot window has been popped up. A log of temperatures for the whole
CICADA run is stored in /opt/cicada/logs in a date stamped file. More extensive analysis of temperature
performance can be made using these data.
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Figure 5.3: Temperature Plots

Note that changing the temperature read interval to a small value will impact on the performance of
CICADA.

Shutdown Controller

This option should be used before disconnecting the power to the controller. A shutdown sends a POF
command to the SDSU controller making it safe for the SDSU controllers to be powered down.

Get Hardware Status

This option simply sends a GET_STATE command to the SDSU camera slave process. Normally these are run
automatically when the system is IDLE - at a regular interval (determined by the temperature readback interval
in the Temperatures window). This option allows for the retrieval of system status whenever required.

SDSU Configuration

Engineering Mode Operation 

Controlling the setup of the SDSU controllers is via the loading of SDSU setup parameters. This is normally 
done from the preconfigured file /opt/cicada/config/sdsu/controller_name/sdsu.setup. A user in the
cicada group will be able to setup this file by using the Configure Controller... option under the SDSU menu. 
Choosing this option will popup the window displayed in Figure 5.4.
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Figure 5.4: SDSU Configuration Engineering Interface

Here, the ability to selectively enable different initialisation options is available. Once a stable configuration
is arrived at, it can be saved in the default configuration file for default loading by the observer.

SDSU Controller Commands

CICADA also provided the engineer with the ability to send individual commands to the SDSU controller via
the DSP Commands window found under the SDSU menu. This window allows the engineer to direct
commands to each of the SBUS, Timing or Utility circuit boards of the SDSU controller.

To increase the diagnostic output from these commands, the CICADA debug level needs to be modified. This 
debug level operates as a mask and the values in Table5.2.1 are pertinent for SDSU operations.

Table 5.1: Debug levels for SDSU operation

Level Output Description

  

0 Show nothing

256 Show only errors from submitted commands

512 Show commands sent to the SDSU controller

1024 Show replies from the SDSU controller

2048 Run in dummy mode - neither sending or receiving data

Figure 5.5 shows the commands available for sending to the SBUS board. These allow the readback of the
Command Status Register (CSR), the Address register (ADR) and the Byte Count Register (BCR) of the 
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SDSU astro device driver. The ability to reset the device driver is also available.

Figure 5.5: SDSU Sbus DSP
Commands

Figure 5.6 shows the commands available for sending to the Timing board. Here basic (boot) commands to
read a memory location (RDM), write a memory location (WRM), reset the timing board (RST) and test the 
data link (TDL) (fibre-optic link between SBUS interface card and timing card) are available. In addition,
basic controller operations can be performed including: clear (flush) the CCD (CLR), go into idle mode 
(IDL), set gain to high (HGN), and low (LGN), start a CCD read (RDC) (though CICADA will not be ready 
to capture read back bytes - they will just spill) and stop any current operation (STP).

Memory operations can be directed to each of P, X, Y or R memory locations and need an address setting.
Some operations also require a data value to use, for example the TDL command will echo the supplied data
value - if the controller communications are functioning correctly.

Figure 5.6: SDSU Timing DSP
Commands

Figure 5.7 shows the commands available for sending to the Utility board. Here basic (boot) commands to
read a memory location (RDM), write a memory location (WRM), reset the timing board (RST) and test the 
data link (TDL) are available. In addition, basic utility operations can be performed including: abort an
exposure countdown (AEX), open the shutter (OSH), turn on the power (PON), and turn off the power (POF), 
start an exposure countdown (SEX), close the shutter (CSH), pause an exposure countdown (PEX), resume an
exposure countdown (REX) and perform a full system reset (SYR).
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Figure 5.7: SDSU Utility DSP
Commands

Refer to the SDSU documentation for a full description of each of the DSP commands available.

The Astromed 3200 controller

Initialisation of the AM3200
The observer may start a hardware initialisation of the AM3200 controller at any time by selecting the
Initialise CCD Hardware option from the Actions menu of the Observing Window. Progress will be shown in
the Cicada Messages Window and voltages and temperatures will be shown as the hardware initialisation
proceeds. When the initialisation is complete a window showing the final settings for all voltages will be
displayed. (This window can be redisplayed at any time by selecting Hardware Status from the Options
menu. Be aware that the figures shown are as read at the end of the last hardware initialisation). Occasionally
during Astromed 3200 hardware initialisation, the black level is not set correctly (very high values). This bug
also exists with the current Imager software - we are tracking it down. Just repeat the hardware initialisation
to clear.

NOTE: The CCD temperature display on the Observing Window will not display a value until after a
Hardware Initialisation has been run. This is a limitation of the interaction between CICADA and the
AM3200 hardware - basically, the software is unaware of the hardware state until after a hardware
initialisation has been run.

The AM3200 menu
These are the AM3200 specific menu items appearing under the AM3200 menu button in the Observing 
Window:

Continuous Flush & Read Temps

Selecting this button will place the system in a loop where it flushes the CCD and then reads the temperatures
and updates the temperature meters display. The temperature of the CCD is CCDTMP1 and the figure is
under the Actual heading in Kelvin.

Edit Gain Values
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This item will pop-up a window allowing the observer to change the default values for PGain, CCDI and TC.

PGain is a scaling factor which affects the number of electrons per ADU. It’s value and what this value
means by way of a final e/ADU is CCD dependent and the observer should consult with Electronics
staff to find out appropriate values for their particular CCD. A sensible default for each chip is always
set and shown in the pop-up window.
CCDI is the integration time per pixel and adjusting this affects CCD readout time and noise levels.
Once again, consult with Electronics staff before modifying this.
TC is the integrating Time Constant and is used in conjunction with CCDI to set gain. If CCDI is
changed, it is likely that there must be a corresponding change to TC. Electronics staff have the details
about this relationship.

A Hardware Initialisation can be started using the Initialise button in this pop-up window. Use the Defaults
button to reset PGain, CCDI and TC to the defaults for the current CCD.

If the observer wishes to alter the gain of the CCD and modifies these values, the new values are stored in the
.cicadarc-hostname file in the observer’s home area. These values will be restored the next time CICADA is
run and a warning will be given the next time a hardware initialisation is requested so that the observer has
the opportunity to revert to the default values.

Show Temperatures

This is as for the SDSU controller - see section 5.2.

Show Voltage Meters

This option will display a window where the observer can choose to monitor Bias voltages, Clock voltages or
Temperatures. Note that it is not possible to do this concurrently with taking exposures as the reading out of
voltages requires separate software to be loaded into the Astromed controller.

Show Hardware Status

This will display a window showing the voltages set in the Astromed controller at the most recent hardware
initialisation. Some of these voltages change with time and so the values shown in this window may be
incorrect depending on how much time has elapsed since the last hardware initialisation.

Shutdown Controller

This option should be used before disconnecting the power to the controller. A shutdown sets all controller
voltages to zero.

CICADA FITS files
CICADA writes the new multi-extension FITS format. This format is understood in IRAF V2.11 but requires
special processing. For a full description see NOAO’s mosaic image definition.

For single region readouts from single CCDs, normal single image format is written (i.e. no special data
reduction software is required in this case).

FITS files are sized according to the current instrument configuration. Because data and headers are written
by separate Unix processes, enough space has to be set aside in the FITS file to accommodate all headers at
the beginning of an exposure. This space is predetermined by the local site CICADA system administrator
using the camera configuration table. See the CICADA Configuraionanual
http://www.mso.anu.edu.au/computing/cicada/cicada_config/cicada_config.html for detailed information on
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CICADA hardware configuration.

FITS file header composition is made up of a standard set of keywords and additional site-specific keywords.

CICADA FITS Dictionary
CICADA will write a standard set of FITS keywords from the CICADA FITS dictionary - table 7.1:

Table 7.1: CICADA FITS Keyword Dictionary Version 1.1

Keyword Type Note Example Value Description

     

SIMPLE Bool P T Fits standard

BITPIX Int P E 16 Bits per pixel

NAXIS Int P E 0 Number of axes

BSCALE Float P E 1.000000E0 REAL = TAPE*BSCALE + BZERO

BZERO Float P E 3.276800E4  

EXTEND Bool P T FITS extensions are part of this file

NEXTEND Int P 8 Number of extensions

OBSERVER String P ’Gary Da Costa’ Observer name

PROPID String P ’P12345’ Site specific observing proposal identifier

FILENAME String P ’/datagdc/ccd0037.fits’ Original host filename

OBSID String P ’T_40.20000904.184013’ Observation ID

RUN Int P 37 Run number

OBJECT String P ’47 Tuc 120s R’ Observation title

IMAGETYP String P ’object’ Observation type

EXPTIME Float P 1.200000e+02 Exposure time (sec)

EXPREQ Float P 1.200000e+02 Requested exposure time (sec)

DARKTIME Float P 1.206810e+02 Dark time (sec)

INSTRUME String P ’WFI’ Instrument name

CAMERA String P ’WFI1’ Camera name

FILTYP String P ’’ Type of filter

FILTER String P ’R’ Filter name

FILPOS Int P 4 Filter position

DEWAR String P ’DWFI’ Dewar name

READMODE String P ’FAST’ CCD readout mode

WINDOW String P ’USER_DEFINED’ Readout window name

DETECTOR String P ’WFI1’ Detector Name

DETSIZE String P ’[1:8422,1:8282]’ Detector size

NCCDS Int P 8 Number of CCDs
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NAMPS Int P 8 Number of amplifiers

CCDTEMP Float P 1.582721e+02 CCD temperature (K)

FITSKW1 String P ’’ Optional user keyword 1

FITSKW2 String P ’’ Optional user keyword 2

FITSKW3 String P ’’ Optional user keyword 3

FITSKW4 String P ’’ Optional user keyword 4

RA String P T ’00:24:05.4’ Initial RA 1.051125e-01

DEC String P T ’-72:09:08’ Initial Dec -1.259294e+00

EQUINOX String P T ’J2000.0’  

LST-OBS String P T ’ 3:32:-968092763.0’ LST at start (hh:mm:ss.s) -7.0401e+04 rad

LSTEND String P ’ 3:32:-968092763.0’ LST at end (hh:mm:ss.s) : -7.0401e+04 rad

MJD-OBS Float P T 4.058700000000e+04 MJD of observation (days)

OBSERVAT String P T ’SSO’ Observatory

TELESCOP String P T ’40INCH’ Telescope

OBJNAME String P T ’’ Telescope object name

LAT-OBS Float P T 3.127336e+01 Degrees

LONG-OBS Float P T 1.490610e+02 Degrees east of Greenwich

ALT-OBS Float P T 1.149000e+03 Metres above mean sea level

AIRMASS Float P T 1.483511e+00 Airmass

HA String P T ’11:30:23.3’ Hour angle at MJD (hh:mm:ss.s): rr.r (radians)

HAEND String P ’11:40:11.6’ Hour angle at end (hh:mm:ss.s): rr.r rad

ZD Float P T  Zenith distance at start of exposure

ZDEND Float P  Zenith distance at end of exposure

TIMESYS String P ’UTC’ Default time system

UTC-OBS String P T ’18:40:13’ UTC of observation start

UTCEND String P ’18:50:23’ UTC of observation end

DATE-OBS String P T ’2000-09-04T18:40:13’ Y2K date of observation start

TELPAN Float P T dd.d Telescope position angle (degrees)

PIERSIDE String P T ’East’ Side of pier

TELFOCUS Float P T 0.000000e+00 Focus position

FOCNEXPO Int P F 5 Number of focus steps

FOCSHIFT Int P F 40 Number of rows read each focus step

FOCPOSn Float P F 32.3 Focus position n

FOCSOLN Float P F 32.8 Optimal focus position

IMAGESWV String P ’CICADA Release 3.1’ Image creation software version

KWDICT String P ’CICADA FITS V 1.1’ Keyword dictionary version
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XTENSION String E ’IMAGE ’ Image extension

EXTNAME String E ’im1 ’ Extension name

EXTVER Int E 1 Extension version

INHERIT Bool E T Inherit global keywords

IMAGEID Int E 1 Image identification

CONTROLR String E ’WFI_Bottom’ Controller Name

CONSWV String E ’V0.1493’ Controller software version

CONHWV String E ’’ Controller hardware version

READTIME Int E 52416 Controller readout time (ms)

CCDNAME String E ’WFI0_CCD20’ CCD identification

CCDSIZE String E ’[1:2098,1:4136]’ CCD size

CCDNAMPS Int E 1 Number of amplifiers used to readout CCD

AMPNAME String E ’A’ Amplifier identification

GAIN Float E 0.000000e+00 Amplifier Gain (e-/ADU)

RDNOISE Float E 0.000000e+00 Read noise for amp (e-)

SATURATE Float E 0 Maximum good data value - ADU

LINCOEF Float E 0.000000e+00 Linearity coefficient No=Nt(1+Nt**lincoef)

SUMSAT Int E 65000 Saturation level of summing wells

AMPSIZE String E ’[1:2098,1:4136]’ Amplifier size

CCDSEC String E ’[1:2098,1:4136]’ Region of CCD read

CCDSUM String E ’1 1’ CCD pixel summing

BIAS0001 String E ’[1:10,1:4136]’ Bias section - prescan cols

BIAS0002 String E ’[2059:2098,1:4136]’ Bias section - postscan cols

AMPSEC String E ’[1:2098,1:4136]’ Amplifier section

DATASEC String E ’[1:2098,1:4136]’ Data section

DETSEC String E ’[6325:8422,1:4136]’ Detector section

P. Primary header unit

E. Extension header unit

T. Delivered from site-specific telescope control system plugin

F. Only in CICADA generated focus sequence images

Site Specific FITS headers
In addition to the CICADA standard keywords (table 7.1) other keywords can be added to cater for
site-specific requirements. There are a number of ways CICADA can be customised so that these extra
keywords can be included.

Telescope Control System (TCS) interface. Local plug-in interface to the TCS can incorporate extra
keywords.

1.
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Optional Interface to the Exposure Controller. Local plug-in to the exposure controller to account for
local exposure timing information.

2.

Optional Site Instrument FITS additions. Site instrument plug-ins can, optionally, have an associated
set of FITS keywords.

3.

Optional FITS Table. A table of keywords copied into the FITS file without interpretation.4.
Optional FITS Plug-In. A plug-in called after the FITS file is closed to allow it to be rewritten with
updated information.

5.

Keyword name translation. In addition to adding extra keywords, keywords from the standard set may
be renamed by using an IRAF like keyword translation table.

6.

These techniques are described fully in the following sections.

Interface to the Telescope Control System

CICADA expects that an interface to the site telescope control system (TCS) be provided through a
site-specific plug-in. By default, CICADA will use a dummy TCS that will provide fake telescope
information for the FITS headers. This dummy TCS will use the system time and date to generate UTC date
and time headers.

For each exposure a single call is made to the TCS plug-in for supply of the FITS keywords flagged with a T
in the 7.1 table. If some of these keywords are not available then they should be set to be invalid by the
plug-in - CICADA will then indicate so by placing a COMMENT keyword in its place in the FITS file. The call to
the TCS is made near the start of an exposure but because CICADA is a multi-process system, this is not
necessarily at the same time that the shutter opens. To account for this corrections are applied to the returned
TCS time information so that they are correctly aligned with when the shutter actually opened.

In addition to the standard telescope keywords, the site TCS plug-in can deliver an arbitrary number of extra
keywords that are of local interest. These are placed in the primary header unit of the FITS file without
interpretation.

Optional Interface to the Exposure Controller

Some sites will have exposure controllers (shutter, filter wheel controller), that can provide more accurate
local information about each exposure. For example, shutter opening/closing behaviour that cannot be
accounted for by the simple shutter delay setting in CICADA’s configuration. CICADA supports these
instruments by providing a call to the exposure controller plug-in at the end of each exposure. The extra
exposure information is added to the FITS headers along with standard exposure information.

Note that CICADA supports accurate timing of exposures that have been paused/resumed. Using exposure
controller timing information provided by a plug-in might not be able to cope in these situations - check with
the local site to see if this is the case.

Optional Site Instrument FITS additions

For each configured site instrument CICADA allows for the addition of an arbitrary number of keywords
which have been setup for the site instrument. These are configured as a table of keywords in a file set up
(and probably rewritten for each exposure) by the plug-in. This file is re-opened and read at the end of every
exposure and the data is copied without interpretation - it is imperative that the formatting comply with to
standard FITS keyword formatting rules.

This feature allows for the support of site instrument specific keywords that CICADA needs to know nothing
of.

Optional FITS Table

A simple copy of any data in the file /opt/cicada/config/fits_table is made (to the FITS file) if the file exists.
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This data is copied without interpretation, so it is important that it be formatted with standard eighty character
FITS keyword entries. CICADA provides no way of linking the contents of this file with the current exposure
other that through other optional plug-ins. The file is re-opened and read after each exposure finishes and also
after the optional exposure-controller plug-in has been called. This gives the site the opportunity, for
example, to rewrite the file during the exposure controller plug-in - if necessary.

Optional FITS Plug-In

At the end of CICADA’s FITS file construction one last opportunity is given to the local site to modify the
final FITS file. CICADA closes the FITS file and then, optionally, calls a FITS plug-in routine to update the
file with any extra information that cannot be provided by using any of the other methods described above.
For example, the AAO 6dF instrument has FITS BINTABLE extensions that describe the configuration of
the instrument for each exposure. This information can only be added through this FITS plug-in mechanism.

The disadvantage of using the FITS plug-in is the extra time required to read and rewrite a new FITS file.
This cannot be avoided when other methods do not provide the required functionality.

Keyword Translation Table

The keyword translation table enables CICADA standard keywords from the dictionary in Table 7.1 to be 
rewritten so that they comply with site requirements. This table lives in the file
/opt/cicada/config/keyword_translation_table. An example file is as follows and consists of simple
keyword name pairs, with the CICADA (IRAF) standard keyword name on the left.

Table 7.2: An example keyword translation table for CICADA.

The same table can also be used during IRAF data reduction to translate site keywords back to the standard
names expected by IRAF. See the IRAF help system for more information about keyword translation.

CICADA Scripting
It is possible to write scripts in the Tcl language for use with CICADA. These scripts must be run from
within the CICADA observing window using the Run Cicada Script item from the Actions pulldown menu.
CICADA starts a Tcl interpreter and passes the script to the interpreter for execution. CICADA commands
embedded in the script are read by the Tcl interpreter and passed back to CICADA for processing.

A CICADA command consists of the keyword cicada followed by a verb, optionally an instrument part
name, and then optional parameter/value pairs. For example: cicada readout xo1=100 width1=100. The
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following table lists available verbs with associated parameters.

A CICADA command has the following structure:

[cicada] command [instrument_part_name] [parameter=value [parameter=value ...]]

For example:

expose dbs_red duration=100 do_save=1 do_display=1 run_number=100

will run an expose request on the dbs_red camera for 100 seconds saving and displaying the image.

The full CICADA command dictionary is detailed in the following table. The table is formatted into groups
of commands belonging to a particular context, each command is then given in bold followed by a set of
parameters.

The parameters are described with data type and default value enclosed in square brackets. For example, the
parameter ‘‘comment [string , undefined]’’ is a string parameter with an undefined initial value. String values
can be enclosed in double quotes. Boolean parameters take either 0 for false or 1 for true. List parameters
have values separated by commas, for example ‘‘r_x=0,100,200’’. All parameter/value pairs are separated by
white space.

CICADA also sets values of a set of global TCL variables that can be used inside a script. The table lists
these variables, if avaiable, next to each parameter’s default value, for example ‘‘object [string , undefined,
CICADA_OBJECT]’’. They are always upper-case. As an example, one could make use of the variable
CICADA_RUN_NUMBER as follows: 

expose dbs_red duration=100 do_save=1 do_display=1 run_number=$CICADA_RUN_NUMBER

These global TCL variables are set at the start of a script and not updated during a script execution.

General Commands 
status 
Fetch current status of the instrument.

state [ boolean , false] 
If true, get only status structures without status messages.

abort 
Abort the current operation. Usually tries to do this in a clean way so sometimes could see small
delay. Takes no parameters.
set 
Set the value of a parameter for any other command. The set value remains current until
modified by another set or specific command. The following list of parameters can only be
changed with set.

comment [string , undefined] 
Set an optional COMMENT FITS keyword.
object [string , undefined, CICADA_OBJECT] 
Set an optional OBJECT FITS keyword.
observer [string , undefined] 
Current observer name.
prop_id [string , undefined] 
Current proposal id.
read_mode [fast|medium|slow , undefined] 
Readout mode.
auto_archive [boolean , undefined] 
True if FITS files to be archived to configured archive disk.
imagetyp [string , undefined] 
Type of current observation.
fitskw1 [string , undefined] 
Set first user-defined FITS keyword.
fitsv1 [string , undefined] 
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Set value of first user-defined FITS keyword.
fitskw2 [string , undefined] 
Set second user-defined FITS keyword.
fitsv2 [string , undefined] 
Set value of first user-defined FITS keyword.
fitskw3 [string , undefined] 
Set third user-defined FITS keyword.
fitsv3 [string , undefined] 
Set value of first user-defined FITS keyword.
fitskw4 [string , undefined] 
Set fourth user-defined FITS keyword.
fitsv4 [string , undefined] 
Set value of first user-defined FITS keyword.

script 
Execute a TCL script. Cicada runs a TCL interpretor to execute the script that has embedded
Cicada commands.

cmds [filename , undefined] 
Identifies the name of a TCL script file - use a full pathname of a file on the observer’s
computer.

Camera Commands. 
These commands are specific to Cicada cameras.

get_state 
Get state of active components of an instrument - this command forces a reread of instrument
meters rather than collecting state from current shared memory, as the status command does.

get_temps [boolean , true] 
Make a reading of the camera’s temperature sensors.
get_volts [boolean , false] 
Make a reading of the camera controller’s voltages.
get_filter [boolean , false] 
Get camera’s current filter position.

pause 
Pause the exposure. The shutter is closed and the system is ready for a change of exposure time
or repeat count - see command resume.
resume 
Resume the exposure with optionally updated parameters.

duration [seconds , undefined] 
Resume with new exposure duration - this is expressed as a total exposure time, so any
exposure before the pause will be subtracted from this value.
repeat [count , undefined] 
Readjust the exposure sequence counter.
do_readout [boolean , false] 
Do a readout after resume.

init 
Run a camera initialisation sequence

config [boolean , true] 
If true then use configuration data from database, else use data from parameters in memory
and those set on this command line.
do_warmup [boolean , true] 
Do a controlled warmup of the camera using specified warmup rates.
warmup_step [degrees K , 5] 
Warmup at this step for each warmup interval.
warmup_tol [degrees K , 3] 
Continue warmup until temperature is within this proximity to target temperature.
warmup_interval [seconds , 600] 
The interval at which to apply the warmup step.
setpoint [degrees , undefined] 
Temperature setpoint degrees K.
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flush 
Flush the CCDs of charge.

count [integer , 1] 
The number of times to perform the flush operation.

shutter 
Open the shutter for the specified duration.

unit [mseconds , 1000] 
The number of millisecond units.
duration [integer , 1] 
The shutter unit counter. For example, if set to 1 with the unit set to 1000, then the shutter
will open for 1000*1 milliseconds.
dark [boolean , false] 
If true, then the shutter is not opened - ie a dark frame.
open [boolean , false] 
Direct open shutter flag. Interpreted when shutter command used alone.

readout 
Readout the CCD array. Use the parameters set to configure the readout.

do_save [boolean , true] 
save the exposure 
do_display [boolean , true] 
display the image 
clear_display [boolean , true] 
clear display 
frame_mode [boolean , false] 
separate frame display 
approx_scaling [boolean , true] 
true for faster integer scaling 
vis_instructions [boolean , true] 
faster ultra VIS instructions wanted 
camera_coords [boolean , true] 
camera coordinates, otherwise CCD
wait_display [integer , 100] 
display timeout msecs 
display_levels [integer , 200] 
number display levels 
ccdmask [integer , 65535] 
which ccds on a mosaic to read out 
window [string , undefined] 
readout window name 
nregions [integer , 1] 
number of regions 
xo [integer list , 0] 
x offset of region 
yo [integer list , 0] 
y offset of region 
width [integer list , 0] 
width of regions 
height [integer list , 0] 
height of regions 
overscan_cols [integer , 0] 
number overscan columns 
overscan_rows [integer , 0] 
number overscan rows 
rcf [integer , 1] 
row compression factor 
ccf [integer , 1] 
column compression factor 
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adaptive_scaling [boolean , true] 
auto adapt scaling 
contrast [double , 0.5] 
contrast adjustment (0-1) 
rescale_tol [double , 0.1] 
sigmas diff before rescaling 
rescale_rate [double , 0.1] 
rescale rate - fraction of image 
sample_pix [integer , 1000] 
number of pixels to sample 
display_min [double , 0.0] 
fixed min scaling 
display_max [double , 65535.0] 
fixed max scaling 
display_xmag [integer , 1] 
display row zoom 
display_ymag [integer , 1] 
display column zoom 
hotpix_val [double , 65535.0] 
hot pixel value 
do_hotpix [boolean , false] 
mark hot pixels in red 
scaling_type[mode|median,mod] 
adaptive scaling type 
run_number [integer , undefined, CICADA_RUN_NUMBER] 
run number for FITS header 
bitpix [integer , 16] 
number of bits per pixel 
bscale [double , 1.0] 
FITS scaling factor 
bzero [double , 0.] 
FITS Offset factor 
out_dir [directory , undefined, CICADA_OUT_DIR] 
output directory 
out_prefix [string , undefined, CICADA_OUT_PREFIX] 
output filename prefix 
out_suffix [string , undefined, CICADA_OUT_SUFFIX] 
output filename suffix 

expose 
Run an exposure sequence. This command would normally run a flush, shutter and readout in 
sequence to complete, so all parameters for these commands can be set here as well. The
command also has a few specific parameters.

do_readout [boolean ,true] 
optionally do the readout 
do_flush [boolean , true] 
optionally do the flush 
repeat [count , 1 ] 
exposure repeat count 

focus 
Run an focus sequence. This command would normally run a flush, shutter and readout in 
sequence to complete, so all parameters for these commands can be set here as well. The
command also has a few specific parameters.

focus_steps [count , 5] 
number of focus steps 
do_flush [boolean , true] 
optionally do the flush 

drawrect 
This command draws a set or rectangles of a specified colour on the image display.

n_rects [integer , 0] 
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number rectangles to draw.
r_colour [colour number , BLUE] 
rectangle colour
r_x [integer list , 0] 
x position of rectangles
r_y [integer list , 0] 
y position of rectangles
r_width [integer list , 0] 
width of rectangles
r_height [integer list , 0] 
height of rectangles

set_filter 
Set a new filter position.

filter_pos [integer , 0] 
The numerical position of the required filter.

Sdsu Commands. These commands are for the SDSU I and II CCD controllers.
init 
Extra initialisation parameters can be set for the SDSU in addition to the standard camera
parameters.

do_long_test [boolean , false] 

do_short_test [boolean , false] 

do_reset [boolean , false] 

do_power_on [boolean , false] 

pon_timeout [integer , false] 
Timeout for performing a power-on - secs.
clr_timeout [integer , false] 
Timeout for performing a flush - secs.
do_tim_board [boolean , false] 

do_tim_download [boolean , false] 

do_util_board [boolean , false] 

do_util_download [boolean , false] 

do_target_temp [boolean , false] 

do_heater_adu [boolean , false] 

do_gain [boolean , false] 

do_tc [boolean , false] 

do_ab [boolean , false] 

do_idle [boolean , false] 

do_test_pattern [boolean , false] 

test_pattern_constant [boolean , false] 

test_pattern_constant_val [integer , 0] 
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test_pattern_seed_val [integer , 0] 

gain_setting [integer , 0] 

tc_setting [integer , 1] 

ab_setting [integer , 0] 

idle_set [boolean , false] 

auto_rdc [boolean , false] 

tim_set [boolean , false] 

util_set [boolean , false] 

tim_filename [string , undefined] 

util_filename [string , undefined] 
dsp_cmd 
This command sends a specific DSP command directly to the hardware. To be used for low level
testing of specific actions.

board [integer , undefined] 
cmd [sdsu_cmd , undefined] 
memory_space [P|X|Y , undefined] 
address [integer , undefined] 
data [integer , undefined] 

set_clock clk,hl,bd [string , undefined] 
Change a clock parameter, where clk is name of clock, hl is either hi or lo and bd is board 
number.
set_bias bias,bd [string , undefined] 
Change bias parameter.
set_board_param par,bd [string , undefined] 
Change board parameter.
set_param par [string , undefined] 
Change parameter.
set_board_define def,bd [string , undefined] 
Change board define.
set_define def [string , undefined] 
Change define.
build_dsp 
Rebuild DSP code with new parameters

Astromed 3200 Commands 
These commands are specific to the Astromed 3200 controller.

init Specific Astromed 3200 initialisation parameters in addition to standard set.
tc [integer , undefined] 
time constant 
pgain [integer , undefined] 
programmable gain 
ccdi [integer , undefined] 
integration time 
ccds [integer , undefined] 
serial transfers 
ccdp [integer , undefined] 
parallel transfers 

volts 
This command runs the Astromed volts sequence, where voltages are read back and reported in a
continuous loop.
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mode [integer , undefined] 
Mode of volts monitoring, either 1=BIAS, 2=CLOCK or 3=TEMPS.
iterations [integer , undefined] 
Number of iterations to run the cycle.

set_volts 
Set a particular voltage value.

vod [volt , undefined] 
controller voltages.
vog [volt , undefined] 
vrbg [volt , undefined] 
vrd [volt , undefined] 
vabg [volt , undefined] 
vabd [volt , undefined] 
vssl [volt , undefined] 
vssh [volt , undefined] 
ids [volt , undefined] 
vrol [volt , undefined] 
vroh [volt , undefined] 
vrspl [volt , undefined] 
vrsph [volt , undefined] 
viml [volt , undefined] 
vimh [volt , undefined] 
vstoh [volt , undefined] 
vtherm [volt , undefined] 
userp [volt , undefined] 

TipTilt Commands 
Commands specific to the Tiptilt camera are:

change_state 

Dummy Camera Commands. These commands are for the simulation CCD controllers. This allows for
testing of the CICADA data flows when no hardware is attached. A standard FITS image is used for
input data. Alternatively by specifying GENERATE_DATA as the input image, test data is generated.

readout 
Extra readout parameters need to be set for the dummy controller.

in_image [string , undefined] 
name of input FITS file.
pixel_time [double , 3.4] 
time delay to clock a pixel (usecs).

Telescope Plugin Commands 
Cicada supports a simple interface to the local telescope control system, through the use of a plugin.

telescope_get_data Get all standard CICADA FITS header keywords from the TCS.
timeout [integer , undefined] 
Command timeout

telescope_get_param Get the value of a particular parameter from the TCS.
timeout [integer , undefined] 
Command timeout.
param [string , undefined] 
Name of parameter to get.

telescope_set_param Set the value of a particular TCS parameter.
timeout [integer , undefined] 
Command timeout.
param [string , undefined] 
Name of parameter to set.
value [string , undefined] 
Value to set parameter.

telescope_command Run an arbitrary telescope command.
timeout [integer , undefined] 
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Command timeout.
command [string , undefined] 
Name (and parameter list) of command to run.

Filter (Exposure Controller) Plugin Commands 
Cicada supports a simple interface to the local filter wheel controller (sometimes named exposure
controller), through the use of a plugin. The following filter controller commands are supported.

get_filter Gets the current filter position.
timeout [integer , undefined] 
Command timeout.

get_filter_exposure_info Get exposure information from the filter controller if available.
Returns exposure start time, exposure duration, filter name and filter position.

timeout [integer , undefined] 
Command timeout.
param [string , undefined] 
Name of parameter to get.

set_filter Sets the filter position.
timeout [integer , undefined] 
Command timeout.
filter_pos [integer , undefined] 
Filter position to set.

Site Instrument Control Plugin Commands 
Cicada does not interpret commands for site instruments, so support for a simple interface is provided
with an arbitray string command. The site instrument plugin can interpret the string as required.:

site_command Only command supported for site instruments - takes two parameters:
command [string , undefined] 
Site instrument command string.
timeout [integer , undefined] 
Command timeout.

Example scripts
Following are some simple script examples showing, for instance, the use of global CICADA Tcl variables,
Tcl looping, Tcl local variables, Tcl error handling, quoted strings etc.

Exposures with different filters.

# Sample Cicada TCL script for reading out a CCD with different filter
# settings. In this instance, the filter wheel is controlled through the 
# camera interface.
#
set filter 1
# Set exposure parameters
cicada set width=416 height=578 XO1=0 YO1=0 
cicada set DO_SAVE=1 DO_DISPLAY=1 DARK=0 DO_READOUT=1
cicada set UNIT=1000 DURATION=5 REPEAT=1 
cicada set out_dir=${CICADA_OUT_DIR} out_prefix=${CICADA_OUT_PREFIX}
cicada SET object=\"${CICADA_OBJECT}\"
cicada set comment=\"This is a comment\"

# Loop to read 3 images, automatically incrementing run_number
for {set i 0} {${i} < 3} {incr i 1} {
# remove the temporary image if already there, catch any failures
    catch {exec /bin/rm -f /tmp/IM${i}.fits}
# execute an expose request - abort script if an error occurs
    set filter [expr ${filter} + ${i}]
    cicada set_filter filter_pos=${filter}
    set run [expr ${CICADA_RUN_NUMBER} + ${i}]
    cicada EXPOSE RUN_NUMBER=${run} comment=\"Exposure ${i} of script\"
}

1.

Following script shows how to command a telescope instrument control module and take some data.2.
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# Sample Cicada TCL script for slewing the telescope and taking some 
# exposures
#

cicada set width1=100 height1=100 XO1=0 YO1=0 
cicada set DO_SAVE=1 DO_DISPLAY=0 DARK=0 DO_READOUT=1
cicada set UNIT=1000 DURATION=5 REPEAT=1 
cicada set out_dir=${CICADA_OUT_DIR} out_prefix=${CICADA_OUT_PREFIX}
cicada SET object=\"${CICADA_OBJECT}\"
for {set i 0} {$i < 1} {incr i 1} {
# remove the temporary image if already there, catch any failures
    catch {exec /bin/rm -f /tmp/IM${i}.fits}
# execute an expose request - abort script if an error occurs
    set run [expr ${CICADA_RUN_NUMBER} + ${i}]
    cicada telescope_command T_APT command=\"coord 12 13 14.5 -23 12 13 slew\"
    cicada telescope_get_data T_APT
    cicada EXPOSE RUN_NUMBER=${run}
}
cicada telescope_command T_APT command=\"coord 20 13 14.5 -15 12 13 slew\"
cicada telescope_get_data T_APT

CICADA Debug Levels
To increase the diagnostic output from CICADA, the debug level needs to be modified. This debug level
operates as a mask and the values in Table9 are used for assistance during troubleshooting diagnosis. The
level can be set as a command line switch when starting CICADA or from the Cicada Configuration dialog
when running in Engineering Mode.

Table 9.1: Debug levels for CICADA

Level Name Output Description

   

0  Show nothing

1 DEBUG_ESSENTIAL Essential debugging info

2 DEBUG_ENTRYPOINTS Entry point messages

4 DEBUG_INDICATORS Tracewrites to indicate location

8 DEBUG_CALCS Progressive calculations

16 DEBUG_STATUS All status handling

32 DEBUG_SPECIAL Special case temporary debugging

Known Bugs
The free disk space shown in the Mb free field does not give the correct amount of free space available
to the observer on quota controlled disks (e.g. /home, /book disks). The figure displayed will be the
total free space on the disk and not the space remaining in the user’s quota.
When using the SDSU controller for the WFI, during readout an occasional buffer overflow occurs.
This results in missing data in the top four CCDs. At present the observed rate of these failures is less
than 1/100. The top half of the mosaic image from WFI should be discarded.

Troubleshooting
Things don’t work: Most problems with CICADA are resolved by quitting and restarting the software.
So, the first thing to try if there are problems is quitting CICADA and starting up again. When
CICADA starts up it looks for and kills any old CICADA processes as well as initialising operating
system resources that are needed by the software. Note that for the Astromed 3200 controller this does
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not mean you need to do another hardware initialisation. Unlike the Astromed Imager software,
CICADA does not require you to go through the HWINIT procedure upon restart. If problems still
persist, and you suspect the software, contact the Computer Section for help.
Things still don’t work: make sure your home area is not full. Run the command quota -v and make 
sure you have not hit your hard disk limit. CICADA writes preferences and log files in your home area
and insufficient free space can cause problems.
Noise levels rising: Check the temperature of the CCD and/or try re-initialising the controller.
Low memory - performance affected: CICADA and GIT can be very memory hungry, depending on
the size of images being taken. Keep a close watch on the memory warning indicators both programs
have. In the case of GIT, a list of images is maintained - only one of which is loaded into memory at
any one time. These could be floating point images, thus requiring four bytes or memory per pixel. 
Sometimes the system fails to free space occupied by previously loaded images - the space has become
fragmented - it is probably a good idea to stop and restart GIT. In general stopping and restarting both
CICADA and GIT is fast and easy, these problems are then managed.
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CICADA V3.1 
Writing Plug-Ins

Computer Section 
Mount Stromlo and Siding Spring Observatories 
Research School of Astronomy and Astrophysics 

Australian National University

December 13, 2000

User Plug-In Extensions to CICADA
V3.0 of CICADA supports the concept of a user plug-in. This feature extends the capabilities of CICADA so
that local site conditions are handled. Specifically, plugins can be written for:

An interface to a local telescope control system (TCS)1.
An interface to the local filter (exposure) controller.2.
Interfaces to other site instrument controllers.3.
A FITS plug-in for modifying the contents of each FITS file at the end of each exposure.4.
Site-specific GUI plug-ins to interface to the low level control plug-ins.5.

Figure 1.1 shows how these plug-ins fit into the CICADA design. The shaded boxes represent the plug-in
code written to support local requirements.

Figure 1.1: CICADA Plug-In Architecture
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Implementation
Plug-ins are implemented though the use of shared libraries. The user writes a plug-in that conforms with the
CICADA C++ API and then builds the shared library using the supplied makefile. The built shared library
replaces the default supplied shared library for the particular facility.

The API is defined with the remote procedure call language (RPCL) and is compiled using the "rpcgen"
command to generate a "C" header file, which is then referenced in the user plug-in. RPC is used so that
plug-in code can run on a machine remote from the user’s workstation. This functionality is transparent to the
user.

Template and include files are supplied in the directory structure under /opt/cicada/user_libs where shared 
libraries can be rebuilt after modification/addition of site specific plug-ins. Once built the shared library
should be moved to /opt/cicada, replacing the shared library that was already installed. Care should be taken
to make a copy of the original shared library in case problems occur.

The plug-in facility requires the use of a recent version of the Sun C++ compiler. GNU compilers (or any
other C++ compiler) will not work since C++ object files from different compilers cannot be linked.

For the GUI plug-ins the user is required to write a C++ Motif class that inherits basic attributes from a Sun
Workshop Visual generated C++ GUI definition. Though not necessary to use Visual to generate the plug-in,
it is recommended for simplicity - and in that way the CICADA simple_control GUI can be included as a 
base definition.

Telescope Control System Interface
CICADA’s interface to the telescope control system is through the shared library libtelescope.so. The 
interface requires that the following functions be written by the user, where the User_Telescope class is
derived from the base Cicada_Telescope class:

Cicada_Telescope* create_telescope_object(Cicada_Telescope_Desc tel, int do_connect, FILE* report,
int debug) 

Takes as input a Cicada_Telescope_desc which describes the characteristic of a particular telescope
including its name. Based on this name a new User_Telescope instance is created. 

int User_Telescope::get_data(int timeout) 

Retrieves all available telescope data as described in the Cicada_Telescope_Data structure which is 
defined using the RPCL definition. This might consist of a series of individual get_param calls to make 
up the full data structure. 

int User_Telescope::get_param(char* parameter, char* value, int timeout) 

Gets the value of an arbitrary (locally defined) telescope parameter. Sets Cicada_Tele_Config with 
retrieved value. 

user_telescope::set_param(char* parameter, char* value, int timeout) 

Sets the value of an arbitrary telescope parameter. 

int User_Telescope::command(char* command, char* value, int timeout) 

Runs an arbitrary command which might have an associated parameter value. Sets Cicada_Tele_Config
with retrieved result of command. 
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Supplied with CICADA is an example implementation of a plug-in: mssso_telescope.cc. This example 
provides support for the current MSSSO telescopes and is, perhaps, a little more complex than needed for
most cases. However, the user should easily be able to follow this example to construct a new plug-in and
then modify the supplied Makefile to build it.

The definition Cicada_Telescope_Desc for a user telescope is maintained through the standard CICADA
configuration GUI. This GUI allows the user to create a new named telescope with specified interface
information such as controlling host, available data etc. Currently, both serial line and unix socket support are
available for communicating with a telescope computer.

Filter Control System Interface
CICADA’s interface to a filter controller is through the shared library libfilter.so. As for the telescope 
interface, a user filter class, derived from Cicada_Filter needs to be written. The following functions need to
be supplied:

Cicada_Filter* create_filter_object(Cicada_Filter_Desc filter_desc, int do_connect, FILE* report, int
debug) 

Takes as input a Cicada_Filter_Desc which describes the characteristics of a particular filter including
its name. Based on this name a new filter instance is created. 

int User_Filter::get(int timeout) 

Returns as much of the information a filter can deliver for the CICADA filter data structure. This is set
in the filter objects filter_status member variable. 

int User_Filter::set(char* value, int timeout) 

Sets the filter to value requested. 

int User_Filter::get_exposure_info(int timeout) 

Returns as much of the information a filter can deliver for the Cicada_Exposure_Ctl_Info data 
structure. This is set in the filter objects filter_status member variable. 

Again, the example mssso_filter.cc is provided to show how a user filter plug-in can be built.

Site Instrument Control System Interface
CICADA’s interface to an arbitrary site instrument controller is through the shared library libsiteinst.so. 
As for the telescope and filter interfaces, a site instrument class, derived from Cicada_Site_Instrument, needs 
to be written. The following functions need to be supplied:

Cicada_Site_Instrument* create_siteinst_object(Cicada_Site_Instrument_Desc siteinst_desc, int
do_connect, FILE* report, int debug) 

Takes as input a Cicada_Site_Instrument_Desc which describes a particular site instrument including
its name. Based on this name a new site instrument instance is created. 

int User_Siteinst::command(char* command, int timeout) 

Runs an arbitrary command which might have embedded parameter value information. CICADA does
not interpret command in any way. 

Again, the example mssso_siteinst.cc is provided to show how a user site instrument plug-in can be built.
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FITS Plug-in
The shared library libfits_plugin.so contains the users FITS plug-in code. This is called to update a FITS
file at the end of an exposure. The plug-in must supply a function to create an instance of a
Cicada_Fits_Plugin, which must be the base class of a user defined object.

Cicada_Fits_Plugin* create_fits_plugin_object(Nametype fits_plugin_name, FILE* report, int
debug_on) 

Simply takes the name of the the FITS plugin object to create.

int User_Fits_Plugin::update(char* fits_name) 

Takes the name of a fits file to update. 

The example mssso_fits_plugin.cc is provided to show how a user fits plug-in can be built.

GUI Plug-ins
GUI plug-in derived class must include as part of its ‘‘public’’ definition the declarations provided in
simple_control_public.h. simple_control_public.h has the following public methods which must be
implemented by the plug-in:

void Simple_Control_c::initialise_control()

Called immediately after the creation of the telescope GUI by CICADA, allows the plug-in to perform
arbitrary initialisation steps.

void Simple_Control_c::start_status_check()

CICADA calls this routine when it wants the GUI to start a telescope interface status check. This is
usually in response to a CICADA initiated query to the telescope interface which would then require
the plug-in to perform a display update of status.

void Simple_Control_c::handle_status(void *this_status, int idle)

This function must be provided so that CICADA can pass a pointer to a Cicada_Telescope_Status
structure. CICADA calls this routine after the the telescope interface returns status in response to the
plug-in calling the send_command callback. The GUI can then update its window based on the status
information.

Telescope GUI Plug-in

CICADA’s interface to the telescope GUI is through the shared library libsimplegui.so. The GUI requires 
that public methods be written by the user, where the User_Telescope_GUI class is derived from the base
Simple_Control_c class. The plug-in must provide a GUI creation function create_telescope_control that 
returns a pointer to the Simple_Control_c object. This definition is provided in the header
cicada_simplegui.h.

Simple_Control_c* create_telescope_control(Widget parent, Cicada_Telescope_Desc *tel) 

This routine must be provided by the plug-in. CICADA calls it in response to a trigger to popup the
telescope GUI. CICADA passes as input a Cicada_Telescope_Desc which describes the characteristics
of a particular telescope including its name. Also provided as input is the name of a parent X11 widget
for the telescope GUI. Two callbacks are provided, one for handling telescope commands which the
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plug-in uses and the other for requesting command status. These callbacks must be used by the plug-in
for accessing the telescope interface from within CICADA. Based on this information a new
User_Telescope_GUI instance is created and returned by the plug-in. 

Filter GUI Plug-in

CICADA’s interface to the filter GUI is also through the shared library libsimplegui.so. Again, the 
User_Filter_GUI class is derived from the base Simple_Control_c class and the plug-in must provide a GUI
creation function create_filter_control that returns a pointer to the Simple_Control_c object. This
definition is provided in the header cicada_simplegui.h.

Simple_Control_c*  create_filter_control(Widget parent, Cicada_Filter_Desc * filter) 

This routine must be provided by the plug-in. CICADA calls it in response to a trigger to popup the
filter GUI. CICADA passes as input a Cicada_Filter_Desc which describes the characteristics of a
particular filter including its name. Also provided as input is the name of a parent X11 widget for the
filter GUI. Two callbacks are provided, one for handling filter commands which the plug-in uses and
the other for requesting command status. These callbacks must be used by the plug-in for accessing the
filter interface from within CICADA. Based on this information a new User_Filter_GUI instance is
created and returned by the plug-in. 

Site Instrument GUI Plug-in

As for the telescope and filter GUI plug-ins a number of site instrument interfaces can be supported through
the GUI plug-in mechanism. Any interfaces built must also be included in the shared library
libsimplegui.so. And a GUI creation create_siteinst_control must be provided.

Simple_Control_c*  create_siteinst_control(Widget parent, Cicada_Site_Instrument_Desc *siteinst) 

Its definition is similar to those for telescope and filter plug-ins. 

Error Handling
All plug-in functions are designed to handle a returned integer which indicates error status. If an error occurs,
the plug-in should set this return status to a non-zero value and fill the telescope or filter integer valid and 
string error variables with appropriate values.

About this document ...
CICADA V3.1 
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About this document ...

Introduction
This document describes the use of the CICADA configuration tables.

Design of the Tables
Early releases of CICADA had many built-in site-specific sections of code which meant that it was very
difficult to ‘‘export’’ to other observatories. One of the aims of CICADA v2 was to replace these sections of
the code with ‘‘self-configuring’’ code based around simple ASCII tables.

Another aim of releases 2 and later of CICADA was to provide support for multi-controller, multi-CCD
instruments. This requirement also impacted on the design of the Configuration Tables.

The Table Hierarchy

Introduction
An instrument is specified using relational type text tables arranged in a hierarchy. The following diagram 2.1
depicts an instrument consisting of a camera with a dual CCD focalplane and a single ‘‘simple instrument’’
controller.

Figure 2.1: Example instrument component hierarchy

The dashed lines in the diagram indicate that multiple components can be configured. Each node in the
diagram is described by an entry in one of the component tables and is referenced by a component name.
Each entry occupies a single named item in the text table with fields indicated by namevalue pairs. A typical
entry from the camera table looks like this:
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[DUMMY_WFI]
  comment=Dummy camera with 2 controllers;  config1=;  config2=;  
  cont_master=1,0;  cont_shutter=1,0; cont_temp=1,0;  cont_xgap=0,0;
  cont_xo=0,0;  cont_ygap=0,0;  cont_yo=0,4096; controller1=DUMMY1;
  controller2=DUMMY2;  dewar=DUMMY;  host=mistress;  ihu=2;
  n_controllers=2;  phu1=3;  phu2=3;  shutter_closed_when_idle=1;  
  shutter_delay=0; synchronise_readout=1;

This entry describes the camera called DUMMY_WFI which is hosted on mistress. It has two CCD controllers 
named DUMMY1 and DUMMY2 and is mounted onto dewar named DUMMY and does not have a filter wheel.
Controller positioning information is given by vectors cont_xo and cont_yo. Flags are set indicating which
controller controls the shutter and temperature sensors and which is the master. The size of generated FITS
header units is given by phu and ihu. Parameters for shutter_delay and synchronisation during readout are 
also available.

Once an instrument is described by the configuration tables, it can be selected from the user interface and the
necessary processes are started on the configured computers. Configuration tables are maintained either by a
text editor or through the CICADA table GUI interface (accessed via the Hardware Configuration option of
the Options menu).

Viewing the tables
When viewing/editing the configuration tables using the CICADA GUI, the window in figure 2.2 is 
displayed. Simply edit the fields as indicated and click the Apply button to rewrite the table.

Figure 2.2: CICADA Hardware Configuration GUI

As indicated in figure 2.2 use the Category popup menu to select a table for editing. The GUI will then
display the available fields for that table - be careful to select the desired item for editing from the scroll-able
list. Use the Add and Delete buttons to change the number of items in the list for each table. More
information on modifying the CICADA configuration tables is contained in chapter 3.
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The Tables

The Instrument Table - the top level

CICADA is used to control data acquisition instruments and associated simple components controllers.
These instruments are made up of one or more cameras, zero or more instrument controllers and 
(optionally) a connection to a telescope system.

To make the instrument available from CICADA’s Start Observing menu click on the Available at this site
toggle. To enable CICADA to write an observing proposal id into the FITS file headers, select Require 
Proposal ID for FITS. This is a site-dependent option, it requires that a relational database be available with
observing proposal information. Currently CICADA uses the free MySQL package for implementing a
relational database.

Finally, site archiving of data is supported by CICADA. If an archiving directory is entered in the Archive 
Directory field a second copy of the FITS file is made and placed in the specified directory with an
observation identification style filename.

Cameras

Cameras are made up of several components - the dewar, focalplane, temperature sensors, CCD controllers,
possibly filter wheels and CCDs. As explained above, these are configured using the instrument tables in a
relational fashion. The format of each of these tables is described below. Figure  2.3 shows the GUI for
editing the camera table.

Figure 2.3: CICADA Camera Table

CCD Controllers

The entries in this table tell the CICADA software the type of controller in use, the names of the CCDs
connected to that controller and their geometry specified in ‘‘controller coordinates’’ (i.e. if using a mosaic of
8k x 8k pixels, this table holds the information that allows the software to determine where an individual
CCD sits inside the 8k x 8k coordinate space). Figure  2.4 shows the GUI for editing the controller table.
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Figure 2.4: CICADA Controller Table

CCDs

Each entry in this table describes the size and amplifier geometry of a CCD. The values entered in this table
are used in conjunction with the controller geometry to assemble the FITS file and image display generated
by CICADA. Figure  2.5 shows the GUI for editing the CCD table.
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Figure 2.5: CICADA CCD Table

Dewars

At present, for the purposes of CICADA, dewars contain nothing but a focalplane.

focalplanes

Each entry in the focalplane table describes the parameters to do with CCD temperature control. There are
settings here for controlling the rate at which a CCD will be warmed up as well as temperature setpoint and
parameters for heater control and temperature sensor min/max values. Figure  2.6 shows the GUI for editing
the focalplane table.
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Figure 2.6: CICADA focalplane Table

The function of some of these fields are controller dependent. At the time of writing, CICADA supports the
Astromed 3200 controller (AM3200) and the Leach SDSU Generation 1 and 2 controllers. The heater
parameters are not used when the controller is an AM3200. Additionally, because many features which are
configurable with the Leach controllers are ‘‘hard-wired’’ in the AM3200, the specification of temperature
sensors for the AM3200 MUST be as follows:

CCDTEMP1, hardware number 0
CCDTEMP2, hardware number 1
LN2, hardware number 2
PCBTEMP, hardware number 3

In addition, CCDTEMP1 must have the Is Setpoint Temp turned on.

Filter Wheels

This table provides the mapping between filter wheel position and filter name (the name added to FITS file
headers). Note that filter wheels may be controlled directly from a Unix host or from a CCD controller. If via
Unix then either through a serial line or across the network via a socket. Enter the relevant host and port
detail required. Figure  2.7 shows the GUI for editing the filter table.
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Figure 2.7: CICADA Filter Table

Telescopes

This table holds configuration items relating to CICADA’s communication with Telescope Control Systems
(TCS). As for filter wheels access to a TCS is via a Unix host serial line or socket interface. Figure  2.9
shows the GUI for editing the telescope table.

Figure 2.8: CICADA Telescope Table

The CICADA TCS interface is through a site-specific plug-in. Standard data items are delivered by the
plug-in for insertion in each FITS file - items that are available for each site telescope are indicated by
checking the toggle buttons on this window. Take particular note of the Focus toggle - if this is checked, 
CICADA will try to use the FOCUS command to set the telescope focus for automated focus sequences.

Instrument Controllers

CICADA supports control of instrument hardware in addition to CCD controller hardware. The Instrument 
Controller table is used to store instrument controller configuration items. Instrument control consists of
passing instrument specific commands and setting/getting parameters.

Specific support is available for interfacing to the local telescope control system and the instruments filter
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(exposure) controller.

More generic support is available for site-specific instruments. Here CICADA will allow the specification of
simple instrument controls and provide no interpretation of any I/O to and from the controller.

Figure  2.9 shows the GUI for editing the telescope table.

Figure 2.9: CICADA Telescope Table

Temperature Sensor Types

This table allows for the specification of temperature sensor types to be controlled by and connected to a
Leach SDSU controller. The entries in this table contain coefficients for converting ADUs output by the
sensor to temperature. As temperature sensors are usually acquired in batches and the individual sensors of
each type will have nearly identical characteristics, each entry in this table can be re-used many times as the
temperature sensor type in the focalplane table. If individual sensors require minor changes to a standard
type, they should be specified in the Temperature Sensor Table.

Temperature Sensors

The entries in this table inherit characteristics from one of the ‘‘standard’’ temperature sensor types defined
in the Temperature Sensor Types Table. Changes can be made to the polynomial coefficients where they
vary from the standard values.

CICADA Table

This table holds a few software settings such as CICADA administrators e-mail address and group name as
well as a location for CICADA logs.

Modifying the tables

Introduction
The GUI which allows modification of the tables is accessed by selecting Hardware Configuration from the 
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Options menu, either from the CICADA main window or the Observing Window. This menu item is not
available to users who are not members of the CICADA administrators group.

Once the window is visible, you will see the Instrument Table with the entry names of the table displayed in
the scrolling list on the left and the details of the first Instrument in the table displayed on the right.

At the top of the window is a popup menu which gives access to the other tables. When another table is
selected, the scrolling list will change to show the entry names of that table and the details section of the
window will show the first entry in the table (or the entry most recently selected from the scrolling list the
last time that table was selected for viewing).

Depending on the speed of the workstation you are viewing the tables from, you may see the GUI
constructing itself as you move from table to table or entry to entry. This is because the GUI is built
dynamically based on the contents of the table entries.

Adding Entries

In General

The easiest way to add a new entry to a table is to select an entry from the scrolling list which is similar to the
one you wish to add and then click the Add button below the scrolling window. This will make a copy of the
selected entry and blank out the name ready for you to key in a new name and modify any fields as necessary.

If you are building the tables from scratch, just click the Add button and then enter the values in the fields as
required.

Note that not all fields have bounds checking or checks for correctness, so make sure you key details in
carefully.

Note also that the new entry is not really in the table until you click on the Apply button or the Ok button (the 
Ok button performs an Apply and dismisses the window).

If you change your mind about adding the new entry, you can click on the Delete button to remove it.

Guidelines

If you are constructing a new instrument, the easiest way to set up the tables is to work from the bottom up.
i.e. define the entries in the tables lower in the table hierarchy before the new entries in upper tables of the
hierarchy. e.g. in the example shown in 2.1, you would define the tempsensors, then the focalplane, then the
dewar, followed by the CCDS, the controller, the filter, then the simple instrument control and telescope and
finally the instrument itself.

Modifying Entries
Modifying an entry is simply a matter of selecting it from the scrolling list, making the required changes and
selecting the Apply button or the Ok button.

Deleting Entries
To delete a table entry, select it from the scrolling list and click on the Delete button beneath the scrolling
list. CICADA will check to see if the table entry you are trying to delete is in use by any other tables higher
up in the hierarchy and will display an error if this is the case and not allow the delete to proceed.
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Once you have succeeded in deleting the entry from the table click on the Apply button or the Ok button to 
write the changes to disk.

When is it necessary to restart CICADA after 
changing Tables?
Most changes do not require a full CICADA restart. However, if you modify the configuration while an
observing window is open, you will need to quit and restart the observing window for your changes to take
effect. (This is because the tables are read once when an observing window is opened and used to configure
the sub-processes which are started. Changes made to tables are not communicated to already running
sub-processes.)

If you modify the Cicada Table, you must quit and restart CICADA for changes to take effect.

Instrument Changeovers
Let us suppose that your site has a telescope with cassegrain and coudé focii and that there are several CCDs
in common use at either of these focus positions. There are two approaches to setting up the CICADA tables
to cope with changeovers in this case. One is to define all the CCDs and controllers and just have two
top-level Instruments (one for cass and one for coudé). Then, each time there is a changeover someone will
need to go through the hierarchy of tables and make sure that all settings are correct.

Depending on the complexity of the situation at your site, a better approach might be to have multiple
instruments set up for all common configurations, so that you might have instruments named ‘ ‘Cass CCD1
SDSU1’ ’ , ‘ ‘Cass CCD2 SDSU1’ ’ , ‘ ‘Coudé CCD1 AM3200’ ’ , etc. This way, the tables need only be set up
once and rarely modified. All that the changeover staff need to do is make one instrument ‘ ‘available’ ’  and
the other unused setups ‘‘unavailable’’ using the Available at this site toggle in the Instrument Table 
entry.

About this document ...
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Introduction
As a part of the CICADA system MSSSO astronomers identified the need for a quick look window-based
tool that would allow some basic interactive manipulation and display of raw CCD data. To this end the
Graphing and Image Tool (GIT) was devised..

The GIT is not designed to be an image reduction facility but simply to provide basic functionality
(e.g. display, statistics, basic arithmetic, and I/O). It operates on FITS [1] files, and as such can be used in
tandem with versions of IRAF (Image Reduction Analysis Facility, KPNO).

This manual describes version 3.0 of the GIT.
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Starting GIT

From CICADA

When running the CICADA software the GIT and image display can be started up via the Tools menu. For
more details see Chapter  and the ‘‘CICADA User Manual’’ [2].

Standalone

The GIT can also be operated independently of CICADA in standalone mode. To start up the GIT simply
type /opt/cicada/git [optional parameters] (see Section  for optional parameter details). This will fire
up the GIT graphical user interface (GUI) and the image display.

Optional Parameters

The GIT accepts the standard X11 optional parameters (e.g. geometry, colour, etc) as well as:

-imagedir directory
Default directory to read and write images and FITS files from and to. If not specified the directory
from which the GIT was started is used.

-cicada n
The GIT will be started in CICADA mode. See Chapter  for details.

-debug
Switches on debug mode.

The User Interface

The GIT user interface (Figure ) was designed and constructed using a GUI builder. It is an X-window
based GUI built from Motif widgets, with a few extra specialist widgets.

Figure: GUI upon initial startup
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The GUI is comprised of six distinct and separate areas :

Menu Bar (Section )
Toolbar Button area (Section )
(scrollable) Image List (Section )
(scrollable) Messages area (Section )
Help text (Section )
Graphics Help text (Section )

Menu Bar
The menu bar contains pull-down menus (File, Image, Vector, Options and Help). These menus can be
activated with either left or right mouse button. Single clicking will pop the menu up. Holding the mouse
button down will only keep menu items visible while the button is depressed over the menu title.

Some menu items will appear greyed out from time to time. When an item is greyed out the specific option is
not currently meaningful. For example, when the GIT is started up the menu item for displaying an image
will be inactive, and will stay that way until the user loads an image.

Some menu items have keyboard accelerators (Section ) associated with them.

The File Menu

The file menu has three main uses :

Reading and writing FITS files into and out of the GIT (Chapter ).
Displaying FITS header keywords (Section )
Exiting the GIT

The Image Menu

The image menu is designed mainly to operate on 2-dimensional images and allows the user to :

Display an image (Section )
Perform arithmetic on images (Chapter )
Examine stellar profiles (Chapter )
Calculate full width half-maximum (Section )
Perform a focus fit of a focus image (Section )
Calculate statistics (Chapter )
Extract a sub-image (Section )
Get a hardcopy of an image (Section  and Chapter )
Store an image in the GIT internal memory (Chapter )

The entries for Statistics, Subimage and Print are described in detail in Chapter , and Sections , and .

The Vector Menu

The vector menu is designed to operate on 1-dimensional images and allows the user to :
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Plot a vector (Section )
Show/hide the vector plot window
Store a vector in the GIT internal memory (Chapter )

The Options Menu

The Options menu has items that permit the user to start up a private image display when in CICADA mode,
or to reconnect to the CICADA display. The user can also access the GIT preferences (Chapter ) under this 
menu.

The Help Menu

The help menu currently has options What’s New and About GIT. For more information see Chapter .

Keyboard Accelerators

A number of menu items have keyboard accelerators associated with them. All are of the form
control+<key>. This means the appropriate control sequence at any time will select that command without
use of the menu. Table  lists all accelerators.

Table: Keyboard Accelerators

Ctrl+<Key> Operation

A Image Arithmetic

D Display Image

Q Quit

H FITS Header

I Sub-Image (via display)

M Interactive Vector Modification

P Star Profile

F Full Width Half Maximum

L Load Image

S Image Statistics (whole Image)

U Unload Image

V Vector Plot mode

W Write Image

Toolbar Button Area
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This area contains a number of icon buttons for commonly used operations, some of which do not have
keyboard accelerators associated with them. The buttons are one-off operations as opposed to putting the GIT
into a mode. The buttons and the commands they carry out are described in Figure . When the cursor is 
moved over one of these icons, a line of help text is displayed in the line help area of the GUI.

Figure: GUI toolbar buttons

Image List
The image list is a scrollable window containing the names of all images currently loaded into the GIT. These
names are full pathnames of FITS files on disk. If the user tries to load or create an image with the same
name as one already in memory they will be asked whether they wish to overwrite. Only one image can be
currently in use, and the name of that image is shown in inverse video.

Single clicking with the mouse will select an image as the current one, and an informational message 
indicating that it has been loaded is displayed. The selected image is also displayed on the appropriate display
depending on whether it is 1- or 2-dimensional.

Informational Text
Informational text is located in a scrollable window in the right portion of the GUI. Messages appear when
images are loaded, unloaded, displayed; when statistics are calculated; sub-images taken, etc. As well,
warnings and error messages are written to this area. There

There are also progress and informational messages displayed in the text area of the GUI window while GIT
is processing or when the cursor is moved over the toolbar.
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Graphics Help Text
When the user selects a mode that requires graphics input, either from the image display or the vector 
display, legal keystrokes and their operation are displayed in this help text area. Legal keystrokes for each
mode are listed in the appropriate sections of this manual.

Preferences
There are a number of preferences available for the user to customise the behaviour of GIT.
Choosepreferences under the Options menu to see a pop up a window with available parameters (see Figure 

 for an example). Separate preference screens for Image Display (Section ), Vector Display (Section ), 
Statistics (Chapter ), Star Profile (Section ) and General (Sections  and ) are available.

Appropriate sections of this manual describe each of the preferences, with valid ranges and values. To select
a screen click either the LH and RH mouse button over the Select Category menu button, and select the
required preference set to display.

After setting one or more preferences the user may click Apply which will ensure that the new values are
picked up by the GIT but leave the window open. Selecting Ok will save the preferences and close the popup 
window. Cancel will remove the window without updating preferences (although any prior Apply’s will have 
already been carried out).

Preferences File

Preferences are written to disk in the file $HOME/.gitrc, where $HOME is a pre-defined system environment 
variable pointing to a user’s home area (see Appendix  for an example $HOME/.gitrc file). When the GIT is 
started up the $HOME/.gitrc file is read, if it exists, and is re-read whenever the preferences window is popped
up.

Users can edit the .gitrc file by hand but must ensure that they do not corrupt the format. If the file is edited
while the GIT is running, changes will take effect when the preferences option is selected.

Lines beginning with a # are comment lines, they are followed by the parameter name and value separated by
a colon. For example,

# Image display scaling type (HOPT/MINMAX)
image_display_mode : HOPT

FITS Files
The GIT uses its own internal data format which has many similarities to the FITS format.

Images are read into, and written out from, the GIT’s internal memory via disk FITS format files. These may
be 1- or 2-dimensional FITS images. Irrespective of the FITS data type (integer, real or double precision) the
GIT stores the data internally in 4 byte floating format (i.e. single precision). This means a double precision
FITS file may cause over or under-flows. At this stage there is no plan to enable the use of double precision
numbers due to memory and speed restrictions. If a double precision FITS file is read into the GIT the user
will receive a warning message.
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Preferences
There is no separate preferences page for FITS files, but one user-definable preference is found under the
General category - FITS output.

There are two standard FITS header keywords : BSCALE and BZERO. Their default values are 1 and 0,
respectively. Data values in a FITS file are scaled such that

 = ×  + 

This permits data with a large dynamic range, or a large scale value, to be represented by a more compact
data type than would be otherwise possible. There is a drawback in a possible loss of precision.

A user has the ability to set the preference such that either precision is preserved or the output data type is the
same as the input data type. If precision is preserved then the output data type is set to real (BITPIX = -32) so 
that BSCALE is left as 1. Otherwise, BSCALE and BZERO are calculated, written to the FITS header record, and 
data values scaled accordingly with a possible loss of accuracy.

Reading an Image
To read an image into the GIT select the Load Image item in the File menu (accelerator: Ctrl+L). A standard
file-selection popup window is then displayed allowing directory browsing for the required file.

As a FITS file is being read a message of the form: 
FITS READ: directory/filename 
will appear in the information window. Upon successful loading a further message will be issued: 
IMAGE LOAD: filename (x × y) where (x × y) are the dimensions of the image.

Images that are successfully loaded are visible in the scrollable image list portion of the main GIT window.
Their name is the full pathname of the original FITS filename on disk.

When an image is loaded it becomes the current image and is displayed. The current image is indicated in the
image list by being shown in reverse video.

Unloading an Image
Any image read into the GIT takes up an amount of computer memory approximately equal to 4×x×y bytes
(i.e. 4Mb for a 1024×1024 image). - when it is the current image. All other images in the list are not loaded
into memory until they are selected. The GIT provides an unload mechanism to remove unwanted images. To
use this, select the image to be unloaded, and then Unload Current Image (Ctrl+U) from the File menu. When
in CICADA mode images are unloaded automatically as soon as more than the maximum number of
CICADA images is exceeded (see Chapter ).

The GIT provides a mechanism to ensure that a user does not accidentally run out of memory when reading
images in, or operating on them. Before each memory intensive operation a check is made of the available
memory to determine if it will still leave a GIT-defined amount free after the operation. If not, the user will
be notified and will not be able to load the image until some memory is freed up.

There are several possible sources of memory usage. Examples to look for are:
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Too many memory intensive applications running (for example, Web browsers, News readers). If this
is a likely cause kill off some to free memory.
/tmp may have been filled up with junk files. Check and remove if necessary.

Writing an Image
Any image in the GIT memory may be written out to disk in FITS format. To do this, select the image to be
written, and then Write Image from the File menu (accelerator: Ctrl+W). A file selection box will popup
whose areas and operation is the same as when reading a FITS file into the GIT (see Section ). The default
selection is made up of the current directory and a filename comprising the image name stub with .fits
appended. The user can then change the output directory, filename and/or the file extension and write the
image out by hitting the OK button, or <return>.

It is not possible to overwrite a FITS file that already exists. If this is attempted a message will be printed to
the informational window : 
File (filename) already exists

Any images created within the GIT will be written out as real format FITS files (i.e. BITPIX = -32). If an 
input image was a FITS file the output type will be the same as the input type (e.g. short integer input will be
written out as short integers). However, in this case it is necessary to determine whether the desired output
type is compatible with the image range and scaling. If not, if the user has asked for precision to be
maintained (Section ) the output bitpix is set to real, otherwise the output type is kept the same and BSCALE
and BZERO are calculated and used.

FITS Headers
If an image is read in from a FITS file the user is able to look at all the FITS header keywords/values present
in the original file. This is done by selecting FITS Header from the File menu (accelerator: Ctrl+H). If the
operation is done on an image that is not a FITS file a warning is printed to the informational window: FITS 
HDR: Not a FITS file.

WARNING : FITS Header Information

An image stored in the GIT internal memory that was read from a FITS file retains only a few of the original
FITS header keywords that are directly required in creation of the image :

BITPIX
The number of bits/pixel (i.e. the datatype)

NAXIS
The number of axes (i.e. 1- or 2-dimensional)

NAXIS1, NAXIS2
The dimensions of the image axes

BSCALE, BZERO
(if they exist) Specifying scaling of the data values from the FITS file to actual values

All other keywords are ignored. Hence, if the user reads a FITS file in, and then writes a copy of it back out
(whether or not it has been modified) any other original FITS keywords will be lost.
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Image Operations

2-Dimensional Images

Image Display

The GIT uses the MSSSO modified version of the IRAF ximtool for displaying 2-dimensional images. When
the GIT is started it automatically fires up a custom version of ximtool using private input and output pipes.
The full functionality of ximtool is available to a user using the GIT. To make the best use of ximtool users
should be familiar with its capabilities. When the GIT is exited the image display will be closed down.

To display an image, select it from the image list. To redisplay the currently selected image, select Display
under the Image menu (accelerator: Ctrl+D), or use the Display button.

Preferences

Figure: Popup window for image display Preferences

Image Scaling
The image scaling preference defines how the minimum and maximum displayed pixel intensities are
determined. Pixels below the minimum value (lower cutoff) are shown in ‘‘black’’ while those greater
than the maximum (upper cutoff) appear ‘‘white’’. The three possible values are: HistOpt - Median,
HistOpt - Mode and Min/Max. The Min/Max option allows the user to specify the cutoff values, while
with HistOpt values are calculated automatically. [Valid values : HOPT_MEDIAN, HOPT_MODE, MINMAX]

Sample %
Used with Hist Opt scaling. It represents the percentage of total number of pixels in an image to sample
when determining the lower and upper intensity cutoffs. The sampling is done linearly. The larger the
value the slower the calculation of cutoff values. For most images a value of 5 - 15% is adequate. 
[Valid range 1...100]

Num SDs below for cutoff
Used with Hist Opt scaling to calculate lower intensity cutoffs to be a number of standard deviations
below the median or mode. Values of 1 - 1.5% are usually adequate in obtaining images displayed with
a good dynamic range. [Valid range 0.01...10]

Num SDs above for cutoff
Used with Hist Opt scaling to calculate upper intensity cutoffs to be a number of standard deviations
above the median or mode. Values of 1 - 1.5% are usually adequate in obtaining images displayed with
a good dynamic range. [Valid range 0.01...10]
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X Bin
Binning factor for display compression in the x-direction. [Valid range 1...20]

Y Bin
Binning factor for display compression in the y-direction. [Valid range 1...20]

Rotation
Angle to rotate the image by before display. [Valid range 0...359]

Display Frame
Ximtool frame in which to display the image. Ximtool has the ability to dynamically create frames 
when requested. [Valid range 1...4]

Hot Pixels
If checked, will enable pixel intensities greater than the selected value to be displayed in red.

Hot Pixel Value
A numerical value which is the limit, above which, hot pixels will be shown if that preference is
selected. [Valid values: any real number]

Saturated Pixels

The ability for a user to be able to easily see saturated pixels on a CCD image has driven this functionality.
The user can specify whether pixels greater than a given threshold limit are shown in red by checking the Hot
Pixels toggle button to enable it.

Note that if a user modifies the image display colour look-up table to one that has reddish tones these
‘‘saturated’’ pixels may not be visible.

Sub-Images

Sub-images (either 1 or 2-dimensional) can be created from a displayed image (Section ) using the image 
display, or the limits can be specified manually (Section ). In both cases the sub-image is sent to the
appropriate image display, and the user can then elect to store it in the GIT’s internal memory if required
(Chapter ).

When a 1-dimensional image is extracted, sky subtraction will be performed if the user has selected that
preference (Section ) and the extraction was done via the image display. See Section  for details of 
1-dimensional image extraction.

Sub-image via Image Display

A sub-image can be selected from a displayed image via the image display using the Subimage via Display
option under the Image menu (accelerator: Ctrl+I). This puts the GIT into subimage mode and warps the
cursor into the image display. Valid keystrokes (case independent) which can be used in the image display
window are listed in the Graphics Help Text section of the main GIT window (Table ). This mode must be
exited before control is returned to the main GIT window.
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Table: Valid Sub-image mode keystrokes (case
independent) for the image display.

Keystroke Operation Dimension

C Column extraction 1

Q Quit subimage mode  

R Row extraction 1

X X-Y slice extraction 1

<space> Use twice specifying diagonally  

 opposite corners 2

Sub-image via Popup Window

A sub-image of a displayed image can be selected via a popup window by the Subimage via Popup option 
under the Image menu. Lower and upper limits in X and Y are specified. If a value is entered outside the
image limits it is automatically reset to the lowest or highest legitimate value. Selecting Apply will extract the
sub-image, leaving the popup visible. Selecting Ok will extract the sub-image, and close the popup.

To extract a 1-dimensional sub-image give either the X or Y low and high values the same, as required. It is
not possible to extract a 1-dimensional X-Y slice via this method, use the image display method instead.
(Section ).

Hardcopy

A hardcopy of the currently displayed image can be made by selecting Print under the Image menu. For more
details on printing see Chapter .

1-Dimensional Images

Image Display

The GIT uses MIT plotter widget for displaying 1-dimensional images (vectors) (see Figure  for an 
example).

To display a vector choose it from the image list and then select Display under the Image menu (accelerator: 
Ctrl+D), or use the Display button. Double clicking on a vector in the image list will also load and then
display it.
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Figure: X-Y slice from pixel (36,204) to (374,220)
of the image ccd0698.fits not summing any 

additional rows, with no sky subtraction, and not
zoomed.

The plot window may be resized at any time and the current plot will be resized and redrawn.

Preferences

Figure: Popup window for the Vector display
Preferences

Scaling Function
Define a function (none, natural logarithm, log base 10, mode, square, square root, or inverse) to be 
applied to the data before plotting the vector. With the mode calculation the lower and upper cutoff 
values are taken from those given as the statistics preferences (Section ). [Valid values: NONE, LN,
LOG10, MODE, SQR, SQRT, or INVERT]

Scale Factor
A multiplicative factor applied to the data before plotting if a scaling function of either none or mode is
used. [Valid values: any real number]

nsum
Number of image ‘‘lines’’ to add together before plotting. ‘‘Lines’’ can be either rows, columns, or
X-Y slices depending on the type of extraction used (see Section ). [Valid range: 1...100]

nsum sky
Number of image sky ‘‘lines’’ to add together. These rows are normalised to match the image nsum. 
[Valid range: 1...100]

Start pixel
Lowest pixel to use in a vector plot. [Valid range: 1...4196]

End pixel
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Highest pixel to use in a vector plot. [Valid range: 1...4196]
Subtract sky

If checked, then sky subtraction is performed before plotting.
Maintain zoom factor

If checked, causes the vector plot zoom factor to be remembered and used with subsequent plots.
Auto plot on image load

If checked, then the last plotted ‘‘line’’ is re-plotted when a new image is loaded in the GIT memory
when running in CICADA mode.

Sub-image Extraction

To extract a 1-dimensional image from a displayed 2-dimensional image select Line Plot from the Vector
menu (accelerator: Ctrl+V). This will put the GIT into line plot mode and warp the cursor to the image
display. Valid keystrokes are those listed in Table . Note that the mode needs to be exited before control
is returned to the main GIT window.

Table: Valid line plot mode
keystrokes (case independent) for 

the image display

Keystroke Operation

C Column extraction

Q Quit subimage mode

R Row extraction

X X-Y slice extraction

If the user wishes to do a single line plot, then the Line Plot icon button may be used instead of entering line
plot mode. The same keystrokes are available.

The Repeat Line Plot icon button will repeat the last line plot again (same type of plot, same coordinates,
same zoom factor). This is of use when displaying a number of images and wanting to do a vector plot of the
same section.

When a 1-dimensional sub-image (vector) is extracted from a 2-dimensional image there are a number of
parameters that affect how the vector is formed. These are described above (Section ).

Firstly, the parameter nsum is used to determine how many ‘‘lines’’ to sum together. The ‘‘line’’ that the user
specifies is the central ‘‘line’’. If sky subtraction is required the user will have specified a sky ‘‘line’’ as well.
The parameter nsum sky is then used to create a summed sky ‘‘line’’. The sky is normalised to the image
before being subtracted off the vector. Finally, if a scaling function and/or scale factor was specified they are
applied to the vector, and the result plotted.

If the user has selected sky subtraction then after specifying either the row or column to plot they will be
prompted for a sky row or column. Note: in the current version there is no sky subtraction for X-Y slices,
nor for vector extraction through the sub-image popup window.

If the maintain zoom factor option is set then new vector plots will be done with the current zoom factor.

Vector plots are titled with: image name, row/column/x-y values, nsum, an indication if sky subtracted, and
zoom factor (if zoomed).
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Hardcopy

To get a hardcopy of the currently plotted vector select Print under the Vector menu. For more details on
printing see Chapter .

Manipulation

It is possible to manipulate a 1-dimensional vector plot somewhat via modify plot mode. This is entered by 
selecting the Modify item under the Vector menu (accelerator: Ctrl+M). Table  shows the valid keystrokes
available from within the plot window while in this mode. Note that this mode must be exited before control
is returned to the main GIT window, and that the GIT window will not be refreshed while you are in the
mode. It is anticipated that this limitation will be addressed in a future release.

Table: Modify Vector Plot Mode Keystrokes

Key Operation

A Expand and Auto-scale

C Redraw Original

F Full Width Half-Maximum

M Statistics

Q Quit

R Reverse/Flip

S Smooth

U Zoom out

Z Zoom in

> or . Display line plot section to the Right

< or , Display line plot section to the Left

<space> Print (x,y) coordinates

Expand and Auto-scale
Hit this key twice, specifying the x-position of both ends of the expanded plot. The y-scale of the new
plot will be determined based on the data in the expanded section.

Redraw Original
The original plot is redrawn, with no smoothing or zooming.

Full Width Half-Maximum
This key must be hit twice to determine the FWHM of a profile, once on either side of the line. The
y-position is important because it is used to calculate a base-line. The result is output to the vector plot
window. See Chapter  for general details on FWHM calculations. This does not work for absorption
lines.

Statistics
This key must be hit twice, to specify the x-position of both ends of the vector segment for which
statistics are calculated. The minimum, maximum, and mean values, together with standard deviation,
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are output to the vector plot window.
Quit

Use this to exit modify vector plot mode.
Smooth

The user will be prompted to enter a smoothing value (odd number) in the vector plot window. A
running box of the requested size is used for smoothing.

Zoom In/Unzoom
The plot is zoomed in (or out) by a factor of 2 in the x-direction around the x-position of the cursor.
The y-scale is auto-scaled.

Left/Right Sections
Using the less-than and greater-than keys (or comma and period) allows a user to move along an
expanded plot in the x-direction.

(x,y) Coordinates
Hitting the <space> bar causes the x-value of the cursor position to be output to the vector plot window,
together with a linearly interpolated y-value.

Storing an Image in Memory
Any image (either 1- or 2-dimensional) that is displayed can be stored in the GIT’s internal memory. Select
Store in Memory under the Vector or Image menu as appropriate. A file selection popup window will appear
allowing the user to specify the new FITS file name.

Hardcopy
The hardcopy device is that which the user has defined in their Unix environment at the time the GIT is
started up. This is controlled by the PRINTER Unix environment variable. If not set, hardcopies will be sent to
the default system-defined printer.

The engine driving the output for 2-dimensional images is ilaser -- the same as that available from FIGARO.
There are no user-configurable options with the GIT version.

Vector (1-dimensional) plots are carried out using the MIT plotter widget (see, for example, Figure ).

Image Statistics
When statistics are calculated the results are written to the informational text section of the main GIT
window. Information comprises the image name, and dimensions; the minimum and maximum values; the
mean, mode and standard deviation. For example,

IMAGE STATS: /tmp/130.fits (416x578)
   min=0.00, max=65535.00, mean=1622.30,
   std dev=754.61, mode=1607.00

2-Dimensional Images

2-dimensional image statistics can be calculated for the whole image, or specified in either a popup window
or via cursor input on the image display.
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For the whole image select All Image from the Statistics menu under the Image menu (accelerator: Ctrl+S).
Alternatively, use the Statistics icon button on the main GIT window.

To specify part, or all, of an image via a popup window select via Popup from the Statistics menu. A window 
will pop up with default values in X and Y of the image dimensions. The operation of this window is
identical to when specifying sub-image extraction (see Section ).

To specify part of an image via the image display select via Display from the Statistics menu. The GIT will 
enter statistics mode which is identical in operation to sub-image extraction via the image display (Section 
). Either a 1- or 2-dimensional section will be used for statistics depending on the keystroke(s) (Table ).

1-Dimensional Images

Statistics can be calculated for part, or all, of a 1-dimensional image while in modify vector mode (Section 
).

If a 1-dimensional image is the current image in memory, either via selection from the image list or by being
the last image displayed, the Statistics button (accelerator: Ctrl+S) will operate on that image.

Preferences

There are a number of configurable statistics preferences which are accessed via the Statistics category from 
the Preferences option under the Options menu (Figure ).

Show Statistics Plot
If checked, a line plot window will show a histogram of values in the statistics.

Ignore Values < =
Values less than this will be ignored when calculating statistics. [Valid values: any real number]

Ignore Values > =
Values greater than this will be ignored when calculating statistics. [Valid values: any real number]

Figure: Popup window for the image Statistics
Preferences

Image Arithmetic
The GIT is able to carry out a range of basic arithmetic functions on images. These are operations:
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with images as both operands
with an image and a scalar
to apply a function to an image

To enable calculations to be carried out select Arithmetic from the Image menu (accelerator: Ctrl+A). This
will pop up the arithmetic window (Figure ).

Figure: Arithmetic popup window

To select the type (that is, Image, Scalar, or Function) for the left and right operands use the appropriate
pull-down menus in the Arithmetic popup window. When an image is used the list of currently loaded images
is displayed. When a scalar operand is required a numeric box will show up. For functions a list of available
options will appear as check boxes.

Function types available are:

Natural Logarithm (ln)
Square (sqr)
Inverse
Square Root (Sqrt)
Base-10 Logarithm (Log10)

Results

Clicking the Result button will carry out the calculation, and if an image is involved pop up a window
allowing the user to save and the resulting image. The result is then displayed and set to be the current image.
Memory checking is done, as with loading any image, to ensure that sufficient resources exist on the
computer.

Irrespective of whether an image is involved information on the calculation will be written to the
informational section of the main GIT window.

The input type of images, and the types of any function or scalar used are checked so that the FITS file is
created with appropriate precision. Some examples are:

two short integer input images would create a short integer output FITS file
two integer input images would create an integer output FITS file
any division creates a float output FITS file
any function creates a float output FITS file
application of an integer scalar to an integer image will create an integer FITS file
application of a float scalar to an integer image will create a float FITS file

Error Checking

When arithmetic is done on two images they are first checked to ensure they have the same X and Y
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dimensions. If not, the user is informed and no calculation done.

It is possible to get divide by zero and other non-meaningful numbers in calculations, and these are handled
gracefully. For example:

ARITH: 1.000000 / 0.000000 = Inf
ARITH: Sqrt(-1.000000) = NaN

These results are part of the IEEE floating point standards, and values such as infinity and not a number
(NaN) are representable in the IEEE floating point format.

Image Object Profiles
The image display can be used to plot radial profiles of objects. The option Star Profile under the Image
menu (accelerator: Ctrl+P) will put the user into profile mode. The keystrokes listed in Table  are the only 
ones available.

Table: Profile Mode
Keystrokes

Key Operation

Q Quit

<space> Select object

Preferences

The Star Profile page (Figure ) of Preferences under the Options menu has the following:

Display profile
If checked, the profile is plotted to the line plot window.

Aperture Size
The radius of the aperture (pixels) to be used when determining the centroid, and for setting plotting
limits. [Valid range: 1...50]
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Figure: Popup window for the Star Profile
Preferences

Use

The user selects an object using the image display cursor, and the GIT determines a centroid based on an
aperture size. If the centroiding fails a message is printed out to the informational text area on the main GIT
window. If the display profile preference is selected the radial profile is plotted.

Irrespective of whether the profile is plotted the (x,y) values of the centroid and full width half-maximum
(Chapter ) are written to the informational text area. For example,

Centroid: (203.78,341.86)  Aperture Size=12
FWHM = 4.52

Full Width Half-Maximum
The GIT may be used to determine the full width half-maximum (FWHM) from a 2-dimensional image via
the display, or from a 1-dimensional image via the line plot window.

The FWHM is calculated by fitting a Gaussian to the data values using the Levenburg-Marquardt method.

2-Dimensional FWHM

This is invoked by the FWHM button on the Image menu and will put the user into FWHM mode with the 
keystrokes listed in Table  available. The GIT stays in the mode until explicitly exited, at which stage
control is returned to the main window.

Table: FWHM Mode Keystrokes

Key Operation

Q Quit

X at each end to select object
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The user must specify each end of the X-Y slice that is used to determine a FWHM. This 1-dimensional
vector is plotted to the line plot window. The value of the FWHM is written to the GIT informational text
window.

1-Dimensional FWHM

A 1-dimensional image which is plotted can have a FWHM calculated from within modify line plot mode --
see Section  for details of use.

Focus Fitting
This is invoked by the Focus Fit button on the Image menu and will start an automated focus fitting
procedure of the selected image - if it is a focus image. GIT will check the image FITS headers to see if the
FOCNEXPO and FOCSHIFT keywords are present, if not then GIT prompts the user for values to use (see figure
).

Figure: Popup window
for the Focus Fitting 

parameters

Using these parameters GIT attempts to locate a sequence of stars in the image to which FWHM are
calculated and then a quadratic is fitted to the FWHM and focus position data. This is then plotted with the
optimal focus position indicated.

Miscellaneous

CICADA Mode
When the GIT is started up with the optional parameter -cicada n it will automatically load images into its 
memory directly as they are read out from a CCD with CICADA. Informational messages will appear
normally, and the images will show up in the image list together with any images the user reads in or creates.

Display of the CCD images is done automatically by the CICADA software [2].

The parameter n indicates the maximum number of CICADA images to be retained. This value can be
modified from within the GIT as a preference. NB. Normally the GIT is started from CICADA itself where
this value defaults to 10.
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Image Display

By default, when in CICADA mode the GIT uses the CICADA ximtool image display. If GIT attempts to
display an image while CICADA is displaying, a message indicating that the ‘‘display is already in use’’ is
written to the message window.

Alternatively, the user can start up a ‘‘private’’ image display when in CICADA mode, thus avoiding any
contention. This is just the normal standalone display that is started when not running CICADA. There is a
preference that can be set to allow this as default (Section ). When this is used the CICADA images
continue to be displayed automatically to one display, while the user is free to use the other for display and/or
manipulation.

A user can start this separate image display using Start Private Ximtool under the Options menu. It can be
cancelled and the GIT reconnected to the CICADA display at any time via cancel Private Ximtool under the 
Options menu.

Preferences

CICADA preferences are found under the General preferences screen (see Figure ).

Figure: Popup window for the General Preferences

Cicada mode
If checked, indicates to use CICADA mode upon startup. If the GIT is started by CICADA then this
box will not need to be checked by the user for correct operation.

Maximum Cicada images
The user can modify the maximum number of images to be held in the GIT’s image list while it is
running. [Valid range: 1...10]

Private Ximtool in Cicada mode
Checking this box allows the GIT, upon startup, to use its own ‘‘private’’ image display when in
CICADA mode (see Section  for details).

Quitting
To quit the GIT select Quit from the File menu (accelerator: Ctrl+Q). Any images which have been stored in
memory but not written to disk can be saved at this time. If there are any such images a window will pop up
asking the user if they wish to save the image(s). The user has the following options:
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Saving none and exiting immediately (No to all).
Saving all automatically (Yes to all).
Prompting whether to save one by one (Yes or No).

If Yes to All is selected the popup window will appear for each unsaved image (see Section ).

Getting Help
This user manual is the first step in getting help. If something is not described clearly or fully in here, or
something simply does not work as described please report it.

If you have a problem that is reproducible, or one that is intermittent but not reproducible at will, please
report it in as much detail as possible.

If you have a ‘‘glitch’’ -- something that occurs only once and you don’t see again it may not be useful to
report that.

The GIT maintains a time-stamped log file to which much information is written. This is not stored in the
user’s area. The contents of this file can be used with any bug report to help track down problems.

All reports should be sent via email to cicada (don’t forget to add @mso.anu.edu.au if outside RSAA) to 
the RSAA Computer Section. Or, if you prefer, in person.

Limitations
These limitations are known and will be fixed in future releases:

There is no sky subtraction for X-Y slices.
There is no sky subtraction for vector extraction through the sub-image popup window.
Sub-image and statistics via display modes, modify vector mode and profile mode must be exited
before control is returned to the main GIT window.
Colour Table Problems - the current version of GIT uses the IRAF application ximtool modified by 
MSSSO as the image display. If you already have a number of applications running which use a fair
number of colours then ximtool will load its own private colourmap and colour flashing will occur
when moving in and out of that window. This will definitely happen if you are running a colour
intensive application such as Netscape Navigator irrespective of whether you have told it to start up
with a private colour map or not. We have not found it possible to have Netscape running at all while
ximtool is in use and not encounter colour problems.

There will be other things that some users will consider limitations. It should be remembered that the GIT
was designed for limited quick-look purposes and in no way should it be thought of as being a general image
analysis or reduction tool. However, the authors are always open to suggestions on how its functionality, ease
of use, etc could be improved.

Sample $HOME/.gitrc Preferences File
#=========================================================================
# Configuration Table: .gitrc
# This table has been automatically generated and consists of a series of
# named items , eg [name], followed by a set of parameter and value
# pairs, which could be multiple per line. 
# Default valued items might not appear. Take care if editing by hand.
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#=========================================================================

cicada.max_loaded_images:8
cicada.mode:0
image_display.angle:0
image_display.binx:1
image_display.biny:1
image_display.display_frame:1
image_display.display_max:1761.220318
image_display.display_min:1456.779682
image_display.hopt_contrast:0.500000
image_display.hopt_sampling:1000
image_display.hot_pix:0
image_display.hot_pix_value:65535.000000
image_display.mode:HOPT_MEDIAN
image_display.vis_scaling:0
image_display.ximtool_height:564
image_display.ximtool_screen:1
image_display.ximtool_width:512
image_display.ximtool_x:564
image_display.ximtool_y:310
misc.auto_line_plot:0
misc.image_load_dir:/priv/mistress/pjy/data/cicada/pjy/
misc.image_save_dir:/priv/mistress/pjy/cicada/
misc.mef_extension_list:1-8
misc.mosaic_mef:0
misc.private_ximtool:0
plot.plot_height:417
plot.plot_width:614
star.aperture:18
statistics.display_profile:1
statistics.plot:1
statistics.sample_full:0
statistics.sample_size:1000
statistics.scale_function:LINEAR
vector.end:4196
vector.maintain_zoom:0
vector.nsum_sky:1
vector.scale_factor:1.000000
vector.scale_function:LINEAR
vector.smooth_box:3
vector.start:1
vector.subtract_sky:0
vector.use_bscale:0
vector.vector_nsum:1
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Next: Introduction 

CICADA

CCD and Instrument Control Software

CICADA - Computerised Instrument Control and Data Acquisition is a software system for control of
telescope instruments in a distributed computing environment. It is designed using object-oriented techniques
and built with standard computing tools such as RPC, SysV IPC, Posix threads, Tcl and GUI builders. The
system is readily extensible to new instruments and currently supports the Astromed 3200 CCD controller
and MSSSO’s new tip-tilt system. Work is currently underway to provide support for the SDSU CCD
controller and MSSSO’s Double Beam Spectrograph. A core set of processes handle common
communication and control tasks, while specific instruments are ‘‘bolted’’ on using C++ inheritance
techniques. CICADA offers consistent user interface, image display, data archiving and quick-look analysis
for a variety of instruments. 
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Mount Stromlo and Siding Spring Observatories
pjy@mso.anu.edu.au
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�BC cEDGFBH�IKJML CGCGCNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC P
�BCQ� DOR3ISLBT�F6UWVYX�Z[VYU\VY]K^`_aR3T CGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC P
�BC P Z	^`J3bM_`R3XWVcU\Id^aJfe�VYgM]dT CGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC P

A �����=h +�-=.c$ � +jilk * $ ��: A
P3C cEF�R3mMm�^aXnU\T!LlF�oBpqU\T&r'p CNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC P
P3CQ� e�VYg3]KT�Z	^`J6UsT!J6U CGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC t

u ilk * $ ��:wv $  !x�4,1ay z
tMC cEF�{�o}|�ISpnm3]SV~o CNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMCQ��� T!_`T!JML CNCGCGCNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC P�� JMpnUsX\R3r�T&J6U�F�T!]dT���Us^aX CNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC t � ^apsIdUsIK^`J�LBIKpsm3]SV~o�VYJML��&^`JBbM_aR3XWVYg3]KT!p CGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMCQ� F�{�o}L3IKpsm3]SV~o���^aJBbM_`RMX\V`g3]dT�p CGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC � � gB�qT���U�]KIKpnU CGCNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC�� F�T!]dT���UsT�Lf^`gB�qT���U���^�^aX\LBIKJMVYUsTNLBIKpsm3]SV~o CGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC ��� T!J6R CNCGCGCNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �

tMC �3C c ����UsIK^`J�p CNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC �3CQ� � mBU\Id^aJMp CNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
tMC �3C P � T&]Km CNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �

tMC � F��3^aXnUW��RBU��[RBUsUs^aJMp CGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �

z��f $ � +�ilk * $ ��: �
�BC c�Z	^`r�r'VYJ�L � IdJMT � m3UsIK^`JMp COCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �

�BC c C c Z � Z[��|�� � ^BLBT CGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BCQ��� ^c��IKJ3_�Us�3T HM^��!VY] � ]KV`J3T COCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BC P�� ^c��IKJ3_�Us�3T � X\g3IdU\VY]/DORMIKLBT!X CNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BC t ¡ ^`U\VcU\IdJM_�Us�3T HM^��!VY] � ]KV`J3T CGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BCQ� ¢ ^�^`r�IKJ3_ CGCGCNCGCNCGCNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BC � F�T!]dT���UsIKJ3_�V`J � gB�qT���U CNCGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BC�� H�IdJ�LBIdJM_�V�DOR3IKL3T£F6U\V`X CGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
�BC � ���!¤6R3IdX\IKJ3_�V'DOR3IKL3T£F6U\V`X COCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
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c DGFBH�IKJML D�� � LBISpnm3]SV~o CGCGCOCGCNCGCNCGCGCNCGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �

�� � � ������� �"!����

c DGFBH�IKJMLl��^aJBbM_`RMX\VYUsIK^`J�UWVYg3]KTGLBT!p\��X\IKmBUsIK^`J CGCNCGCOCGCGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC t
� F�R3r�r'VYX\o�^$#��&^`r�r'VYJML}]dIKJ3TG^amBUsIK^`JMp%# ^aX�DGFBH�IdJ�L CGCNCGCNCGCNCGCGCNCGCOCGCNCGCGCNCGCNCGC �
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e��3ISp�r'VYJ�RMV`]=LBT�ps�&XsIKg)T!p�U\�3T ^am�T!X\VYUsIK^`Jl^ # V'_aR3ISLBT£pnU\VYX�]d^B�&VYUsIK^`J�U\^6^a] C e��MIKp�Us^�^`]=RMpnT�p�U\�3T�DOR3ISLBT�F6U\V`X
Z[VcUWVY]K^`_aR3T'm3R3g3]KISpn�3T�Ljg�o�����FB� V`pGUs�3Tfpn^aR3X\�&T�^ #�_aR3IKL3T�pqUWVYX�m�^6pnIdUsIK^`JMp�VYJML r'V`_`J3IdUsRML3T!p C e��3T�V`Idr
^ #%Us�3ISpOUs^�^`]�ISp�U\^}mMXs^c��ISLBT�V #,V`pnUNV`JML �&^`J��`T!J3IKT&J6U�r�T�U\�3^BL ^$#%]K^��!VcU\IdJ3_�V�_aR3ISLBT�pnU\V`X # ^aXGV`pnUsX\^`J3^ar�IS�&V`]
^`g�pnT!Xs�cVcU\Id^aJMp��3VYJML�V`p\psIKpnU\V`JM��T # ^`X�_`R3ISLBT£pnU\V`X�V`�&¤6R3ISpsI U\Id^aJ����MId]KT ^`g�pnT!Xs��IKJ3_ C e��3ISp�_aR3ISLBT pqUWVYX�U\^�^`]����[Vap
^`X\IK_`IKJMVY]K]do'LBT!�`T!]d^am�T�L # ^aX�Us�3T��<ISLBT H�IdT!]KL � r'VY_`T!X���� H ����� g)T&IKJ3_'LBT&�aT&]K^`m)T!L£�q^`IKJ6Us]Ko�g�o � F3F3F � �3��� �
VYJ�L U\�3T ��J3Id�aT&XWpnIdUqo ^$# � T!]dg)^`RMXsJ3T��=�M^ �	T!�`T&XNIdU£m3X\^c��IKLBT�pGVfr�T��W�MVYJMIKpsr # ^aX£LBT!p\��X\IKg3IdJM_}U\�3T�]SV~o`^aRBUG^ #
p\��IKT&JM�&T�VYJML�_`R3ISLBT�LBT&UsT���Us^aX\p£IdJ�Us�3T}IdJMpnUsX\R3r�T&J6U�# ^��!VY][m3]SVYJ3T���V`JML ISp U\�3T&X\T�# ^aXsT��&^`JBb�_`R3XWVYg3]KT	# ^`X�RMpsT
��IdUs�jVY]Kr�^apnUGV`J�olIdJMpnUsX\R3r�T&J6U C �<�3Id]KT'IdUN��V`pNg)T&T&JjLBT!�`T!]d^am�T�L U\^fX\R3J IdJj�&^`Jc�qR3J���UsIK^`J!��IdUs��Z � Z[��|��
� Z	^aJBbM_aR3X\V`g3]KT � JMpnUsX\R3r�T&J6U Z	^aJ6UsX\^`]=V`JML |OVcUWV}���&¤6R3ISpnIdUsIK^`J � �@pn^$# U��[V`XsT£L3T&�`T!]d^am�T�L VcU � F3F3F � �)IdUNr�V~o
VY]Sps^�g)TGRMpsT!L}^#"%$6]KIdJMTOIKJlV�pqUWVYJML�VY]K^`JMTOr�^BLBT C

& 	 ���/��� ! !��O�  ���

'�(�) *,+�-/.�0�1

DGFBH�IKJMLfIKp�m�VYXsU�^$#=U\�3T�Z � Z[��|�� mMV`�W{cVY_aT C F�T&TNU\�3T�Z � Z[��|�� r�V`J�RMVY] C

'�(2' *435.�1567+98;:=<4>?:@8;:BA�C�D93E6

DGFBH�IKJML�X\T!¤6R3IKX\T!p�U\�3T DOR3ISLBTNF�U\VYX�Z[VYU\VY]K^`_aR3T�U\^�g)T�IKJMpnU\V`]d]KT!L�^`J}V�]K^��!VY]�LBISpn{ C e��3ISp[�!VcUWVY]K^`_`RMT��MV`p	U��[^
Z[| �`^`]KR3r�T!p��aV`JML'T�V`�W�'�`^a]dRMr�T�pn�3^aR3]SL�g�TO��^`mMIdT�L�Us^�L3IKps{�IKJ�psT&mMV`X\VYUsT�LBIKX\T!��U\^`X\IdT�p C=� #/pnT&U��6Us�MT�T&J���IKXs^aJ;F
r�T&J6U��cVYX\IKV`g3]dT�p�DGFMZ � �O¡ e � VYJ�LfDGFMZ F � ��e � ps�3^`R3]SLf��^`J6UWVYIKJ�Us�MT�# R3]d]/mMVcU\��U\^�U\�3TGJ3^aXnU\�3T&X\J}V`JML
ps^`RBU\�3T&X\J��&VYU\V`]d^a_`R3T�p%X\T!psm�T���U\Id�aT&]Ko C�� #/Us�MT!psT��cVYX\ISVYg3]KT!p[VYX\T�J3^`U�L3T�bMJ3T�LG�3DGFBH�IdJ�L}VapspsR3r�T!p%Us�3TNJ3^aXnU\�3T&X\J
�&VYU\V`]d^a_`R3TH�[Vap�IdJ�pqUWVY]K]dT�L�IKJfUs�3T LBIKX\T!��U\^`X\oJI~_6ps�KI~�`^a]8c��6V`JML�Us�3T ps^`RBU\�3T&X\J��&VcUWVY]K^`_aR3T�IKJLI~_6ps�KI~�`^a] �3C

'�(2M >?CN0EO�DN35<P:@8P.�CN0RQS:=T�A�6

e��3T�IdJMpnUsX\R3r�T&J6UNVYJML�# ^B�!VY]/mM]KV`J3T��&^`JBbM_aR3XWVcUsIK^`JlL3VYU\V�IKpOpqU\^`X\T!L�IKJ V�U\TVU�U # ^aXsr'VYUsT!LfUWVYg3]KT C�� #%pnT&U��)Us�MT
T&J���IKXs^aJ3r�T&J6U��~V`XsISVYgM]dTGDGFBH � ��| e���� �XW ps�3^`RM]KLf��^aJaUWVYIKJ�U\�3T�# R3]K]dof¤6RMVY]KI b�T!L}bM]KT&JMV`r�TN^$#=U\�3T ��^aJBbM_`RPF
XWVcUsIK^`J bM]KTY� ^`Us�3T!XZ��ISpnT'DGFBH�IKJMLL��IK]K]�]d^�^`{ # ^`XOUs�3T�bM]KT[I~^amBU\IY��IS�&V`LMV]Ic�&^`JBb�_^I~_6pqb�JML UWVYg3]KT C�� #%Us�MIKpObM]KT�IKp
J3^`U # ^`R3JML_��V`J TVU3VYr�m3]KT���^aJBbM_`RMX\VYUsIK^`J bM]dT[��Id]K] g)T���XsIdUnU\T&J U\^?I�Usr�m`Ic_apnbMJML UWVYg3]KTY��VYJML�DGF3H=IKJML!��IK]d]
TVUBIdU C e��3T �&^`J6UsT!J6U�^$#/U\�3T ��^aJBbM_`RMX\VYUsIK^`J�b�]dT���IK]d]/g�T LBT�ps�&XsIKg)T!L}IdJlpsT!��U\Id^aJ PMC

a  ����b � ���  � �dcfe �  �
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� pnIKJ3_`]KT}DGFBH�IKJML �&^`JBb�_`R3XWVcU\Id^aJ U\VYgM]dTf�&VYJ pnR3mMm�^aXnU�R3m�U\^?c�n"# ^��!VY][m3]SVYJ3T�p C!W Va�W� # ^��!VY][m3]SVYJ3T}r�V~o
��^aJ6U\VYIKJ R3mwUs^ c � ps�&IdT!JM��T LBT&UsT���Us^aX\p���VYJML<c � _aR3IKL3T LBT�U\T!��Us^`XWp C ��]K]�p\��IKT&JM�&TlLBT�U\T!��U\^`XWpo� Z�Z[|Op � VYX\T
V`p\psR3r�T!L Us^ g)T'U\�3T�p\VYr�T�pnIqp&T��/g)^YU\��IdJ U\T&X\r�p£^ #[Us�3T�J6RMr£g)T&X£^$#[mMIrUBT&]Sp���V`JML Us�3T�m3IrUBT!]%LBIKr�T!JMpsId^aJMp C
e��3T�m3��o�psIS�&VY]=LBIdr�T!JMpnIK^`J�p�^ #%V`]d]=_`R3ISLBT£L3T�UsT���U\^`XWp�VYX\T VY]Sps^�V`p\pnR3r�T�LfUs^�g)TGU\�3T�p\VYr�T£psIsp!T C e��3T�_`R3ISLBT!X
pso�pnUsT!r'p�psR3m3m)^`XsUsT�L g�o DGFBH�IdJ�L VYX\T btU�T�LG�@^`X\g3IdU\V`]2�@VYJ�LlXs^`U\VYU\VYgM]dT C �[^`Us� btU�T�L VYJ�L X\^YU\VYU\V`g3]dT�_`R3ISLBT!X
pso�pnUsT!r r�T!V`JMpNU\�3T�]K^��!VcU\Id^aJ ^$#�Us�3T�_aR3ISLBT�LBT�U\T!��Us^`XWp V`XsT�bPUBT!L X\T&]SVcU\Id�aT�Us^lU\�3T�p\��IKT&JM�&T�LBT�U\T!��U\^`XWp C}� J
Us�MT��&VapnT�^ #[Us�MT�Xs^`U\VYU\VYgM]dT'pso�pnUsT!r�/U\�3T'T&J6UsIKX\T	# ^��!VY] mM]KV`J3T'r'V~o g)T'Xs^`U\VcU\T!L VYg)^`R3UGUs�3T��&T&J6UsT!XG^ #�Us�MT
p\��IKT&JM�&T�LBT&UsT!��Us^aX\p bMT&]SL�^$# �6IKTu� C HM^`X	V`J�^`X\g3IdU\V`]�_aR3IKL3T&X	psoBpqU\T&r��^`J3]Ko�^`J3T�_`R3ISLBT�L3T�UsT���U\^`X[IKp	m�T!Xsr�IdUnU\T!L C
e��3TO��T&J6U\T&X[^ #@Us�MIKp[LBT�U\T!��Us^`X[ISp	�&^`JMpnUsXWVYIKJ3T!L�U\^£r�^c�`T�VY]K^`J3_£V£��IKX\�&]dT��6�&T&J6UsT!XsT�L'^`J'U\�3T�p\��IKT&J���T�L3T�UsT���U\^`XWp
bMT!]KL ^ #%��IKTu� C e��3T�^`X\IdT!JaUWVcU\Id^aJl^ # U\�3T�_aR3ISLBT�LBT&UsT���Us^aXGLB^�T!p�J3^YUNXs^`U\VYUsT�Vap�U\�3T�LBT�U\T!��U\^`XOr�^c�`T!p C e��3IKp
pso�pnUsT!r IKp[LBT!psIK_`J3T�L	# ^`X[_`R3ISLBTOLBT�U\T!��U\^`XWp U\�MVcU�VYX\T��!VYX\XsIKT!L�^aJ�VYJ�v5F2w m3]SVcU # ^aXsr��g3RBU�VY]q��V~o�p m�^6pnIdUsIK^`J3T�L
T!¤6R3ISLBISpqUWVYJ6U�# Xs^ar U\�3T ��T!JaU\T&X�^$#/Us�MT ps�&IdT!JM��TObMT!]KL C

x�yuz{z}|�~ �\�����}�Z�_�_��� ������� �����]� ���#�����\��|K��z2���K�u����������� �
� yuz{z}|�~ �\�����}�Z�_�_��� ������� �����]� ���#���\�K�2���{�������u�Z�X�#�
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e��3T�UWVYg3]KT�T!J6UsX\IdT�p # ^`X	T!V`�W�'IKJMpnUsX\R3r�T&J6U	�&^`JMpsIKpnU%^$#@V£ps¤6RMV`XsT�g3XWV`�W{aT�U\T!L�T&JM�!VYmMpsR3]SVcU\T!L�IKJMpqU\XsRMr�T!J6U%]KV`g�T!]2�
VYJ�L�V£pnT!XsIKT!p�^$#@psT&r�IS��^a]d^aJ�psT&mMV`X\VYUsT�L��cV`XsISVYg3]KT����cV`]dR3T�mMV`IdXWp C �<�3T!XsT�U\�3T��cVYX\ISVYg3]KT�IKp	VYJ'VYX\X\V~o��~Us�3T��~V`]dRMT
bMT!]KL}g�T���^ar�T�p�V���^`r�r'V�pnT!mMVYXWVcU\T!L�]KISpqU�^$#=�cVY]KR3T!p C e��3TGL3VcUWV�IdJ}Us�3T �&^`JBb�_`R3XWVcU\Id^aJ'U\V`g3]dTGLBT�ps�&XsIKg)T!p[Us�MT
m3��oBpnIS�&V`]�]KV~oa^`RBUN^ #[Us�MT'IdJMpnUsX\R3r�T&J6U # ^B�&V`] m3]SVYJ3T�IKJjVYJ!vEF}w ��^�^`XWLBIKJMVcU\T'pnoBpnUsT&r�h��I U\� V`]d] L3Idr�T&J�pnIK^`JMp
r�T!VapnR3X\T!L�IKJ�r�r C e��3T�]K^B�&VYUsIK^`J'^ #@U\�3T�^aXsIK_`IKJ'ISp	V`Xsg3IdUsXWVYX\o C e��3T�^aXsIKT&J6UWVcUsIK^`J�^$#@Us�3TO��^�^`XWLBIKJMVcU\T�V UBT!p%IKp
psRM�W�GUs��VcU�Us�3T����`TNvEF LBIdX\T!��UsIK^`J���^`X\X\T!psm�^aJML3p�U\^ W V`pnU=^`J Us�3T�ps{6o��cVYJML Us�3T����`TNw5F LBIdX\T!��UsIK^`J£�&^`X\XsT�pnm)^`J�L3p
Us^/��^`XsUs��^`J}Us�3T ps{�o C
e��3T JMVcU\R3XsT VYJMLwUqo�m)T ^ #NU\�3T �cVYX\ISVYg3]KT!p'IKJ>V DGF3H=IKJML �&^`JBb�_`R3XWVcU\Id^aJ UWVYg3]KT ISp�L3T!p\��X\Idg)T!L g)T&]K^ � C � #
�cVYX\IKV`g3]KTY�B�cVY]KR3TNmMVYIKXWp�VYX\T�^ar�IdUnU\T!L # X\^`r U\�3T ��^aJBbM_aR3X\VYUsIK^`J�U\VYgM]dT��3LBT�#,V`R3] U��cV`]dR3T�p�VYX\TGV`p\pnR3r�T�L C

� V`XsISVYg3]KT e	o6m)T |�T!p\��X\Idm3UsIK^`J C
J �!�&L3p � J6UsT!_`T&X e��3TNJ�R3r�g�T!X�^ #�ps�&IdT!JM��TGLBT&UsT!��Us^aX\p C
�!�&L �3T!Id_a�6U ¡ T�VY] � T&IK_`�6U�^ #�T!V`�W�fps�&IdT!JM��T�Z�Z[| IdJfr�r C
�!�&L ��ISL�Us� ¡ T�VY] �<ISL�Us��^$#�T�V`�W�}p\��IKT&J���T�Z�Z[| IKJ�r�r C
�!�&L m3IsUBT&] pnIqp&T ¡ T�VY] F�Iqp&TN^$#�T�V`�W��ps�&IdT!JM��T£Z�Z[| m3IsUBT&]@IKJ�r�r C
�!�&L UB^ ¡ T�VY]��,V`XsXWV~o � ^aX\LBIKJMVYUsTO^ #�Us�3TG^aXsIK_`IKJ�^$#=U\�3T ps�&IdT!JM��TGLBT&UsT���Us^aX\p C
�!�&L oa^ ¡ T�VY]��,V`XsXWV~o � V`gMps�&IKp\p\V£^$#/Us�MTG^`X\Id_aIdJf^ #=Us�3T p\��IKT&JM�&TGLBT�U\T!��U\^`XWp C
�!�&L m3IsUBT&] U�^ � J6UsT!_`T&X �5VYX\X\V~o � v5F ^Y"�psT�U ^$#@p\��IKT&J���T�m3IsUBT&]M^aX\L3IdJMVYUsT�IKJ�VNr�^ap\VYIS��XsT�# T&X\T&JM�&T

# XWVYr�T C
�!�&L m3IsUBT&] o`^ � J6UsT!_`T&X �5VYX\X\V~o � w�F ^Y"�psT�U[^ #/p\��IKT&JM�&T�m3IsUBT&]�VYgMp\��ISpsp\VGIKJ}V£r�^6psV`IK��XsT�# T&X\T&JM�&T

# XWVYr�T C
LBT�V`L �!�&L � J6UsT!_`T&X �5VYX\X\V~o � F�T&U Us^SnGI #/ps�&IdT!JM��T�L3T�UsT���U\^`X ISp # RMJM��U\Id^aJ3IdJM_t��c�^YU\�3T&X���IKpsT C
T�V`pnU VcU ]dT�# U � J6UsT!_`T&X |�IKpsm3]SV~o W VapqU�VYU�X\IK_`�6U�I #�pnT&U�Us^/nP�M^`X W VapqU�VcU � T�# U�I #�psT�U

U\^�c C
ISp T�¤aR�VcUs^aXsISVY] � J6UsT!_`T&X F�T&U�Us^ cNI #=U\T&]KT!p\��^`m)TGISp�T!¤6RMVYUs^`X\ISVY]K]do'r�^`RMJaU\T!LG�%n�^`Us�3T!X�F

��ISpnT C
# ^B�&V`] m3]SVYJMT mMV ¡ T�VY] � JML3IK�!VcUsT�pOUs�3T�L3IdX\T!��UsIK^`J ^`J Us�3T�ps{�o ^ #	Us�3T����aTSw V UBIKp

^$#�Us�3T�vEF}w X\T�# T!XsT!JM��T # X\V`r�T�^ #�U\�3T # ^��!VY]�m3]SVYJ3T C e��MIKp
V`]d]K^ ��p # ^`X�X\^YU\VYUsIK^`Jf^ #�Us�3TGIKJMpnUsX\R3r�T&J6U�^`J}Us�MTGUsT!]dT�ps�&^`m)T
��IdUs�3^aRBU�Us�3T�JMT&T!L£Us^NX\T!�&^`JBbM_aR3X\T%U\�3T%# ^��!VY]Bm3]SVYJMT�]KV~oa^`RBU C
� T�V`psR3X\T!L IdJ>L3T&_`X\T&T�p # Xs^ar ��^`XsUs�_��IKJM��X\T!VapnIKJ3_ U\�3^`R3_a�
W V`pnU C

^aXsIKT&J6U\VYUsIK^`J ^ # JM^`XsUs� ¡ T�VY] � JML3IK�!VcUsT�p=Us�3T�LBIKXsT���UsIK^`J£Us^NLBISpnm3]SV~o ��^aXnU\�£IKJ£U\�3T�DGFBH�IdJML
ps{�o£�W�MVYXsU=��IdJML3^ � C�� T�V`psR3X\T!L�VYJ6UsIsF �&]d^B�W{^��ISpnT[IdJ'LBT!_`X\T&T�p
# X\^`r Us�MT X\Id_a�aUf�3^`X\Iqp&^`J6UWVY] C e��3ISp�VY]K]d^ ��p�Us�3T DNH�FBIdJML
ps{�oY$B�W�MVYXsU%U\^�g)TG^`X\IKT&J6UsT�L'Us�MT psV`r�TH��V~o'^`J}Us�3TGLBISpnmM]KV~o
Vap%U\�3TGIKr�V`_`TNX\T!V`L # X\^`r U\�3T LBT�U\T!��Us^`X C

J _aR3ISLBT �&�!L3p � J6UsT!_`T&X ��R3r£g)T&X�^$#�_aR3IKL3TNL3T�UsT���U\^`XWp C
_aR3IKL3T �&�!L �3T&IK_`�6U ¡ T�VY] � T&IK_`�6U�^ #�T!V`�W�}_`R3ISLBT LBT&UsT���Us^aX�IdJ�r�r C
_aR3IKL3T �&�!L ��IKLBUs� ¡ T�VY] �<ISL�Us��^$#�T�V`�W��_aR3ISLBT LBT�U\T!��Us^`X�IKJ�r�r C
_aR3IKL3T �&�!L UB^ ¡ T�VY]��,V`XsXWV~o � ^aX\LBIKJMVYUsTO^ #�Us�3TG^aXsIK_`IKJ�^$#=U\�3TG_`R3ISLBTGLBT&UsT!��Us^aX\p C
_aR3IKL3T �&�!L o`^ ¡ T�VY]��,V`XsXWV~o � V`gMps�&IKp\p\V£^$#/Us�MTG^`X\Id_aIdJf^ #=Us�3TG_aR3IKL3TNL3T�UsT���U\^`XWp C
LBT�V`L _aR3IKL3T �&�!L � J6UsT!_`T&X �5VYX\X\V~o � F�T&U�Us^�n�I #�_`RMIKLBT L3T�UsT���U\^`X�ISp%# R3JM��U\Id^aJ3IKJ3_t�6cN^`Us�3T!XZ��ISpnT C
_aR3IKL3T&X Uqo�m)T � J6UsT!_`T&X n���bPUBT!L
	Kc���^`X\g3IdUsT&X�	 � ��Xs^`U\VcUWVYg3]KT C
UBo Xs^`U\VcU\Id^aJ � J6UsT!_`T&X n��Hn	�c�� � n	 � � c � n
	 P � �6� n}LBT&_aXsT!T�X\^YUWVcUsIK^`J ^ #	Us�3T

X\T�# T!XsT!JM��T # X\V`r�T�^$#/Us�MT�vEF}w pnU\V`_`TO^ #�VYJf^`X\g3I U\T&X�_`RMIKLBT!X��
��IdUs��X\T!psm�T���U�Us^�Us�MT�# ^��!VY] mM]KV`J3TNXsT�# T&X\T&JM�&T # XWVYr�T C

J ��IK_ � J6UsT!_`T&X ��R3r£g)T&X�^$#���IK_`J3T&UnUsT�LfXsT!_`IK^`JMp[IKJ�U\�3TNbMT&]SLf^ #���IdT�� C
��IK_`J3T&UnUsT ��IKLBUs� ¡ T�VY]��,V`XsXWV~o � �<ISL�Us��^$#���IK_`J3T&UnUsT�L�X\T&_aId^aJ}IKJfr�r C
��IK_`J3T&UnUsT �3T&IK_`�6U ¡ T�VY]��,V`XsXWV~o � � T&IK_`�6U�^ #��6IK_`JMT�UnU\T!L}XsT!_`IK^`JfIdJfr�r C
��IK_`J3T&UnUsT UB^ ¡ T�VY]��,V`XsXWV~o � ^aX\LBIKJMVYUsTO^#"@pnT&U�^ #=��IK_`J3T&UnU\T!LfXsT!_`IK^`J C
��IK_`J3T&UnUsT o`^ ¡ T�VY]��,V`XsXWV~o � V`gMps�&IKp\p\V£^Y"�psT�U�^ #���Id_aJ3T�UsUsT�L�X\T&_aId^aJ C

e=V`g3]KT c�	 DGFBH�IdJ�Ll��^`J3bM_`R3XWVcU\Id^aJ�UWVYg3]KTGLBT!p\��X\Idm3UsIK^`J

��p�VYJ�TVU3V`r�mM]dT��BUs�3T U\VYgM]dT�# ^aX�Us�3T � H � IKJMpnUsX\R3r�T&J6U�ISp�pn�M^ ��Jfg)T&]K^ � C e��MIKp�IdJMpnUsX\R3r�T&J6U��MVap � p\��IKT&JM�&T
VYJ�L � _aR3IKL3T Z�Z[|NF}IdJlV�bPUBT!Lf_aR3IKL3T&X�pso�pnUsT!r�3VYJMLfJ3^���Id_aJ3T�UsUsT�L}X\T&_aId^aJMp C
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e��3T£D�� � U\^'DGF3H=IKJML�ISp�pn�M^ ��J}IKJfbM_`R3X\T�c C

WE(�) +OX jZY4.�k]g�A�:Gj

e��3TNps¤6RMV`XsT�XsT!_`IK^`J�VYU	U\�3TNr�IKL3L3]dTN]KT�# U�^ #/U\�3TGDGFBH�IdJML�D�� � IKp	U\�3TGpn{�o'LBISpnm3]SV~o C e��3ISp�pn�M^ ��p U\�3TGpqU\T&]K]KV`X
^`g3�qT!��UWp�V`p�pn^a]dISL ���3IdUsTl�&IdXW��]KT!p��%VYJ�L � ^amBUsIK^`J�VY]K]do � J3^`J;F pnUsT&]K]SVYX£^agB�qT!��U\p�V`p�^am�T!J ��IKXW��]KT!p C � X\T!L ��X\^ap\p
r'VYX\{Bp�Us�3T���T&J6U\T&X�^$#=U\�3TGbMT!]KL C�� �aT&X\]KV`IKL}^`JfUs�MT£pn{�o}m3]d^`U�ISp�Us�3T�IdJ�pqU\XsR3r�T!JaU # ^B�!VY]/mM]KV`J3T C e��3ISp�pn�M^ ��p
Us�MTG^`RBU\]dIKJ3TG^ #�Us�MT ps�&IdT!JM��T LBT&UsT���Us^aX\p�V`JMLf_`R3ISLBTGLBT&UsT!��Us^aX\p�IKJ�_`X\T&T!J C � IK_`J3T&UnUsT�L�XsT!_`IK^`JMp�V`XsTGLBISpnmM]KV~oaT!L
V`p�X\T!L}X\T!��UWVYJ3_a]dT�pu�^��IdUs��]KIdJ3T�p�V`�&Xs^6psp	U\�3T LBISVY_`^aJMVY]Sp C

WE(2' [ 6XD�6X051

e��3TGps{6o�m3]K^YU�]KT&_aT&JML�IKp�ps�3^ ��J}VYU	U\�3TNg�^`UnUs^ar ]KT�# U�^ #=Us�3TGD�� ��C e��3ISp�IKJMLBIS�&VcU\T!p	Us�MTNL3IdX\T!��UsIK^`J�^$#h��^aXnU\�
VYJ�L W V`pnU IdJ U\�3T�ps{�o LBISpnmM]KV~o��=VYJ�L U\�3T�{aT&o U\^ LBT&UsT&X\r�IdJMT�Us�3T�r'V`_`J3IdUsRML3T'^ #�Us�3T�^`gB�qT���U\p IdJ U\�3T�ps{6o
LBISpnmM]KV~o C

WE(2M \�0�k�8^<%35l 6X098 + 6hA�6-]`8;C�<

e��3T�L3T!psIdX\T!L IKJMpqU\XsRMr�T!J6U£r'V~o g)T�pnT!]dT���U\T!L # X\^`r Us�3T�L3Xs^am^$�LB^ ��J r�T&J�Rj^ #�U\�3T � JMpnUsX\R3r�T&J6U�F�T!]dT���U\^`X C
e��3ISp�]K^aV`L�Us�3T �&^`JBb�_`R3XWVcU\Id^aJ}L3VYU\V # X\^`r U\�3TNU\V`g3]dT��3VYJML�LBISpsm3]KV~oBp	Us�MT ��R3X\XsT!J6Us]Ko�pnT!]dT���U\T!L}IdJMpnUsX\R3r�T&J6U C

WE(^W _CNk^. 8P.�C90 1�.�k]g�A�:Gj :B051`] CN0EO�DN35<P:=T�A�6Xk

e��3Tf��R3X\XsT!J6U ¡ � V`JML�|�T!�}��^�^`XWLBIKJMVcU\T!p ^$#�Us�3T���T!JaU\T&X�^ #�Us�MT}ps{6o LBISpnmM]KV~o VYX\T�ps�3^ ��JjIdJ�Us�3T�H�IdT!]KL 	
¡ � �)|�T!�£UsTuU6UOg�^KUBT�p C e��MT!psT �cVY]KR3T!p�r'V~o}g)T£r�^BLBIdbMT!Llg�ofUs�MT£RMpsT&X��)V`JMLlIKJ3IdUsISVcUsIKJ3_fV ¡ T!VaL DGFMZ ��IK]d]
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X\T!LBISpnmM]KV~o�VYU�Us�3T �&^�^`XWLBIdJ�VcUsT�p�T&J6UsT!XsT�L C e��3T �&R3X\XsT!JaU��&^�^`XWLBIdJ�VcUsT�p[^ #�Us�3T£�&T&J6UsT!X�^ #�Us�MT�# ^��!VY] mM]KV`J3T VYX\T
LBISpnmM]KV~oaT!L IdJ�Us�3T'U\TVU�U�g)^KUBT!pG]SVYg)T&]K]KT!L�|�T�U\T!��U\^`X�	 ¡ � VYJMLj|�T!� C e��3T!psT��cVY]KR3T�p£�&V`J3J3^`U£g�T}r�^�L3I bMT�L
g�o�Us�3T�RMpsT&X C e��3T'��^�^`XWLBIKJMVcU\T�psoBpqU\T&r RMpsT!L # ^`XOg�^`Us� Us�3T # ^B�&V`]�mM]KV`J3T�V`JMLlb�T&]SL ��T!J6UsT&XG�!VYJ g)T'pnT&U�U\^
� c �6� nP��� � nYn�nP�`^aX%^aX[V��`R3]KISVYJ�T!m�^B�W��^$# Us�3TORMpsT&XWp%�W�3^aIK�&T C e��3TOLBT�#,V`R3] U�pso�pnUsT!r IKp�� � nYn�n C e��3T�m)^apsI U\Id^aJ
VYJM_`]KTG^ #�Us�3T # ^B�!VY] m3]SVYJMTGIKp�L3IKpsm3]SV~o`T!L}IKJ�Us�3TGU\TVU�Usg)^KU}]SVYg)T&]K]KT!L�� � � �5LBT&_aXsT!T!p ���3C H3^`X�Xs^`U\VcUWVYg3]KTN_`R3ISLBT!X
pso�pnUsT!r'pu�cU\�3ISp��cVY]KR3T�r�V~oGg)T�VY]Sps^�r�^BLBIdbMT!L�Us^GpsT�U�U\�3T�m�^6pnIdUsIK^`J�VYJ3_a]dT�Vap�Us�3T�RMpsT&X LBT�pnIKX\T!p C e��3T�VaL~�nV`�&T&J6U
UsTuU�Usg)^KU�T�p�]SVYg)T&]K]KT!L?v ^Y"�psT�UGVYJMLow�^Y"�psT�UGLBISpnmM]KV~ofUs�MTSv VYJ�L w ��^�^`XWLBIKJMVcU\T!p�^ #%^$#	VYJ ^`X\g3I UWVY]�_`R3ISLBT!X
pso�pnUsT!r C e��MT!psT��cVY]KR3T!p[�&V`J3J3^YU	g�T�r�^BLBIdbMT�L'g�o�U\�3T�R�pnT!X��6VYJML�V`XsT�^`J3]Ko�L3IKpsm3]SV~o`T!L # ^aX%IKJMpnUsX\R3r�T&J6U\p9��I U\�
^`X\g3IdU\V`]@_`R3ISLBT&X�psoBpqU\T&r'p C

WE(	� +OX j 15.�k]gHA�:Gj ] C90�O�D93E<P:=T�A�6Xk

e��3TOr'VY_`JMI U\RMLBT�XWVYJM_`T�^$#@Us�3TO^`g3�qT!��UWp�LBIKpsm3]SV~o`T�L�^`J�U\�3TNpn{�o�m3]K^YU��&VYJ�g�TN��^aJBbM_`RMXsT�L�g6o'r�^BLBI # o�IdJ3_�Us�MT
r'VY_aJ3I U\RMLBT�]KIdr�IdUGbMT&]SL3p C e��3T�]dT�# UGUsTVU�U\g�^KU ps�3^ ��pOU\�3T�g3XsIK_`�6UG]KIdr�IdU��=V`JML Us�3T�X\Id_a�6UOU\TVU�Usg)^KU U\�3T	#,VYIKJ6U
]KIdr�IdU C e��3T�RMpsT&XGr'V~o VY]Spn^fm3]K^YU V���IKX\�&]dT'V`Xs^aR3JMLlU\�3T'��T!JaU\T&XG^$#%Us�MT�# ^B�!VY]�m3]SVYJ3T C e��MIKpGISpGLBT�pnIK_`J3T�LlU\^
V`p\psIKpnU Us�MT�RMpsT&X ���3T&X\T�U\�3T�IKJMpnUsX\R3r�T&J6U%bMT!]KL�^ # ��IKTu� IKp[��IKXW��R3]SVYX C e��MT�XWV`LBIKRMp ^$#@Us�3ISp[��IKX\�&]dT�r'V~o�T&J6U\T&X\T!L
IKJ�U\�3T�UsTuU�Usg)^KU�]SVYg)T&]K]dT�L
� ¡ V`L3IdRMp��5VYXW��r�IKJ ��� ^`J���T[Us�3T��\|�XWVK� �&IdXW��]KT�VYX\^`R3J�L�LBT&UsT���Us^aX ��T!JaU\T&X � �W�3T!�W{�g)^KU
ISp��W�3T!�W{aT!L C

WE(	�  T��]6-]`8 A�.ZkY8

e��3T[^`gB�qT���U�]dISpnU��&^`J6U\V`IdJ�p U\�3T	m)^apsIdUsIK^`JMp��Yr'VY_aJ3I U\RMLBT�VYJML£^`gB�qT���U�Uqo�m�T���VY_ # ^`X�VY]K]�^ #3U\�3T�^`gB�qT���UWp/J3T�VYX�Us�MT
bMT!]KL���T!J6UsT&X��P��IdUs��r'VY_aJ3I U\RMLBT�p�g�T&U��	T!T&JfUs�MT ��^`J3bM_`R3X\T!L}]KIdr�IdU\p C e��3TG^`g3�qT!��U�]KISpqU�V`]Kps^'��^`J6UWVYIKJMp�^`gB�qT���UWp
Us��VcU�VYX\TOJ3^YU�LBISpsm3]KV~oaT!L C e��3ISp�VY]K]K^ ��p%# ^`X�bMT!]KLfX\^YU\VYUsIK^`JJ��I U\�3^`RBU�U\�3TGJ3T!T!L}Us^�X\T!V`L�Us�MT£DGFMZ V`_aV`IdJ C

WE(�� + 6hA�6-]`8;6X1 C�T��]6-]`8�] C�C�<t1�.�05:h8;6�15.Zk�gHA�:Gj

��J'^agB�qT!��U%r'V~o£g)T�psT&]KT!��UsT!L�g�o£Us�3T�RMpnT!X5� psT&T�psT!��UsIK^`J �BC � ��C�� #�Us�MIKp%^`gB�qT���U #,V`]d]Sp ^aJ�V£ps�&IdT!JM��T�L3T�UsT���U\^`X��
Us�MTOmMIrUBT&]=��^�^`XWLBIKJMVcU\T!p	^ #/U\�3ISp�^`gB�qT���U�VYX\TGpn�3^ ��J}g�T!]d^ �>Us�3TN^agB�qT!��U�]KISpqU C e��3IKp�ISp�LBT�pnIK_`J3T�L'U\^�VapspsISpqU�Us�MT
RMpsT&X�IdJ Va�&¤6R3IKXsIKJ3_�V'_aR3IKL3T£pqUWVYX���Vap�Us�MT&ofr�V~o���^ar�mMVYX\TNUs�3T���^�^`XWLBIKJMVcU\T!p�^$#�Us�3ISp�^agB�qT!��U�Us^'U\�3^apsT # X\^`r
V�XsT�VY]�TVUBm)^apsR3X\T C e��3TGLBISpnm3]SV~o�VY]Sps^�IKJMLBIS�&VYUsT!p�I #�Us�3TG^agB�qT�U�ISp�J3^YU�^`J}Us�MTNps{�o�m3]K^co�LBISpnmM]KV~o�V`XsT�VP��^`X�J3^`U
^`J�V�ps�&IdT!JM��T L3T�UsT���U\^`X C

WE(	� � 6X0�3

e��3T mMXsIKr'VYX\o���^aJaU\Xs^a]Kp��&X\R3J^$6UsIKr�T ��^`J3bM_`R3XWVYgM]dT�p@VYJMLNRMpsT&X/�3IdJ6UWp # ^`X�DGFBH�IdJMLG�!VYJNg)T IdJ�pqU\Id_6VcUsT�LG�~r�^�L3I bMT�L
^`X�LBIKpsm3]SV~o`T�L}R�pnIKJ3_�Us�MT£LBX\^`m^$BLB^ ��J}r�T!J6R�p�VcU�Us�3TGU\^`ml^$#=U\�3T�D�� ��C e��3T # RMJM��U\Id^aJMVY]KI Uqo}^ #�Us�MT!psT r�T&J�R
IdUsT&r'p���IK]K] g�T L3IKp\��RMp\psT!L}IdJfUsRMXsJ C

u�� � �,7 � ; � $ �)�= 

� ¢ ^�^`r � J 	 ¡ T!LBR���T'U\�3T�psIsp!T'^ #[Us�3T�ps{�o LBISpsm3]KV~o bMT&]SL ^ #���IdT�� g6o V #,V`��Us^`X£^ # � ��XsT&U\VYIKJ3IKJ3_�Us�MT
��R3X\XsT!J6U	bMT!]KL��&T&J6UsT!X C

� ¢ ^�^`r � R3U 	 � JM�&XsT�V`psTOUs�3T£psIqp&T ^$#�U\�3T£ps{�o}LBISpnmM]KV~o�bMT&]SL�^ #���IdT�� g�o�V #,V`��Us^`X�^ # � ��XsT&U\VYIKJ3IKJ3_�Us�MT
��R3X\XsT!J6U	bMT!]KL��&T&J6UsT!X C

� � X\IdJ6U 	 � ^am3R3m�V g)^KU Us^ psm)T!��I # o Us�MT�m3X\IdJ6U\T&X�� VYJMLjmMXsIKJ6U�Vl�MV`X\LM��^`m�o ^ #�U\�3T}ps{�o L3IKpsm3]SV~o V`JML
]dT!_`T&J�L C

� ¡ T!VaLfDGFMZ 	 ¡ T�V`L}Us�MT£DOR3IKL3T£F6U\V`X�Z[VcU\V`]d^a_`R3TOU\^�RMm)L3VYUsTGU\�3TG^`g3�qT!��U�]KIKpnU�VYJ�LfL3IKpsm3]SV~oY�;��IdUs��Us�MT
bMT&]SL}�&T&J6UsT!X�pnm)T!�&I b�T!Lfg�o�Us�MT H=IKT&]SL ¡ � VYJ�L}|�T!�N�cVY]KR3T�p C

� � ^aVaL # X\^`r e�Z�F 	)DOXWVYgfUs�MT£��R3X\X\T&J6U���^�^`XWLBIKJMVcU\T!p�m3R3gM]dISpn�MT!L�g�o�U\�3T£e=T&]KT!p\��^am�T�Z	^aJaU\Xs^a]/F�oBpqU\T&r
D�� � �MV`JML ¡ T!V`L�DGFMZ4��I U\�fUs�3ISp�m)^apsI U\Id^aJ�Vap[Us�3TNb�T&]SLf�&T&J6UsT!X C

� ¡ T!�&T&J6UsT!X VcU � ^B�&VYUsIK^`J 	�F�T&UGUs�3T�bMT!]KL �&T&J6UsT!XGUs^fUs�MT���R3X\X\T&J6UG]d^B�&VYUsIK^`J ^ #	Us�3T # ^B�!VY]�m3]SVYJ3T��=V`JML
¡ T!VaLfDGFMZ C

��� R3I U 	 W U�IdU�DGFBH�IKJML C
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� F^�[V`m W VapqUVIK� T!pnU 	�H�]dIKm U\�3T LBIKpsm3]SV~o<VYg)^`RBU}Us�3T!��FqF V#U�ISp C e��3ISpf^c�`T&X\X\IKLBT�p�Us�MT T!VapqU VcU ]KT�# U
��^`J3bM_`R3XWVcU\Id^aJ�UWVYg3]KTN�~V`XsISVYgM]dT C

� F^�[V`m F�ISLBT�^ # � IdT!X 	 ¡ ^YUWVcU\T�Us�MT # ^B�&V`]%m3]SVYJ3T�g6o c � nlLBT!_`X\T&T!p ��I U\��XsT�pnm)T!��U Us^ Us�3Tfpn{�o C e��3IKp
^`mBU\Id^aJ}ISp�^`J3]Ko}V~�cV`Id]SVYg3]KTOI #�Us�3TGISp T!¤6RMVcU\^`X\IKV`]��~V`XsISVYgM]dTOIKp�pnT&U[U\^ c C

� F��3^ � ��^`J^$BpqU\T&]K]KV`X � gB�qT!��U\p�	 e=^`_`_a]dT�p	Us�3T LBISpsm3]KV~o�^ #=JM^`J^$BpqU\T&]K]KV`X[^agB�qT!��U\p�IKJfUs�3T ps{�o�LBISpnm3]SV~o C

� F��3^ � � IdJMT!p�^ # ¡ � V`JMLf|�T�� 	%e/^a_`_a]dT�p%U\�3T LBISpnmM]KV~o�^$#�V`J ¡ � VYJML�|�T!�N_aXsISL�^c�aT&X\]KV~o�^aJ�U\�3T£ps{6o
LBIKpsm3]SV~o C

u�� � � A �l��4,x

� ��g)^`RBU�DGFBH�IKJML 	 � ^`m3RMmfLBISpsm3]KV~o�^ #��&^`m�o�XsIK_`�6U�IdJ # ^`X\r�VYUsIK^`J�VYJML�Va�W{6JM^ ��]dT�LB_`T!r�T!J6U\p C

� �<�MVcU�� p���Tu� 	 � ^`m3R3m�LBISpnmM]KV~o�^$#/U\�3TGJ3Tu��# T!VYUsR3X\T!p�IKJfUs�3ISp�X\T&]KT!VapnTO^ #�DGFBH�IdJML C

� � T&]Km 	 � ^`m3RMm}LBISpnmM]KV~o�^$#��MIdJ6U\p%# ^aX�RMpsT&XWp C
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e��3T!XsT�VYX\T � g3RBUsUs^`J�p�g�T!]d^ � U\�3T�r�T&J�R3gMV`X�U\�MVcU'm3X\^c��IKL3T}V pnIKJ3_`]KT���]KIK�W{jIKr�m3]dT!r�T&J6U\VYUsIK^`J ^$#OV r�T&J�R
IdUsT&r Va��UsIK^`Jj^aX£^amBUsIK^`J C H3X\^`r ]dT�# U£U\^ X\Id_a�aU£Us�3T�pnT}g3RBUnU\^`JMp�IKr�mM]dT!r�T!J6U ¢ ^�^`r � J_� ¢ ^�^ar � RBU��%F^��VYm
W VapqUVIK� T!pnU�� � XsIKJ6U�� ¡ T�V`L�DGFMZ�� � ^6V`L # Xs^ar e�Z�FfVYJML ¡ T���T&J6U\T&X�VcU � ^��!VcU\Id^aJ C
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e��3T �&^`r�r'VYJML}]dIKJ3TG^amBUsIK^`JMp�mMXsT�pnT!JaU\]do}pnR3mMm�^aXnU\T!L}IdJ DGFBH�IKJML�VYX\TNps�3^ ��JfIdJle�VYg3]KT �BC

� mBUsIK^`J � V`]dR3T |�T!p\��X\IKmBUsIK^`J
¡ � | W Z W m�^B�W� �3� 	 r�r 	 p\p�p\L3L 	 r�r 	 p\p w5w5w�w � JMI U\IKV`] m�^6pnIdUsIK^`J�VYJ�L}T!m�^B�W�!� �aR3]KIKV`J ¡ T�# T&X\JM�&T �
$���IS�&VaL3V  ¡ R3J�IdJl��IS�&VaL3V�r�^�L3T
v c cN^amBUsIK^`JMp  F�U\VYJ�L3VYXWL[v c cN^`m3UsIK^`JMp9$�psT&TGr'VYJ�v c-c

e�VYg3]KT � 	 F�R3r�r'VYX\o�^$#��&^`r�r'VYJML}]dIKJ3TG^amBUsIK^`JMp%# ^aX�DGFBH�IdJ�L

z �,7 �,7 � 8 � � v ��� � :��

DGFBH�IKJML[��IK]K]@XsR3J}IdJf��IS�&VaL3V£r�^BLBTH���3T&J�Us�3T�$B��IS�&V`LMV ��V`_£ISp�_`IK�`T&J�^`J�U\�3TG��^ar�r'V`JML�]KIdJMT C e��3ISp�IKp[�3^ �
DGFBH�IKJML ISp�pnU\V`XnU\T!L ���MT&J IdUNIKp�]KV`R3JM�W�3T�L�# X\^`r Z � Z[��|�� C e��3T£r'VYIKJ X\T!Vapn^aJ�# ^`XOLB^`IKJ3_�U\�3ISp�ISpOpn^�Us�MVYU
RMpsT&XWp��3�&IK�!V`L3V�m3X\T�# T!XsT!JM��T�p��&VYJfg)TGRMpnT�LfIdJ DGFBH�IKJML C

��(2' � C��E.�0ED78��E6 -�CV] :BA _?A�:B056

� J�^`XWLBT&X�U\^�VY]KId_aJfV�_aR3ISLBT pqUWVYX���IdUs� V�_aR3IKL3T LBT�U\T!��U\^`X���Us�3T # ^��!VY] mM]KV`J3TGr'V~o�J3T&T�L}Us^'g)T r�^c�`T!L C e��3IKp
r'V~o�g�T'LB^aJ3T£T!I U\�3T&XNg�olRMpsIdJ3_�Us�3T�r�^`R�pnT�^`X�Us�3T�{`T!o6g)^aV`X\L C e=^�R�pnT�Us�3T�r�^`RMpsTY�@m)^apsIdUsIK^`JlU\�3T'��R3XWpn^aX
^c�`T!X�Us�MT�p\��IKT&JM�&T�LBT&UsT���Us^aX�V`JML LBT!m3XsT�psp�Us�MT£]KT�# UNr�^aRMpsT£g3RBUsUs^aJ C ��^ � r�^c�`TGU\�3T£r�^`R�pnT£Us^�X\T&m)^apsIdUsIK^`J
Us�MT # ^B�&V`]�mM]KV`J3T C�¡ T!]dT�V`psT�Us�MT�r�^`R�pnT�g3RBUnU\^`JJ���3T&J}o`^`R�� X\T�LB^aJ3T C ��]dUsT!XsJ�VcUsIK�`T!]do��aR�pnT�Us�3TNVYX\Xs^ � {aT&oBp�U\^
r�^c�`T # ^B�!VY]�m3]KV`J3T R3m IcLB^ ��J V`JML�]KT�# U\IcXsIK_`�6U C H3^aX�bMJMT&XNpqU\T&mMp����3^`]SLlLB^ ��JlU\�3T �\pn�3I # U � {`T!oJ���3IK]KT£RMpsIdJM_
Us�MT VYX\X\V~o�{`T!oBp C
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H3^aX�^aXsg3IdU\V`]/_aR3IKL3T&X�psoBpqU\T&r'p��MU\�3T£_aR3IKL3T&XN�&VYJlg)T£r�^c�aT!LlVYX\^`RMJMLfUs�3T�# ^B�&VY]�m3]SVYJ3T C e��3ISp�^am�T!X\VYUsIK^`Jl�&V`J
^`JM]do�g)TOLB^aJ3TORMpnIKJ3_£Us�3TOr�^`RMpsT C e=^�X\T&m)^apsI U\Id^aJ'Us�MT�_aR3IKL3T&X ��I U\��Us�MT�r�^`R�pnT��6r�^c�aT�Us�3TG�&R3X\ps^`X	^c�`T!X Us�MT
_`RMIKLBTGLBT&UsT���Us^aX�VYJML�LBT!m3X\T!p\p[Us�3TNX\Id_a�aU�r�^`R�pnTNg3RBUsUs^aJ C ��p[U\�3TGr�^`RMpsTGISp�r�^c�aT!LG��U\�3TG_`RMIKLBT!X���Id]K]@UsXWV`�W{
Us�MT�m)^apsI U\Id^aJ�VYJM_`]KT�^ #@U\�3TN��R3XWpn^aX C�¡ T!]dT�V`psT�Us�MT�r�^`RMpsT�gMRBUnU\^`J����3T&J�oa^`R � X\T�LB^`JMT C e��3T ��v>^Y"�psT�U � V`JML
��w ^Y"�psT�U � ��^�^`XWLBIKJMVcU\T!p�VYX\T�RMm)L3VYUsT�LfVap[Us�3TG_aR3ISLBT&X�ISp�X\T&m)^apsI U\Id^aJ3T!L C

��(^W � CB8;:@8;.Z0ED 8 �56 -�CV] :=A _�A�:B0E6

H3^aX�X\^YUWVcU\V`g3]KTG_`R3ISLBT&XOpnoBpnUsT!r�p���Us�3T m)^apsIdUsIK^`J V`J3_`]KTG^ #�U\�3T # ^B�&V`]/m3]SVYJMT r'V~o}g)T��W�MV`J3_`T�L}Us^�X\T&m)^apsIdUsIK^`J
Us�MT�_`R3ISLBT&X C e��3IKp��!VYJ�g)T�LB^`J3T�g�o£T!J6UsT&X\IKJ3_GV�JMTu�w�~V`]dRMT # ^aX�Us�3T�m�^6pnIdUsIK^`J�VYJ3_a]dT�IKJ6Us^OUs�3T � � � � UsTuU�Usg)^KU �
RMpsIdJM_�Us�3TGr�^`R�pnT��B^`X�g�o�{aT&oBpqU\Xs^a{`T�p C e/^'R�pnTOUs�MT r�^`RMpsTY�Bm)^apsI U\Id^aJfUs�3T �&R3X\ps^`X�^c�aT&X[Us�MTG_`R3ISLBT LBT&UsT!��Us^aX
VYJ�LjLBT&m3X\T!p\pGU\�3T�X\IK_`�6U£r�^`RMpsT�g3R3UnUs^aJ C ��p U\�3T�r�^aRMpnT�r�^c�aT!p��/U\�3T # ^B�!VY][m3]KV`J3T���IK]d][X\^YU\VYUsT'U\^lUsXWV`�W{
Us�MTfm)^apsIdUsIK^`J V`J3_`]KT�^$#�Us�MT��&R3XWpn^aX Cj¡ T!]dT�V`psT�Us�MTfr�^aRMpnTfg3RBUsUs^aJ ���3T!J oa^`R3X�LB^`JMT C e��3T # ^B�&VY]�m3]SVYJMT
VYJ�L pn{�o���Id]K]=Us�3T!J g�T�Xs^`U\VYUsT!LfU\^`_aT�Us�MT&X�U\^�r'VYIKJ6U\V`IdJ�U\�3T£^aXsIK_`IKJMVY]/^`X\IdT!JaUWVcU\Id^aJl^ #�Us�MT # ^B�&V`]/m3]SVYJ3T C e=^
RMpsT£U\�3T�{`T&o�g)^aV`X\LG��m3X\T!p\p�U\�3T
��� � V`JML ��� � {`T&oBp�Us^fXs^`U\VYUsTGU\�3T�# ^B�!VY]�m3]SVYJ3T�IdJ c�LBT!_`X\T&T�pnUsT!mMp CN� ^`]SL
LB^ ��J'U\�3T �sps�3I # U � {aT&o�Us^�r�^c�`T�IKJJn C c�LBT&_aXsT!T�pnUsT&m�p C ��_6VYIKJ_�6Us�3TO^`X\IKT&J6U\VYUsIK^`J'^ #/Us�3T # ^B�&VY])m3]SVYJ3TH��IK]d]�g)T
r'VYIKJ6U\VYIKJ3T�LG�Bpn^�Us�3TNps{6o'mM]d^`U ��IK]d]@g)TOXs^`U\VcU\T!L�IdJ�Us�3TGLBISpnmM]KV~o C e��3T � � � � L3IKpsm3]SV~o�b�T&]SL[��IK]d]�g)TNR3m)LMVcUsT�L
V`p[U\�3T�# ^B�&V`]@m3]KV`J3TGISp�Xs^`U\VcU\T!L�Us^�X\T �MT���U�Us�MT ��R3X\XsT!J6U[IKJMpnUsX\R3r�T&J6U�m�^6pnIdUsIK^`JlV`J3_`]KT C

��(	� ��C C9l .Z0ED

e=^ V`]d]K^ ��Us�3T # ^B�&V`]	m3]SVYJMT}^aX�_aR3IKL3T&X�Us^ g�Tfm�^6pnIdUsIK^`JMT!L ��IdUs�w_`X\T!VYUsT!X�V`�!��R3XWV`�&oY��Us�MTfLBISpsm3]KV~o r'V~ojg)T
p&^�^ar�T�L C e��3ISpO�!VYJ g)T�LB^`J3T�VYg)^`RBUOUs�MT£bMT!]KL ��T!JaU\T&XORMpsIdJ3_}Us�MT�r�T&J�R I U\T&r'pO^`XNpn�3^aXnUW��RBUOg3RBUsUs^`J�p C e=^
p&^�^ar IKJ VYg)^`RBU�V LBIs"�T&X\T&J6U�m)^`IKJ6U�� m)^apsIdUsIK^`J�U\�3T���R3XWpn^aX�VYU£U\�MVcU'm)^`IKJaU'VYJ�L���]KIK�W{ U\�3Tfr�ISL3LB]KT�r�^`RMpsT
g3RBUsUs^aJ C e��3IKp9��IK]d])XsT�LBRM�&T�Us�3T�bMT&]SL�psIsp!T�g�o�V�#,V`��Us^`X	^ # � �6V`JML�XsT���T!JaU\T&X%Us�3TOLBIKpsm3]SV~o�V`g�^aRBU%U\�3T�]K^B�&VYUsIK^`J
^`X\IK_`IKJMVY]K]do m)^`IKJaU\T!L�Us^ g�o Us�MTf�&R3X\ps^`X C ��pnIKJ3_ Us�3Tfr�IKLMLB]dTfr�^`RMpsT�gMRBUnU\^`J X\T!psR3]dU\p�IdJw��oB��]KIS��p&^�^ar�IKJ3_ C
� JM�&T�U\�3TObMT&]SLfpnIqp&TNISp�XsT�LBRM��T�L�U\^�^aJ3TNT&IK_`�6Us�f^ #�I UWp�^`X\Id_aIdJ�VY]@pnIqp&T��6Us�3TGJ3TuU�U��&]dIS�W{�^$#/Us�MTOr�ISL3LB]KTGr�^`RMpsT
g3RBUsUs^aJ���IK]K] XsT&UsR3X\J}Us�3T LBISpsm3]KV~o�Us^�Us�3TG^aXsIK_`IKJMV`]�b�T&]SLfpsIqp&T VYJ�L}�&T&J6UsT!X C

��(	� + 6hA�6-]`8P.�05D :B0  T��]6-]`8

��J ^agB�qT!��U r�V~o g�T�psT&]KT!��UsT!L U\^�L3IKpsm3]SV~o I U�� p£LBT�U\T!��U\^`X£�&^�^`XWLBIdJ�VcUsT�pu�@^aXNUs^�bMJ�L ^aRBU r�^`X\T�IdJ # ^aXsr'VYUsIK^`J
VYg)^`R3UOU\�3T'^`g3�qT!��U C e��MIKpG�!VYJ g�T'LB^aJ3T�g6o m�^6pnIdUsIK^`J3IKJ3_}Us�3T��&R3XWpn^aX�^c�aT&XGVYJ ^`gB�qT���UNIdJ U\�3T'pn{�o LBISpsm3]KV~o
VYJ�L m3X\T!p\pnIKJ3_�Us�3T�pnm�V`��T!gMVYX C e��3T�^agB�qT!��UH��IK]K]=U\�3T&J g)T��3IK_`�M]dIK_`�6UsT�L IKJ U\�3T�^`gB�qT���U�]KISpqU C ��]dUsT!XsJMVYUsIK�`T!]do��
VYJl^agB�qT!��U�r'V~o�g)T£pnT!]dT���U\T!L # X\^`r U\�3T£^agB�qT!��U�]dISpnU�g�of�&]dIS�W{�IdJ3_�U\�3T ]KT�# U�r�^aRMpnT£g3RBUnU\^`Jl^aJlI UWp�]dISpnU�T&J6U\Xso C
� #�Us�3T psT&]KT!��UsT!L}^`g3�qT!��U�ISp�^`JfU\�3T pn{�o�mM]d^`U��BIdUE��Id]K] g)TGr�V`Xs{aT!L}g�o�V���V`ps�3IKJ3_�XsT�L�g)^KU C
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e=^�]d^B�!VcUsT�V�pnRMI UWVYg3]KT _`RMIKLBT�pqUWVYX�JMT!VYX�Us^�oa^`R3X�U\VYX\_`T&U�^`g3�qT!��U���T!J6UsT&X�o`^aR3X�U\V`Xs_aT�U��&^6^aX\L3IdJMVYUsT�p�IdJ6U\^�Us�MT
H�IdT!]KL 	 ¡ � VYJML |�T���UsTVU�U\g�^KUBT!p��/V`JMLlU\�3T&J ¡ T�V`L DGF�Z C � ^�^`{�# ^aXNV�psR3IdU\VYgM]dT�_`R3ISLBT'pnU\VYXNJ3T�VYXOUs^f^`JMT
^ #%Us�3T�_`RMIKLBT!XGLBT�U\T!��U\^`XWp C�� ^c�`T£Us�3T # ^B�&V`]�m3]KV`J3T�VYJML _`R3ISLBT&XOU\^}m)^apsI U\Id^aJ U\�3T'�W�3^apsT&J _`R3ISLBT'pqUWVYXO^`J V
_`RMIKLBT�LBT&UsT!��Us^aX C ��^ � p&^�^ar IdJ VYJML r'VY{`T£bMJ3T'V`Lc�qRMpqU\r�T&J6U\p�Us^fU\�3T�m)^apsIdUsIK^`J ^ # U\�3T�_`R3ISLBT&X�Us^l�&T&J6UsT!X
Us�MT�_aR3IKL3T�pqUWVYX[^`J'U\�3T�L3T�UsT���U\^`X C ��^YU\T�Us�MT���RMXsX\T&J6U[L3T�UsT���U\^`X	�&^�^`XWLBIdJ�VcUsT�p5�=e��3T!psT��&^6^aX\L3IdJMVYUsT�p%VYX\T�V`]Kps^
m3R3gM]dISpn�MT!LG�MV`JMLfr'V~o'g�TGX\T!VaL�IKJ�g6o�Us�3TNU\T&]KT!p\��^`m)T ��^aJ6UsX\^`]@pnoBpnUsT!r ��C

��(	� � ]	��35.�<t.�05D : *435.Z1E6 +98;:=<

e��3T�psT&]KT!��UsT�L ^agB�qT!��U\p£m3IrUBT!]%��^�^`XWLBIKJMVcU\T!p V`XsT'LBISpsm3]KV~oaT!L VcUGU\�3T�g)^YUsUs^ar ^$#	U\�3T�^`g3�qT!��U�]dISpqU£Us^ VYISL Us�MT
^`g�pnT!Xs�aT&X%IKJ}Va�&¤6R3IKXsIKJ3_�V _`RMIKLBTNpnU\VYX C F��3^`RM]KL�Us�3TN_`RMIKLBTNpnU\VYX[J3^`U #,V`]d]�^`J�Us�3TN_`RMIKLBTOLBT�U\T!��Us^`X����3T!J�U\�3T&o
ps]dT�� U\^lUs�MT&IKX U\V`Xs_aT�U£�&^6^aX\L3IdJMVYUsT�pu�/Us�3T}^`gMpsT&X\�`T!X �&VYJ UWVY{`T}Vlpn�3^aXnU�TVUBm�^6pnRMXsT'^$#[U\�3T'UWVYX\_`T�U£Us^ ]K^B�&VcU\T
V pnR3IdU\V`g3]KTfpnU\V`X�^aJ�U\�3Tlps�&IdT!JM��T�LBT�U\T!��Us^`X C e��3T!o �&V`J�U\�3T&J pnT&U�U\�3TfbMT&]SLw��^�^`XWLBIKJMVcU\T!p�IdJ<DGFBH�IdJ�L�U\^
Us�MTGU\V`Xs_aT�U���^�^`XWLBIKJMVcU\T!p�� ¡ T�V`LlDGFMZ���V`JML�pnT!]dT���U�U\�3T£pnU\VYX�Us�3T!o�ISLBT&J6UsIdbMT�L�^`J�# X\^`r U\�3T TuU�m)^apsR3X\T C e��MT
LBISpnmM]KV~oaT!L mMIrUBT&]3�&^�^`XWLBIdJ�VcUsT�p�^ #MU\�3T�psT&]KT!��U\T!L�pqUWVYX��&V`J£U\�3T&J�g)T���^ar�m�VYX\T!LGU\^OUs�3T�m3IsUBT&]M�&^6^aX\L3IdJMVYUsT�p�# X\^`r
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Us�MT£L3VcUWV C �<IdUs� {�J3^ ��]KT!LB_aTG^ #�Us�MT m3IsU�T!]=p\�&V`]dT��3Us�MTGUsT!]dT�ps�&^`m)T ^#"@pnT&U�X\T!¤6R3IKXsT�L�U\^�m3]SV`�&TGUs�3T£_`R3ISLBT£pnU\V`X
^`J}Us�MTG_`R3ISLBT LBT&UsT!��Us^aX��&VYJfg)TNUsX\Id��ISVY]K]do��!VY]S��R3]SVcU\T!L C
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9;:]9_^a`1Ncbedgf1hi`1MOY=@�Gj^jQaf)CEDPGJN�IHk%XAhlN):\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[: m
9;: n ^a`1NcB"Co^pf7qsr=K1VWtuY=D)kvSAIpwj@1@1YxD1Vy>A@1B/z{Co|j^"wjza} ~�~s��GJN,D.FHY=SWD5F�:[:\:[: �

� ��.� ���.� ���%�"��� � �'�(*'�2u�.��6.� 8 6
n1:=<?>A@1B/CED5FHGJILK1MON,DPG�:\:[:\:[:\:[:[:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[: >
n1:]9_>A@1B�Q{XWM�N�ILX7:[:[:\:[:\:[:\:[:[:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[: �
n1: n >A@1B�Q�Q{��QTSADPGJILSWr=rxN�I�:[:\:[:[:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[: �
n1: m >A@1B�Q�Q{� :\:[:[:\:[:\:[:\:[:[:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[: �
n1:]�_>A@1B�B5S�h�X#r=�1r�X#D1N�:\:[:\:[:\:[:[:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[:�<$�
n1: > bedgf;hi`5M�Y�@�Gj^ N,r=N�FLhlSA�.N3QTSWD1U5VWK1IiX�GLYxSAD/:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[:�<A<
n1:���CED5FHGJILK1MON,DPGRQTSADAGLIJSArxr=N,IiFaX#D5@)GJ`5Nc>W@1B�f;Y�GLNcCED5FHGJILK1MON,DPG�:\:[:\:[:\:[:�<�9
n1: � ^ N,MO��N,IiX�GJK5IJNcf�N�D5FHSAIp^�����N�F?:R:[:\:[:\:[:[:\:[:\:[:R:[:[:\:[:\:[:\:[:�<�9
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^a`5Y=FO@;S;hlK5M�N�DPG�@;N$FJh,IJY��.N$F[GL`1N�K.FHN�S#kRQTCJQ{wj�jw���YxGJ`�GL`1N wjw�� >W@5B Y=D5FHGJILK1MON,DPG
X#G�GL`1N wjw���bjd f;hi`1MOY=@;G�GLN,r=N�FLhlSW��NW:gC4G FH`1SAK1r�@��.N ILN�XW@ YxD hlSWD��oK1D5h GLYxSAD���YxGJ`
GL`1N VWN�D1N,IiX#rjQTCJQ{we�pw bjFJN,I! �XWD�K5X#r#"�GL`1NZQTCJQ{wj�pw QTSAD;U5VAK1ILX#GJY=SWD$ �X#D�K5XWrpX#D5@
GL`1N�QTCJQ{wj�jwgq�rxK5V#t4YxD bjFJN,IiF&%RK1Y=@1NW:' �X�GLN,ILY=XWr"`5N,ILN�h,SWD5h,N,DPGJIiX�GLN�FRSWDZGJ`1NyFJ�.N$hlYxU.h
SA�.N�ILX#GJY=SWD7S#k"GJ`1Nc>A@1B�Y=D5FHGJILK1MON,DPG�kvIJSAM(��YxGJ`1Y=DZQTCJQ{wj�pw3:

<
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QTCJQ{we�pw `5XWF ��N,N�D hlK5FHGJSAM�Y�FJN�@)kvSWIj>A@1B�Y=D�GL`1N\kvSWr=r=S ��YxD1V �aX���F�

��������������������! #"$�%�'&)(���*,+-�!�/.��0�1(��#2435�-+-67���8.9�-�9":�
��;�<���%�7"=�?>=.9&)"@�7(A�?B�"<CEDGFE&)BH I�1�J�LKEMON PRQTSUK4V@QWNYX$�!��35�R.Z�@.8KWP[F\2E35�-+-67���
����[]9K^F_2435�-+-67���a`T�������b"$�a�7(c���%�$"=���L�����edW]/SfKghdiNjMG":k9�b"$�����1(����\�-"=�=&$���1X$���g+��B%"I�-���������������! #"$�%�i&:(���*[+��!�/.��0�1(��

^a`1N$FHN X#ILN @1N�FLhlILY ��N�@ M�SAIJNZkvK1r=rx� Y=D kvSArxr=S ��Y=D1V�FJN�hlGJY=SWD5F�: w�@;N�FLhlILYx�1GJY=SWD SWk3`1S �
QTCJQ{we�pw Y=FjhlSWD1U5VWK1ILN�@ykvSWIp>A@1B/Y�F�X#r�FHSOY=D5hlr=K5@;N$@ :

lAm$n oqpcr s^tvu^wyxOzc{}|ht#w�~��ItU�<��zvxT��wT�=��t
^"X��1r=Ny9;:=<*FH`1S �pFeGL`1NyB"Co^pf�`1N$XW@;N�ILF[FLXZ�WN$@�Y=D N$XWhi` >W@1B B Co^pfZU5r=NOGJ`.X�G[IJN��1ILN�FJN,DPG
GL`1NOYxD5FHGJILK1MON,DPG[hlSAD;U5VWK5ILX#GJY=SWD	��`1N�D�GL`1NOYxM*X#VAN �aXWFeGLX-�WN�D :c^a`1NI��XWrxK5N�FekvSWIRGJ`5N�FJN
�5XWILXWMONlGJN�ILF�D1N,N$@cGLS ��NaN,DPGJN�IJN$@&���\GJ`5NTS �5FHN�I/�AN,I �.N,kvSWILN{XWDN,����SAFJK1ILN�Y�F GLX��AN,D : Q{X#ILN
`5XAF\GJS �.N*GiX��AN,D GJ`5X#GcGJ`5N�FJNA��XWrxK5N�FcXWIJNyh,SWILIJN$h G �.N$h,XWK5FHNyGJ`1N�IJN*Y�F@����XWK;GJSAMOX#GJY�h
hi`1N$h)��YxD1VGJ`.X�Gjh,XWD ��Nc@;SAD1NW:

^"X��1r=Nc9;:=<-
 >W@5B�QTSWD1U5VWK1IiX�GLYxSAD�B"Co^pf7d\N,� �{SWIi@1F
d\N�� �{SWIi@ ^�����N ~ �1XWM��5rxN��sX#r=K1N �eN�FLhlILY=�;GJY=SWD
%��pw ^aCo� fPGJILY=D1V �]9W�#�Az�� |eX#MON\S#k�VWIiX�GLYxD1V
%��pw ^pf1~�^ B"rxSPX�G  �Y=h,IJSAM�N,GJN�IaFJNlGJGJY=D1V<�vMOY�hlILSWMONlGLN,IiF:�
%��pw ^pf1} �R^ fPGJILY=D1V � wL� %RIiX�GLYxD5V�FJrxSWG
%��pw ^�za} w�� fPGJILY=D1V ��Q �R}�} C  Zw ^����q� z{r�X���NR@;Y=ILN�h GLYxSAD
} w� �qT|jw� Z~ fPGJILY=D1V � �{bez{Co�jCob  �� } X#MO�7D5X#MON
f �Rb;�pQ{~ fPGJILY=D1V � qsr�X�GJN <-� f;SWK1IihlNR�1r�X�GJN
B �[Q{bef B"rxSPX�G to9;: >A� >A@1B�f���N�hlGJILSWVAIJ�5XW`ykvS;hlK.F�N,D5h,S;@;N,I���X#r=K1N
^a`1N�S �5FJN,I:�WN,ION�DAGLN,IiFOGJ`5N��5X#IiX#MON,GJN,IiF'���/U5IiFHGySW��N,D1Y=D1V�GL`1N F����7"��8;�Q��-����5XWD1N,rakvSAK1D5@ K1D.@;N,IOGL`1N ]��%�)�����! A"=���APT(��%���/(J35� MON,D�K S#keGJ`1N QTCJQ{we�pw S �5FHN�I/��Y=D1V

9
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#�%$&�#�('(�#�)�!� n
��Y=D5@;S � �%FJN,N�B"Y=VWK1ILN$91:x<Z� "{X#D5@ GJ`5N,D FJN,r=N�h GLYxD5V8��XWrxK1N$FyXWF*XW�1�1ILSW�1ILY�X�GJNA: �eD5hlN7GL`1N
h,SWD;U.VWK1IiX�GLYxSAD7Y�Fjh,SWILIJN$h Gjh,rxY�h)�)GL`1N V;":&)(��/�AF "=����2 �1K1GHGJSAD GJS)N,D5FJK1ILN\GJ`1ND1Nl��GeB"Co^pfU.rxN ��Y=rxr�YxD5h,rxK.@;Nc@;N�FJY=IJN$@ ��X#r=K1N$F,:�f�N�N[B Y=VWK5IJNc9;:]9;:

Select the AAO 6dF instrument
configuration control

B Y=VWK5IJNc9;:=<-
sf�N�rxN$h GLYxD1VOGL`1Ncwjw���>W@1B hlSAD;U5VWK5ILX#GJY=SWD ��Y=D5@;S �

Click this button to record 
displayed settings

Enter 6dF setup configuration
here before taking an exposure

Time setup last recorded
is shown here

B"YxVAK1ILN[91: 9�
 wjw�� >A@1B�h,SWD;U.VWK1IiX�GLYxSAD ��Y=D5@;S �
f;NlGHGLYxD5VAF\X#ILNFLXZ�WN$@ YxD X)h,SWD;U.VWK1IiX�GLYxSAD U5r=NSAD @;Y�F � ��`5N,ILN3GL`1N,��h�X#D ��N��1Y=h)�AN�@
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K1� ���*GL`1N[D1Nl��GpILK1D7S#k�QTCJQ{wj�pw3:5^ X �1r=N[91: 9�FJ`1S �pFaNl�1XWM��5rxN[hlSADPGJN,DPGiFaS#k�GL`1Y�FaU5r=NW:
���������������������������������������������������������������������������������������������������������������������������������������������������
�
	������������������������������ "!
�#��$%��&'������� ($)�)&'�) � �*�������+�������,�����-'�� �� ������� �./���.0,���&���&���&1���*�0& ����2 )&(���
�3����+� �.4���� 5+6&879 �;:<����+� �=>7?���������@� �.(��-*�4&2 ��
���3A�������+� �� ��3���.3B����2�) 
�3A�������&C7D@�$%��,�$E,��)��.��) '+)������FA��� 'A) �4�)�F�) "G
�#H� �������2�/B����2�) �.0���� �+6&I+6����$��/�)���
�A�A) ����JGK����L� *,���� 0���
 �.��5���5������-#$)�2��.MG
���������������������������������������������������������������������������������������������������������������������������������������������������

N .��MG<������O� >!P	�Q�R�S�T�Q
N .��MGU���),���&V!XW�Y"G[Z�Y�\�\�\�\
N .��MG]���������F���J!_^�Y�\�\`
N .��MG[����+)Aa!]T�b�c%d�H�dFb�R
N .��MG<A������� >!Ue)������ �f�Y
N .��MGg& ������F���J!_^�^hG[i�j�\�\�\�\
N .��MGg&������J!]S

^ X �1r=N[91: 9�
 wjw�� >W@1B/~s�1X#MO�1r=NcQTSAD;U5VAK1ILX#GJY=SWD7�eX#GLX

lAm)l kmlv|onqp rDs"lc{ �=pUwtk�~ur s^t#w[| xwv��xs�|
QTCJQ{we�pw Y=DPGJN,IJk%XWh,N�FsGJScGL`1Njr=S;h,XWr.^jQafOK5FJY=D1V3XcFJY�GLNltEFH��N�h,Y�U�hp�1r=K1V#t4Y=D*M�S;@;K5rxNA:y�pNlkvN,I
GLS�GL`1N�QTCJQ{wj�jw qsr=K1V#t4Y=D beFHN�ILF&%RK1Y�@;NOkvSAI\kvK1rxrT@;NlGiX#Y=rsSWD `1S ��GL`1N�FJN*�1r=K1V#t4Y=D5F[X#ILN
��ILY�GJGJN�DZX#D5@�YxMO�1r=N,MON,DPGLN�@ :R^a`1Nbed f;hi`1MOY=@;GR�1r=K1VWtuY=D�XWh�hlN�FLFJN�Fj^jQaf YxD;kvSAIJM*X#GJY=SWD
K5FJY=D1VyGL`1N*wjw�� KEMON PRQTSUK4V@QWN FH��N�h,Y�U.h�X�GLYxSAD	��Y�GL` X�FHS;h)�ANlGRh,SWD1D5N�h GLYxSAD GJS�GJ`5N
KEMON PRQTSUK4V@QWN FJN,I:�WN,I$:B1SAIcN�XAhi` Nl�;�.SPFHK5IJNOGL`1N*�1r=K1V#t4YxD/FJN,D.@1F\GJ`5N3y{z MTVhM hlSAMOMOXWD5@ � kvSAIcGJN�rxN$FJh,SW��NY=D;kvSWILM*X�GLYxSAD�� " X �aX#YxGLF3X�IJN$FH��SWD5FJN*kvILSWM GJ`1N KEMON PiQOSUK�V�QWN FJN,I:�WN�I " GJ`1N�D�FJN,D5@1F
X ��Q�P�C,F |WMLK hlSAMOMOXWD5@�GJSyVANlGpGL`1N[GLN,r=N�FLhlSW��N[kvS;hlK.FjX#D.@7U5D5X#r=r=��FJN,D5@1FpGJ`1N V@QR6KgLKWQOV hlSAM�M*XWD5@ GJS VWN,G3GL`1N7h,K1ILIJN�DAG�IJSWGLX#GJSWI�X#D1VArxNA: ^a`5N
y}z MTV;M hlSAMOMOXWD5@
FJ`1SWK5r=@�ILNlGJK5IJDOGL`1NpMON�XWD#�jw&"A�R~{Q "ANF~PK1Y=D1S�� "AXW�1�5X#ILN,DPG `1SAK1I�X#D5VWr=N "AXWYxILM*XWFLF�S#k�GJ`5N
GLN,r=N�FLhlSW��N "1be^ XWD5@7f1^ kvILSWM�GL`1NRGJN�rxN$FJh,SW��NRM*XAFoGLN,Iphlr=S;h)�yX#D5@)GJ`5Nq�,N,D5Y�GL`7@;Y�FHGLX#D.hlNW:

^a`1N$FHNy@1X#GLX XWIJNyXA@1@;N�@ GLS GJ`1N)FHGLXWD5@1XWIL@ FHN,GcS#kjQTCJQ{wj�pw�GJN,r=N�FLhlSA�.NA�AN,� �{SWIi@1F
kvSAI�Y=D5FJN,IJGJY=SWD Y=D GL`1N ILN�FJK1rxGLXWDAG B"Co^pf U5r=NW:
CED XA@1@;YxGJY=SWD GJ`1N �1r=K1V#t4YxD X#r�FHS ��IJYxGJN$F
GL`1N�kvSWr=rxS ��Y=D1V "/k9���/.D�9"��J`W(��/�Z� tjFHN�NO^"X��5rxN*9;:]9;:*f�SWMONOS#kTGJ`1N$FHN#�AN,� �TSAIL@5FeXWIJN �oK5FHG@;K5�1rxY�h,X#GJN$F�S#k�GJ`1NpFHGLXWD5@1X#Ii@*QTCJQ{wj�pw �AN,� �TSAIL@5F �1K1G�YxD.hlr=K5@;N�@ ��YxGJ`O�1ILNlkvN�IJILN�@wjw��
kvSAIJM*X�GJGJY=D1V*X#D5@�D5XWM�NA:

^"X��5rxNc9;: n�
 >A@1B�~s�PGLILX�^ N,r=N�FLhlSW��N[B"Co^pf�d\N�� �TSAIL@1F
d\N�� �{SWIi@ ^�����N ~ �1XWM��5rxN��sX#r=K1N �eN�FLhlILY=�;GJY=SWD
����C %RCo| fPGJILY=D1V � wjw���� bedRtEf1hi`1MOY=@�Gc<A: 9#M wjw��
be^��pw ^�~ fPGJILY=D1V � �#m#ti<$9�t4�A��� wew���be^��pw ^�~��WN�� �{SWIi@
be^pf;^ w;��^ fPGJILY=D1V �]9#n�
=<��!
 9W�1: ��� wew���be^pf;^"wh��^ �AN,� �{SWIi@���\f;^"wh��^ B"rxSPX�G ��: >#m;�#�W�A��N��R�1< wew�� � �Rf;^"wh��^��WN�� �{SWIi@���@;N,VAIJN�N�F)�
f;^pf1^ w;�"^ fPGJILY=D1V � �1<-
]9#n%
 �1<W: ��� wew�� f1^pf;^ w;��^ �AN,� �TSAIL@
� wef;^"wh��^ fPGJILY=D1V � �W��
=<�n%
 nA�1:]9;<9� wew�� � wef;^"wh��^��WN�� �{SWIi@



��� � � ����� 
��)� �?���(� $�� ��� 
 �!��'"� �"����$ � � 
�� ����� '���� � �
	������ � �)�!���g�
^ X �1r=N[91: n%
 >W@1B ~ ��GJIiX^ N,r=N�FLhlSA�.N[B"Co^pf7d\N,� �{SWIi@1F

d\N�� �TSAIL@ ^T�P��N ~s�;XWMO�1rxN��sXWrxK1N �jN$FJh,IJY=�;GLYxSAD
we};^ �Rz�f B"rxSPX�G <A<�nW� wjw���wj};^ �Rz�f\�AN,� �{SWIi@��vMON,GJN,IiF)�
} w ^ �Rz�f B"rxSPX�G tEn1<A: 9P��nWnAn wjw���}�w ^ �Rz�f\�AN,� �{SWIi@��vMON,GJN,IiF)�
} �R| % �Rz�f B"rxSPX�G <�mA�1: �P�#�W� wjw���} �R| % �Rz�f �WN�� �{SWIi@��%MONlGJN�ILF)�
 Z~�wj|;�pw B"rxSPX�G <A:]�W��mA�A�#N��R�1< wjw��  �~�we|h�pw �AN,� �TSAIL@_�%@;N�VWILN,N$F:�
 Z~�wj|e�e~aQ B"rxSPX�G to�;: >#m��#>#mAN��R�5< wjw��  �~�we|j�R~{Q �WN,� �{SWIi@���@;N,VAIJN�N�F)�� �R^pf;^ B"rxSPX�G <A: 9Wn#mP�W>#N��R�1< ��S#GiX�GLSWIR��X#r=K1NcX�GpFHGLX#IJG�S#k�Nl�;��SAFJK1IJN� �R^�~T|j� B"rxSPX�G 91: nWmP�#>���N��R�1< ��S#GiX�GLSWIR��X#r=K1NcX�G�N,D.@�SWk N,����SAFJK1ILN
^a`5Ny^jQaf �1rxK5V#t4YxD Y�FchlSAD;U5VWK5IJN$@ZGLS K5FJNyX FHS;h)�WN,G[YxDPGJN�IHk%XAhlNOkvILSWM�X hlSWD1U5VWK1ILN�@

KEMON PRQOSfK4V�QWN FJN,I:�WN�I�: f�N,N�f�N$h GJY=SWD n1: > kvSWI*@;N,GLX#Y=r�FOSWD�`1S ��GJS�h,SWD;U5VAK1ILN)GL`1N
�5rxK1VWtuY=D :

lAm�� kmlv|erYshk r���$zv���4��t v��@x���pcp<�$tv� oqpcr��Gs��ok��������
��� w[|htvuy�=�Itvu

CED XA@1@;YxGJY=SWD�GJSOGJ`5N\B"Co^pf�Y=D;kvSWILM*X�GJY=SWD XW@5@;N�@�K5FJYxD1V�GL`1NchlSAD;U5VWK5ILX#GJY=SWD)�5rxK1VWtuY=D X#D5@
GL`1Ny^jQaf YxDPGLN,IJk%XWhlN ""QTCJQ{wj�jw�X#r�FHS XW@1@5F\YxD;kvSAIJM*X#GJY=SWD X �.SAK;G[GJ`5NO>A@1B Y=D5FHGJILK1MON,DPG
h,SWDPGLXWYxD5N�@yY=D B Co^pf!�1Y=D5X#IL�OGLX �1rxN$F,: ^a`1Y�Fa@1X�GiX3Y=D5h,rxK5@1N�F{GJ`5NeU �1IJNR��SAFJY�GLYxSAD1YxD5V3Y=D;kvSWIJt
M*X#GJY=SWD�K5FJN�@7kvSAIpGL`1NcNl�;��SAFJK1ILN3X#D5@ XWr=FJSyXOU5r=N3h,SWDPGLXWYxD1Y=D1V*GL`1N[GLN,r=N�FLhlSW��N[GLN,MO�.N�ILX#t
GLK1ILNW:

QTCJQ{we�pw/h�X#r=r=F GJ`1N�B"Co^pfR�1r=K1VWtuY=DcX�k GLN,I�h,rxSPFHY=D1VaGJ`5N�B"Co^pf\YxM*XWVWN�U5r=N�X�G GL`1N�N�D5@\S#k
XWD*Nl�;��SAFJK1IJNA:"^a`5Np�1r=K1V#t4YxDOILN ��ILY�GLN�F�GL`1N�U5r=N ��YxGJ`*GL`1NpN,�PGLILX[@5X�GLX[XA@1@;N$@ : ^a`1NpNl��GLILX
�5YxD5XWIJ�\GiX��1r=N�Y�F"IJN$XW@[Y=DckvILSWM�@1Y=F/�\U5r=N�F"@;N�FLhlILY ��N�@3YxD3GJ`1N�B"Co^pf[�5rxK1VWtuY=D3h,SWD;U5VAK1IiX�GJY=SWDU.rxN � �A�� � ,���,��.�� � ,�2�����5� � Q�Q"! N .$# ���5��&�G ,�2������� :c^a`1Y=F[h,SWD;U.VWK1IiX�GLYxSAD�U5r=N*M3K5FHG��N �{SWILr=@�t4ILN�XW@5X��1r=NeXWD5@ hlSWDPGiX#Y=D5F{�5X#IiX#MONlGLN,I���X#r=K1N\�5XWYxIiF�XWF�FJ`1S ��D)Yxk"GLX��5rxN391: m.:
�
Q�Q%! N .&#'#�d��)(�A��2����W)�5�4,������������������2��(����)�� 
A������� �^�f������ "! � �A�� � ,���,2��.�� � ,2�2�����F� � Q�Q)!�f N .*#)f�A)������ �^6GU������&
A������� �Y�f������ "! � �A�� � ,���,2��.�� � ,2�2�����F� � Q�Q)!�f N .*#)f�A)������ �Y"GU������&
�� ���� 5+)A�f����2�� "! � �2A�� � ,���,�.�� � ,2�2���)��� � Q�Q)!�f N .$#�f2�� ���� �+�AJGP.����
�� ���� 5+)A�f��� +� �����M![j

^ X �1rxN391: m�
 wjw�� >A@1B�B"Co^pf�qsr=K1V#t4Y=D QTSAD;U5VWK5ILX#GJY=SWD��RX�GiX

^a`5NeU �1IJNR��SAFJY�GLYxSAD1YxD5V�@1X#GLX3U5r=N�F�X#ILNRNl�;�.N$h GLN�@)GJS �.N\Y=D7B"Co^pf �1YxD.X#IL�OGLX��5rxNRkvSWIJt
M*X#G "AQTCJQ{wj�jw ��Y=rxr �oK5FoG"YxVAD1SWILN�GJ`5N��1ILYxM*XWIJ�e`1N�XA@;N,I K1D1YxG"X#D.@[hlSW���jGJ`1N{zTCo|e^ weza}�~
N,��GJN,D.FHY=SWD Y=DAGLS�GJ`1N[D1N � MK1rxGJYxtuN,�PGLN,D5FJY=SWD B Co^pf8�  �~�BT�{Y=MOXWVWNRU5r=NW:



� �������	��
 �

� ����� � � ���[� � �  � � � � �*� �

� � 	

��N,kvN,IRGJS)GJ`1NyQTCJQ{wj�jw�QTSAD;U5VAK1ILX#GJY=SWD	 �XWD�K5X#r kvSWIekvK1r=rs@;NlGiX#Y=r SAD QTCJQ{wj�jw `5XWIL@;t
�aX#ILNchlSAD;U5VWK5ILX#GJY=SWD :�^a`1Y�FeFJN�hlGJY=SWD�h,SWD5h,N,DPGJIiX�GLN�F�SAD GJ`1N�hlSWD1U5VWK1IiX�GLYxSAD FHN,GHGJY=D1VPFpkvSAI
GL`1Njwjw�� >A@1BZY=D5FHGJILK1MON,DPG�: beFHN�GL`1NRQTCJQ{we�pw h,SWD;U5VAK1IiX�GJY=SWD %\bpC�kvSAI �1K5Yxr�@;Y=D1V[GJ`5N
>A@1B/FJNlGJK5� :

�\m$n oqpcr s^tvu^wyxOzc{}|ht#w
w{GRGJ`1NGJSA�ZSWk GJ`1NOhlSAD;U5VWK5ILX#GJY=SWD `1Y=N,IiX#Iihi`���Y�FpGL`1N�YxD5FHGJILK1MON,DPGRGLX �1rxN " X#D5@ kvSWI\>W@1B
GL`1Y=FprxS�S-�;F{r=Y �ANcB Y=VWK5IJN[n1:=<W:

Use camera named 6dF

Select an instrument controller for
the TCS plug-in and the instrument
configuration

Select the UK-SCHMIDT
telescope plug-in

Click the "available" toggle

B"Y=VWK1ILN[n1:=<-
�QTCJQ{wj�pw >A@1B/CED.FoGLIJK1MON�DAGeQTSAD;U5VWK5ILX#GJY=SWD %\bpC

>



� � �����	��
���'"� � �(' �
�\m)l o�pcr ~��L{ | xT�
^a`5Nah�X#MON,IiXpY�F"GJ`5N,DOhlSWD1U5VWK1ILN�@XWF�FJ`1S ��D3Y=D�B"Y=VWK1ILNan1:]9;: |jS#GLNTGL`5X�G�Y�F�Y�G `1N�IJN ��`1N,ILN
GL`1NB"Co^pf7�1r=K1VWtuY=D Y=FeFH��N�h,Y�U5N$@ :�wpr�FHS*D5S#GJN "1GL`5X�G\QTCJQ{we�pw�ILNF~PK1Y=ILN�F{GJ`.X�GeB"Co^pf7U5r=N
`5N�XW@1N,I[FHY �,N'��NO�1IJN,t4h,SWD;U.VWK1ILN�@ t�YxG[Y=F[@;SAD1N�`1N,ILN ���ZFJ��N�hlYxkv��YxD5V�GL`1NOD�K1M ��N,I\S#kanW>�AN,� �{SWIi@ �1r=S;h)�;F"GJS[ILN�FJN,I:�WNW:�CED1Y�GLY=XWrxr=�>A@1BZB"Co^pf3U5r=N�F ��Y=r=r �.NeFHY=D1VWr=NaNl��GJN�D5FJYxSAD�B"Co^pf
Y=M*X#VAN�F �1K;G!��Y=rxr�VAIJS �
GLS M3K1rxGJYxtuN,��GJN,D.FHY=SWD�U5rxN$F*X�k GLN,IOGJ`5N B"Co^pf��1r=K1V#t4YxD�ILN ��ILY�GLN�F
GL`1N,M ��YxGJ`7GJ`1N[N,��GJIiX@1X#GLX5:

Select the 6dF dewar from this popup

Select the 6dF controller from this popup

Allow space for 4 FITS header blocks because we have 
more than 108 keywords

6dF requires the rotater value at the end of the exposure
instruct CICADA to make a TCS call at the end

This name is fixed as it is used to key to the
specifically written FITS plugin for the 6dF

Select the Solaris host holding the SBUS
interface card to the SDSU controller

B"YxVAK1ILN\n5: 9�
�QTCJQ{wj�pw�>A@1B Q{XWM�N�ILX*QTSWD1U5VWK1IiX�GLYxSAD



� ���"'�� ����� � ��� �!�"
#�%$&��� ����$ �#�)��'"�(' 
 �!� �	��


�\m�� oqpcr ~�~�� ~ ��tIwyxT� � �$| x
|jS#GJ`5YxD1V�FJ��N�hlYxU.hOGLS�>W@1B GJS D5S#GJN*`5N,ILNOteM*X��ANOFJK1ILNOGJ`1N7f;zabef @;N��PY�hlNyXA@1@;ILN�FLF\Y=F
h,SWILIJN$h GJr=�yFJ�.N$hlYxU5N�@ :�f;N,NcB"YxVAK1ILN\n5: n

The SBUS device name that holds the
SDSU controller which is a generation
2 device

Only one CCD and it is named CCD_102

B"Y=VWK1ILN[n1: n�
�QTCJQ{wj�pw >A@1B Q�Q{��QTSADPGJILSWr=rxN�IpQTSAD;U5VAK1ILX#GJY=SWD



� � � ���	��
�� ��� �
�\m�� o�pcr ~�~��
B"Y=VWK1ILN3n5: m)FJ`1S �pFaGL`1N>A@1B Q�Q{��h,SWD;U.VWK1IiX�GLYxSAD�kvSAI\QTCJQ{we�pwc:�C4Ge`5XAFpSAD1NcILN�XW@1SWK;G
XWMO�1rxYxU5N�IjhlSAD;U5VWK5IJN$@)X#D.@�Y�F�X�G�GL`1N �.SWGHGLSWM r=Nlk GRhlSWILD1N�I{SWk�GL`1NQ�Q{�3:

Include WCS information when calibration
detail is known and enterred here

Readout amplifier configured as shown

B"YxVAK1ILN\n5: m�
�QTCJQ{wj�pw >A@1B Q�Q{��QTSAD;U5VWK5ILX#GJY=SWD



<$� ���"'�� ����� � ��� �!�"
#�%$&��� ����$ �#�)��'"�(' 
 �!� �	��


�\m�� oqpcr rv�Ks�� ��� �$�Ltv|
^a`1NekvS;h,XWrx�1r�X#D5NRh,SWD;U5VAK1IiX�GJY=SWD ��Y=D5@;S � Y=F{K5FJN�@yGJS�N,DPGJN�Ia@1NlGLXWYxr�FTS#k"h�X#MON,IiX\GLN,MO�.N�IHt
X#GJK1ILNRh,SWDPGJILSWru:�w kvK5rxr�@1N�FLhlILYx�;GLYxSAD)SWk `1S � QTCJQ{we�pw��Wf;�\f;b �.N�IHkvSAIJM*FTGJN�MO�.N�ILX#GJK1ILN
h,SWDPGJILSWr�h,XWD ��N kvSWK5D5@ X#G*GJ`1Nc�jf1wjwL� Fy�eNlGLN�h GLSWI)} X�� �jN,GJN$h GJSAIy}�X ��� �TN � �5XWVWNA:B"Y=VWK1ILN[n1:]�FJ`1S �pFTGJ`5NcFHN,GHGJY=D1VPF{kvSWIaGJ`5Nc>W@1B @;N �aX#I$:

The 6dF camera has two temperature sensors, they are configured as shown below.
FOCALPL is the setpoint sensor. Alarms are shown if temps go out of range.

Temperatur sensor type chosen from these popupsThese are the SDSU controller address values

Temperature setpoint is entered here - the SDSU controller will control to
this value

Control warmupo parameters entered here

CICADA will request temperature values from the
controller at this rate. NB temperature readouts are
not done during exposures.

These servo parameters are sent
to the SDSU controller for the
temperature control model

B"Y=VWK1ILN[n1:]�!
�QTCJQ{wj�pw >W@1B/B5S;h,X#r=�1r�X#D1N3QTSAD;U5VWK5ILX#GJY=SWD

�
	������� ����������� ������� ���� �� !
"� �� �� #�$��%&��!
')(+*,��-��$"�!.�)/0��%#�$1
12"&/0��%#�$1
12"&12�����3')��/,/,!
'.�$��"&�� �4����)!
���5!
'��$�� �')!����3!
���#!2'��$�� &'�!�� 	��)�



� � � � ��� ������� ���&� ����� � � � �a��� � �!��
#�%$&���('(�#�)�!� <W<
�\m:o n;p rDsMlc{ �=pUw ka| �=| uVs�� �8| ~ ��tU�<��zvxT��wT�=�It
B"Y=VWK1ILN�n1: >�FJ`1S �pF�GJ`1N %\bpCkvSWI)FJNlGJGJY=D1V GJ`1N @;NlGiX#Y=r=F*SWk\GJ`1N Y=DPGJN,IJk%XWh,N GJS GL`1NZbjd
f1hi`1MOY=@�G\^jQaf�:�^a`1NcY=DAGLN,IJk%XWh,NcY=Fh��Y=XyXyD1NlG �{SWI:��FJS;h)�WNlG�GLS*GJ`5N>W@5B�� Y=D5hlN�DPGJN,IR|j^
M*XAhi`1YxD5NW:�~sDPGJN�I GJ`5N{FJS;h)�WNlG"D�K1M ��N,I�X#D5@3FHN�I/�AN,I�`5SAFHGJD5XWM�NTYxD3GJ`1Y�F ��YxD5@1S �[:"^a`1N�QTC4tQ{we�pw h,SWDPGJILSWr�`1SPFoGsFJ`1SWK1r�@ �.N{GL`1NpFJXWMON{`5SAFHG kvIJSAM ��`1Y�hi`3GL`1NeQTCJQ{wj�pw S �5FJN,I:�PY=D1V
Y=DPGJN�IHk%XAhlN\Y=FpIJK1D�:

Enter socket number for communication
with Wincenter TCS server

via network socket
Indicate that TCS interface is

Timeout for getting a response
from TCS

These data items can be delivered (as a minimum) by TCS

This Solaris host will
run the TCS slave
process

B Y=VWK5IJN[n1: >�
�QTCJQ{we�pw bjd
f;hi`1MOY�@�Gj^�N�rxN$FJh,SW��N3QTSWD;U5VAK1IiX�GJY=SWD



<�9 ���"'�� ����� � ��� �!�"
#�%$&��� ����$ �#�)��'"�(' 
 �!� �	��


�\m�� s^tvujw[xOzc{ |htIw ~ ��tIwyxT� � �$| xTu��Ltvp}w�lv| o�pcr rf�)w[| s^t �
ujw[xOzc{ |htIw

^a`1N>W@1B YxD.FoGLIJK1MON�DAGeIJN5~AK5YxILN�FpX#Gjr=N�XWFHGjSAD1N[YxD.FoGLIJK1MON�DAG\hlSADAGLIJSArxr=N,Iph,SWD;U.VWK1ILN�@ :awjF
@;N$FJh,IJY���N�@YxDyf�N$h GJY=SWD*9;:=< "A>W@1B hlSWD1U5VWK1IiX�GLYxSAD3Y�F�N,DPGJN�IJN$@ ���[GL`1N�S �.FHN�I/�AN,I�YxDGJ`5Np>W@1BY=D5FHGJILK1MON,DPGehlSADPGJILSWr ��Y=D5@;S �[:�^a`1Y�FpY�FjXA@1@;N�@7GLS7QTCJQ{wj�jw�K5FJYxD5VyXyhlSAM �1Y=D5X�GLYxSAD S#k
GL`1N ]��%���0���! A"=���LPO(J���0�/(�3 " F����7"�]=�����0���! A"$�%� X#D.@ ]=���������! #"$�%� h,SWD;U5VAK1IiX�GJY=SWDZGLX �1rxN$F,:z{�OXW@1@;Y=D1V�X#D*Y=D5FoGLIJK5M�N�DPG{hlSADPGJILSWr�QTCJQ{we�pw���Y=r=r���D1S ��GJS�XW@1@*XhlSADAGLIJSArxr=Y=D1V[MON,D�K
YxGJN�M GJS GJ`1N M*X#Y=D S �5FHN�I/��Y=D1V %\bjC "pX#r=rxS ��Y=D1V�GL`1N K.FHN�I�GLS Y=DPGJN�IHk%XAhlN�GLS�GL`1N >W@1B
h,SWD;U5VAK1IiX�GJY=SWD��1r=K1V#t4YxD�:�B"Y=VWK1ILN�F�n5:]�XWD5@�n5: �OFJ`1S � GL`1N[ILNF~PK1Y=IJN$@)FJNlGHGLYxD5VAFakvSAIp>W@1B{:

Select the SITE instrument control
type

Select the AAO 6dF instrument
name

This is the host that will run the
instrument control slave process.
Not required for the 6dF

B Y=VWK5IJN[n1:��H
�QTCJQ{we�pw >W@1B�f�NlGJGJY=D1VAFpCED5FoGLIJK5M�N�DPGjQTSADPGJILSWr QTSWD1U5VWK1IiX�GLYxSAD

�\m�� k |h{ �_|hxT��wyzvxT| r |htvu[�@x k�� �_|hu
^a`1N\>W@5B @1N �aX#I{`5XWF�G �TS3GJN�M���N,IiX�GLK1ILNeFJN,D5FJSWIiF,: �eD1NeY=FTkvSWI{MON�XAFHK1ILY=D1V[GJ`5NjGLN,MO�.N�IHt
X#GJK1ILN�S#k�GJ`5N�kvS;h,X#r=�1r�X#D1NeX#D5@�GL`1NpS#GL`1N,IskvSWIsGL`1Njh,SWDPGJILSWr1N�rxN$h GLIJSAD1Y=h�F,:"^a`1Y�F�hlSAD;U5VAK1ILX#t
GLYxSAD*GLX �1rxNRX#r=rxS �pFaQTCJQ{wj�pw GJSK1D5@;N�ILFHGLXWD5@*`1S ��GJ`5NjGLN,MO�.N�ILX#GJK1ILNeFJN,D.FHSAILF SA�.N�ILX#GJNA:
f�N�N[B Y=VWK5IJN[n1: �1:



� � � � ��� � ��� �('(� ���(� � � �����!� ���w� � � <�n

This is the file that stores the currently
selected configuration

FITS headers are written to
this file when the observer
clicks the "Record" button

This SITE instrument has no slave
control process - no need to enter
anything here

B"Y=VWK1ILN[n1: ��
�QTCJQ{wj�jw >W@1B�f�Y�GLN[CED5FHGJILK1MON,DPGRQTSWD;U.VWK1IiX�GLYxSAD

B"YxVAK1IJN[n5: �%
sQTCJQ{we�pw >W@5B�Q�Q{��^ N,MO��N,IiX�GJK5IJNcf�N�D5FHSAI
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#%$  &�'�)(�* $,+)-/. �� "

#%$  &�'�)(�0	132�45�6 "

798 ��� . �/: -�; � $ �)�<13�=:>���)���!�6?@� A

BDC  $ � +FEG$IH �64 $ ��� J
�LK `NM	OQPRP'SUT�VXW/YZT\[^]�_3`aYbOQT\c KdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK f

�LK ` K ` M	gaMih�jkhmlnOLVL[ KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK f
�LKo� p�q Ysrutwv6`uSUxa`�y q YbV3[ KeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK z
�LK {}| YZ~b[!c�SUT\V����3[!YZxkW/O�r!S�`�YZO�T\c KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
�LK � MiSU~bYb�3x�SU`aYbOQTXg�P'SU�Q[�c KeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �

�LK �\K ` �%xa[!_\SUx�YZT\�'MiSQ~ZYb�3xuS�`aYbOQTwg�P'SU�Q[�c KeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
�LKof ��x�OLr�[�cacaYZT\�Rv6`�[&_\c KGKeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
�LK z g�T3_ q `�j�SU`�S KeKGKeKGKeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��
�LK�� ��x�OLr�[�cacaYZT\����SQx�SQP�[&`a[!x�c KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��
�LK �}� caYbT3�R`a�3[Gg�P'SQ�Q[�M	�3O�O�ca[&x KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��
�LK � M	OQT6`�xaO�~Z~bYZT\�R�%xaOLr&[!c�c�YbT3� KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��

�LK �3K ` v6`uSUxa`���Yb_�[!~ZYbT3[G� q T\T3YZT\� KeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3Ko� v6`�OQ_ KeKGKeKGKeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3K { � q TnvLYZT3��~Z[ | Yb~Z[ KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3K � � q TnvLYZT3��~Z[�v�`a[&_ KdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3Kof � T\VLO���x�OLr�[�cacaYZT\�^�IOQxkW=SQc�` | YZ~b[ KeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3K z vLS���[�M q xax�[&T6`���x�OQ��xa[�cac KGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
�LK �3K�� ��[�c�[&`�`�YZT3� � T\c�S��Q[!V��IOQxkS'��[�c�`uSUxa` KeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
�LK �3K � ��[�c�[&`�`�YZT3��h�~Z~��IOQxkSR��[!c�`�SQx�` KGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �

�LK `!��lnO�T3Y�`�OQx�YZT\�R�%xaOLr&[!c�c�YbT3� KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
�LK ` `�M	OQT3�\� q xuS�`�YZO�TXSQT\V�v�[�`a`aYbT3��c KeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �

�LK ` ` K ` M	O�TL�\� q x�SU`aYbOQT KGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
�LK ` ` K ��� c�YbT3��¡kO�TL¢�W�Yb�3x�SQxa£¤M	O�TL�\� q x�SU`aYbOQT | Yb~Z[�c KGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
�LK ` ` K {¥� c�[!x�v�[�`a`aYbT3��c KGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
�LK ` ` K �¦| OQT6`�c�SQT\V§M	OQ~bO q xuc KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
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fLKo� g��kh | M	~sSQc�c KeKGKeKGKeKGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` �
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��Ko� ��x�[&_�SUxuS�`aYbOQTwOU��r&SU~bYb�3x�SU`aYbOQTXYZP'SQ�Q[!c KGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK¨���
��K { g�PR_3~b[&PR[&T6`�r&OQP��\YZT3[d�IO�x�_3xa[!_\SUx�YbT3��r!SU~bYZ�\x�SU`aYbOQT¤YbP'SU��[!c KeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK¨�Q{
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` °kO,+ ��Yb_)[&~bYZT3[d�3`uc�YbT�`�O�`a�3[G��[&T3[!x�SQ~�caru�3[!PR[ KGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
� ��Yb_)[&~bYZT3[�y � g�-<YbT\VLO,+ KGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK z
{ ��Yb_)[&~bYZT3[^�%xa[&�I[&x�[&T\r&[!c�-<YbT\VLO,+ KGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
� W�OLr!S�`aYbOQT�c�OU����Yb_�[!~ZYbT3[d�\~b[!c KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
f ] q `�~ZYbT3[GOU��_3x�OLr�[!c�caYZT3�Rc�`a[&_�c KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
z ��OQ_ q _.+�YbT\VLO,+>�IOQxkca[�`a`aYbT3��V3S�`uS�_\S�`��\ckSUT�V¤_\SQx�SQPR[�`a[!x�c KeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��
� ��OQ_ q _.+�YbT\VLO,+>�IOQx�[�VLY�`�YZT\�'_3xaOLr&[!c�c�YbT3��_\SUxuSUPR[�`�[&xuc KeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `��
� ��OQ_ q _.+�YbT\VLO,+>�IOQxkca[&~b[!r�`aYbT3�'YZP'SQ�Q[!ciO�x��\~Z[�c KGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK `,`
� ��OQ_ q _.+�YbT\VLO,+>�IOQxkca[&~b[!r�`aYbT3��r�O�TL�\� q x�SU`aYbOQTwV3YZx�[!r�`aOQx�Yb[!c KeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` z
`!� ��Yb_)[&~bYZT3[^SQx�ru�\Y�`�[!r ` q x�[ KGKGKdKGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK¨� �
` ` g��kh | r&~bS�caciYbT3�3[&x�YZ`�SUT�r�[^c�`ax q r ` q xa[ KGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK¨� �
` � W�OLr!S�`aYbOQTXOU����Yb_)[&~bYZT3[^r&OLVL[eYZTX`a�\[^l v3v3v\] M��dvw`�xa[![ KGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK¨���
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` v q PRP'SUx�£¤OQ��r&OQPRP'SUT\Vw~ZYbT3[GO�_L`aYbOQT\ci�IO�xk��Yb_�[!~ZYbT3[ KGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK f
� j�[!c�r�x�YZ_L`�YZO�T�OU�/��~Z[�c q ca[!VXSUT\V�r�x�[!SU`a[�V¤��£¤�%YZ_)[&~bYZT\[ K KeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
{ v q PRP'SUx�£¤OQ�=_3x�OLr�[�cacaYZT\��c�`a[!_\c KGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK �
� hkTn[&¯3SUPR_3~b[er&OQTL��� q xuS�`�YZO�T��\~b[d�IOQx��%YZ_)[&~bYZT\[ KiKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` {
f hkTn[&¯3SUPR_3~b[e�%YZ_)[&~bYbT3[Gr�OQT3�\� q xuS�`�YZO�T��\~b[e�IOQxkc�`�SQx�`�YZT\��g���h |iK¦KGKGKeKGKdKGKeKGKGKeKGKeKGK ` {
z hkTn[&¯3SUPR_3~b[e�%YZ_)[&~bYbT3[Gr�OQT3�\� q xuS�`�YZO�T��\~b[7+�YZ`a��g��kh | `�S�c�tw_\SUxuSUPR[�`�[&xuc K�KGKeKGKGKeKGKeKGK ` �
� hkTn[&¯3SUPR_3~b[ K _3Yb_�[!~ZYbT3[!x�rd�\~b[ KGKeKGKeKGKGKeKGKeKGKdKGKGKeKGKeKGKeKGKGKeKGKdKGKeKGKGKeKGKeKGK ` f
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���3YscGP'SUT q SQ~�VL[!c�r�x�YZ�)[!cG`a�3[�O�_�[!x�SU`aYbOQT OU��SX_3YZ_)[&~bYbT3['`aO�O�~��IOQx�S q `aO�P'S�`a[�V r!SU~bYZ�\x�SU`aYbOQT OU��YZP'SU��[�V3S�`uS
SUT�V S�r&r�O�PR_\SUT3Yb[!c�`��3['xa[!~Z[�SQca[�` K �XOQ�i��Yb_)[&~bYZT3[ K ���3['SUYbP OU�i`a�\YbcG_\YZ_)[&~bYZT\[R`aO�OQ~�Yscd`aOn_3x�O���YbV3[�SXPROQx�[
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�)[ q c�[�Vw�IOQx�OU`��3[&x�PR[�SQc q xa[!PR[&T6`i_ q xa_)O�ca[!c K
���3Yscd_3YZ_)[&~bYbT3[�`aO�OQ~��7+�SQcdO�xaYb�QYbT\SU~b~b£XVL[!�Q[!~ZO�_�[�Vn�IOQxd`��3[(-<YsVL[ | YZ[!~bV g�P'SU��[&x�� - | g������)[&YbT3�nVL[&��[&~bOQ_)[!V
��OQYbT6`a~b£G��£el v3v3v\]���h�h�]<SUT\V^`a�3[ � T3Yb�Q[!x�caYZ`�£dOQ��ln[!~Z�)O q x�T3[���� q `�Y�`�r&SQT��)[ q ca[!V^`aOd_3x�O�r&[!c�c�OQ`a�3[!x�M�Mij
YbPRSQ�Q[kV3SU`�S K g `%��SQc��)[&[!T�VL[&��[&~bOQ_)[!V�YZT'SG��[&T3[!x�SQ~LP'SUT3T3[!x%caO�`��\S�`	OU`a�\[&x�_3x�OLr�[�cacaYZT\��`uSQcatLc�r�O�T�`uSUYbT3[!V�YbT
g��kh |�� r&SUTR�)[kSQV3V3[!V K ]�T3[�PRYb�Q�6`�[&T���Ybc�SU��[iS�V3VLYbT3�e�,SQr&YZ~bYZ`aYb[!c��IO�x%r&SQ~ZYb�3xuS�`aYbOQT�_3x�OLr�[!c�caYZT3�dOU�R`�j c�_)[!r�`axuS
�IOQxR[&¯LSQPR_3~Z[ K -<�\YZ~b[�Y�`��\S�c���[![&T VL[&��[&~bOQ_)[!V `aO x q T�YbT�r&OQT�� q T�r `aYbOQT +�YZ`a�>M	gaMih�jkh � M	OQTL�\� q xuSU�3~b[
g�T\c�`ax q PR[&T6`RM	O�T�`�xaO�~%SUT�V j�SU`�Snh�r�� q YbcaYZ`aYbOQT!�"��caOU� ` +�SUx�[�VL[!�Q[&~bOQ_)[!VFSU`�l v3v3v�]��/YZ`�P'S�£ SQ~bcaOn��[ q c�[�V
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* r�Ysr&SQV\S + � q TXYbTnr�Ysr&S�V3S�P�OLVL[
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| Yb� q x�[ � %��%YZ_)[&~bYZT\[�y � g�-<YZT\V3O,+
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SU_3_)[!SQx	¢ | Yb� q xa[ {
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Developer Notes

Developing and maintaining a system such as cicada is not easy. A stable maintainable version is required for
production use. Developers need the freedom to work on new features. These two requirements are not
compatible. To help make this problem easier to deal with please read the following guidelines and try to
follow them. Additional background information can be found in the rationale.

Tagging

Every release of cicada that is installed at a telescope will be tagged.
Tags look like this: Rel-4-2-1, where the first digit indicates the major release number of cicada, the
second digit indicates the minor release number, and the third digit indicates the bugfix release number.
Minor release numbers that are even indicate that this release is considered stable. Minor release
numbers that are odd indicate that this release is considered unstable.
Unstable versions of cicada should never be installed at a telescope except for testing purposes.
Unstable versions of cicada will periodically be tagged when they reach a point that is considered
meaningful in some way. Examples of this include the addition of major new functionality, or the
rearchitecture of some part of the system.

Bug fixing

Before working on a bugfix you should consult the versions web page to determine which tagged stable
release your fix will apply to. The web page will show which version of cicada is installed for which
instruments on which telescopes.
Check out the tagged version appropriate to the bugfix you need to make.
Anything that is not a bugfix does not belong on a stable branch. You will most likely know whether
what you have done counts as a bug fix or whether it is something more complicated. If in doubt, check
with the configuration manager.
Before any fixes you have made can be committed you must thoroughly test cicada, using the testing 
checklist.
Bugfixes to a stable version of cicada can only be checked in on a branch. Branch tags look like this:
Rel-4-2-1-branch. If the stable version you are working on does not already have a branch then see the
configuration manager.
You must include a meaningful log message when you commit your changes.
The configuration manager is responsible for building a new cicada package, installing it at the
appropriate telescope, and merging your bugfixes back into the main trunk (if appropriate). See their 
web page if you want to know what they will do, or if they’re not around and you need to do it
yourself.

Feature addition

Feature additions do not belong on a stable branch.
Feature additions only belong on the main trunk.
I think you get the idea.

Code portability

The code you write should be as portable as possible. Keep in mind that not only will the code be run
on Solaris machines, but potentially also on VxWorks, QNX, and Linux machines in the future. #ifdefs
will be (and are) used where appropriate. Before changing any code that is inside an #ifdef block, be
sure you know what you are doing and how it will affect each of the platforms involved.
If there are good reasons to include OS specific code in a module then by all means use it (but delimit
it by #ifdefs). For example we gain performance improvements on the UltraSPARC architecture by
using the VIS instruction set, and we use the mmap system call on Solaris because it’s incredibly
handy.
Your code may run on both big and little endian machines.
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Configuration Manager

The configuration manager is responsible for looking after the cicada source tree, and making sure that it is
always possible to build a stable working version of cicada for each of the instruments and telescopes it
supports. Their tasks are as follows.

Tagging, Branching, and Merging

Every stable release of cicada must be tagged with a unique tag of the form: Rel-4.2.1.
If a bugfix must be applied to a stable release then the source tree branches at that point with a branch
tag of the form: Rel-4.2.1-branch.
Subsequent stable releases do not need to be branches.
Bugfixes must be merged back into the main trunk whenever this is possible.
Unstable versions of cicada should be tagged when a major new feature is added, when a rearchitecture
of any part of the system takes place, before a new port is undertaken, and probably at some other
points when it feels right to do so.
The source tree should never branch at an unstable release.

Installing cicada at a telescope

Before cicada can be installed at a telescope there are a number of things to be done:

The version of cicada to be installed must be stable. The only exception to this is if it will only be used
for testing purposes, in which case the previous stable version must be reinstalled before the next
observer is due to use the telescope (probably that night).
A version of cicada is only considered stable if it passes all the automated tests and all the tests on the 
testing checklist.
The version number in cicada_version.h must match the tag, and these must be unique so that there can
be no doubt about which bugs and bugfixes are in the currently installed version.
The cicada_knownbugs and cicada_whatsnew files must be updated to indicate what has changed since
the last release.
The OPTFLAGS variable in all the appropriate makefiles must include optimisation flags and not
debugging flags.
The package built must include a working cicada_ximtool for that platform (only sparc and ultra at this
stage).
The versions page must be kept up to date.
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Testing Checklist

The following is a checklist of those things that must be tested before a release of cicada can be given a stable
version number. After any changes to a stable version it must pass these tests again before being installed at a
telescope. Most of these tests have been incorporated into a Tcl script. This belongs in the cicada tree but it
hasn’t been put there yet.

start cicada without errors
initialise the controller
close the shutter
open the shutter
perform a flush
perform a readout
read temperatures
do 20 consecutive exposures of the whole detector
for each controller:

do 20 consecutive exposures of a single CCD
do 20 consecutive exposures of a region within a single CCD
do 20 consecutive exposures of a region that spans multiple CCDs
do 20 exposures that alternative between regions on different CCDs

do 20 exposures that alternative between regions on different controllers
do 20 exposures of a region that spans CCDs on multiple controllers
with a region that has dimensions that are odd in both x and y:

do 20 exposures using binning that is not 1x1
do 20 exposures using x overscan that is not 0
do 20 exposures using y overscan that is not 0
do 20 exposures using x and y overscan that are not both 0
do 20 exposures using x and y overscan that are not both 0, with binning that is not 1x1

pause and resume an exposure
pause and resume multiple times during a single exposure
pause and resume multiple times during a single exposure, changing the exposure time
pause then readout an exposure
pause then abort an exposure
abort an exposure
abort an exposure then successfully take a new exposure
verify that FITS headers are correct
verify that FITS files can be read into IRAF
get the filter position using the appropriate filter plugin
set the filter position using the appropriate filter plugin
get telescope information using the appropriate telescope plugin
send telescope commands using the appropriate telescope plugin
test any site control plugins
check that no cicada processes have memory leaks

The tests should be performed with a configuration as close to the actual production configuration as
possible. In particular consider:

Testing with a dummy controller is not the same as testing with real hardware
Remember that cicada usually runs in a multi-machine configuration at the telescopes. Testing on a
single machine does not exercise the RPC services fully.
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Versions

Telescope Instrument Version Date
installed

Bugs
reported Comments

40" WFI 4.0.10 April 2004 WFI bugs None

2.3m

DBS Blue 5.1.10 May 2005 2.3m bugs None

DBS Red 2.0.10 Unknown 2.3m bugs None

Imager 5.1.10 May 2005 2.3m bugs None

UK-Schmidt 6dF 4.0.12 June 2004 6dF bugs None

AAT WFI 4.0.12 June 2004 WFI bugs None

UTas UTas
camera 4.0.13 July 2004 None

A new filter plugin was
developed for the UTas filter 
controller. No reports have yet
been received as to how well it 
works.
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WFI - Wide Field Imager
The Wide Field Imager will provide a focal plane CCD detector system with a size of
123 by 123 mm, 8192 by 8192 pixels, made up of a 4 x 2 array of 2048 x 4096 pixel
thinned, back-illuminated CCDs, to be used on both the Anglo Australian and ANU
40inch Telescopes. The output of the system is pixel data in the form of
multi-extension FITS files written on an archiving medium which is part of the system,
and/or transported to a device of the user’s choice over a Local Area Network, or fed
into an automated archiving and reduction pipeline where available.

Top and side-on views of the WFI dewar showing the eight CCDs in place

At the centre of the system is a 123 x 123 mm focal plane mosaic of eight three side
buttable 2048 x 4096 15 micron pixel CCDs which AAO and MSSSO are procuring
as a result of a being partners in a consortium of astronomical institutions funding
development of such devices at Lincoln Labs in the USA.

The focal plane will be housed in an evacuated vessel (the "dewar") and will be
cooled to about 170 K by the use of liquid nitrogen refrigeration.

The dewar fits onto exposure controllers located on the AAT Prime Focus and the
40" Cassegrain Focus, each comprising a filterwheel with at least four positions,
shutter and their control electronics frames. The AAT exposure controller will also
accommodate their existing acquisition and guide cameras.

Autoguiding at the 40" will be accomplished by the use of one of eight small guide
CCDs located on the focal plane next to the scientific detectors. They are connected
to (preferably) a commercial CCD controller (SBIG ST4 or similar/better) and a PC
which interfaces to the Telescope Control System. Alternatively, the guiding facility
which will have to be incorporated in the exposure controller for the tiptilt system can
be used. This can probe inside the camera field, shadowing it. If such a system is
compatible with the existing AAT autoguider, it may be used there as well.

Two San Diego State University second generation CCD controllers will be mounted
on the dewar to read out the CCDs and transfer the data over fibre optic links to the
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data acquisition computer system.

The control and data acquisition computer system will consist of two Sun
workstations with enough capacity to efficiently handle the data stream from the CCD
controller for display, storage and archiving, plus data reduction. The use of two
computers will allow the time-critical control of CCD readout to be separated from the
user interface and data reduction computer. It will also allow user interface and data
reduction computers to be set up permanently at both telescopes, optimally
configured for each organisation’s data pipelining procedures. The control and data
handling software will be the MSSSO CICADA package, suitably adapted to deal
with reading out CCD mosaics through the SDSU controller.

Partners

The following organisations are involved in the WFI project:
MSSSO: MSSSO will provide the overall project management, CCD expertise, four 
2048 x 4096 CCD chips and the MSSSO’s workshop infrastructure.
AAO: the Anglo Australian Observatory will provide 4 of the 8 CCDs. University of 
Melbourne: The astrophysics group will develop the scientific requirements for the 
Project.
Auspace Ltd: Auspace will provide project management, quality assurance and 
mechanical design to the project.

Contractors

The following are the major contractors that will help in the WFI project:
GL Scientific: Building the focal plane, assembly of instrument and testing.
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WFI, the Wide Field Imager for the ANU 1m and 
the AAT.

The Wide Field Imager (WFI) is CCD mosiac camera being fabricated by the Research School of Astronomy
& Astrophysics, ANU, for use on both the ANU 1m telescope and on the AAT prime focus at Siding Spring
Observatory. 
 

Construction

WFI will use 8 4k x 2k 3-side buttable CCDs arranged in a 2 x 4 mosaic to give a total format of 8k x
8k pixels. The CCDs in WFI will come from the MIT-LL consortium lot runs in which the RSAA and
the AAO are joint participants. Each institution will contribute 4 CCDs to WFI.
The AAO is engaged in upgrading the prime focus to accommodate WFI while the RSAA has designed
(in collaboration with Auspace and the University of Melbourne) and manufactured the WFI dewar.
The RSAA is also providing the CCD Controllers (dual 4 channel SDSU V2 controllers), controller 
software, user interface and data pipeline processing software, as well as commissioning the
instrument.
The focal plane mosaic is being assembled by Dr. Gerry Luppino in Hawaii.
The goal is to be able to read out the full WFI array in under 60 sec; recent tests at the RSAA
demonstrated that this goal is likely to be met - a full 4k x 2k readout through a single channel took
under 50 sec with 5 electron read noise. WFI will have one channel per CCD.

 WFI on the ANU 1m telescope at Siding Spring Observatory

The CCDs have 15 micron pixels which will give a scale of 0.38"/pix at the 1m telescope Cass focus
with a field-of-view of 52 arcmin on a side (diagonal ~1.2 deg). Available filters will be standard
UBVRI plus a far-red z filter. Any 5 can be held in the wheel at the same time.
Gary Da Costa (gdc@mso.anu.edu.au), is the RSAA astronomer who acts as WFI Project Scientist.

 WFI at the AAT

WFI will be a stand-alone instrument at the AAT.
The scale at the AAT prime focus will be 0.23"/pix with a field-of-view of 31 arcmin on a side
(diagonal ~0.75 deg). Filters available will be standard UBVRI.
Chris Tinney (cgt@aaoepp.aao.gov.au), is the AAO astronomer responsible for WFI on the AAT and
the AAT prime focus upgrade.
For more information see the WFI/PFU WWW Page.

Current Status

The WFI dewar and the controllers are in Hawaii awaiting sufficient CCDs to complete the focal plane
mosaic, after which the first part of the integrate and test phase will be carried out. The complete instrument
will then be shipped back to Australia and commissioning on the ANU 1m telescope will follow.
Commissioning on the AAT will occur once the prime focus upgrade is complete and WFI is successfully 
operating on the ANU 1m.

Gary Da Costa, WFI Project Scientist, RSAA (gdc@mso.anu.edu.au) 
Last Update 9 July 1999 
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                              WFI on MSSSO 40" Notes
                              ====================
                                   June 2001

As a first-time observer at the 40 inch I found there was virtually no useful
documentation, ie troubleshooting notes. However, with just a few simple
fixes, and some minor changes to the way I used CICADA, I could have saved
about three lost nights. I hope this saves you similar trouble.
Although I did have first-night training and excellent help from technical
support that doesn’t cover a problem that crops up after midnight later
in the run!

These should be properly html’ised but I don’t have time.
At present they are at
http://www.physics.usyd.edu.au/~ande/astronomy/WFI_40inch.html

These notes have grown out of notes written by Terry Bridges
(his file was /data/murky3/tjb/transit/WFI_notes but I can’t find it now as
murky3 has gone) and the collective experience of myself, Bob & John
Shobbrook, John Goodyear, Winston Campbell, Gary Da Costa, Malcolm Harris
and others.

Things change: new problems appear, old ones get fixed, new fixes are 
discovered. So feel free to copy, edit, improve, correct, add to, embelish,
simplify or whatever these notes.

Clear Skies!
Andrew Jacob

*****************************************************************************

CONTENTS
========
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  B "40 Inch Telescope Observer’s Technical Guide"
  C http://www.mso.anu.edu.au/observing/40in/DirectIm/40in/
  D http://msowww.anu.edu.au/computing/cicada/cicada/
  E And the WFI web pages
  F Other Hardcopy Manuals in the Control Room
  G http://msowww.anu.edu.au/observing/tc_manual/
  H Additional Notes for Shobbrooks manual
3/ GENERAL INFORMATION
  BASIC DATA
  CICADA, GIT & Ximtool
    General
    GIT (Graphic & Imaging Tool)
    Ximtool
    Screen Preferences for GIT and Ximtool
    Other
  COMPUTERS
  FOCUSING
  OTHER
  CCD GUIDER SYSTEM
    GSFIND
    Procedure
    Restarting Guider PC
  TELESCOPE & DOME
    Telescope
    SDSU Cooling
  CAMERA SHUTTER
    Priming the shutter
    Shutter Priming Delay
  IRAF
3/ TROUBLESHOOTING
  In the control Room
  In the Dome

***************************************************************************

1/ BEFORE YOUR RUN...
Before your run I recommend you read:-
  a) The "40-Inch & WFI DIY Manual".
       [hardcopy only: email sbrook@mso.anu.edu.au]
  b) http://www.mso.anu.edu.au/observing/40in/DirectIm/40in/
  c) http://msowww.anu.edu.au/computing/cicada/cicada/
  d) These notes
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***************************************************************************

2/ SOURCES OF INFORMATION
There are many sources of information, some more useful than others (from
an observers point-of-view). Not all of it is on the web.

A) The "40-Inch & WFI DIY Manual"
Contents self-explanatory.  Essential reading for first-time observers
using WFI at the 40inch.
Get your hands on a copy of this. Written by John & Bob Shobbrook.
This manual is not on the web. Would someone please put it there?
Email John at  sbrook@mso.anu.edu.au for a copy.

  This manual has sections:
      Running CICADA
      Telescope Setup
      Filling the Dewars
      Bias Frames
      Flat Fields
      Dark Frames
      Pointing The Telescope - Calibrating the Pointing
      Focusing the Telescope
      Autoguiding
      Data taking
      Data Archiving
      Shutdown
      Accessingthe MSSSO Online Comment File
      Autoguider Settings
      Initialising CCD Hardware
      Shutter Priming
      WFI - General

B) "40 Inch Telescope Observer’s Technical Guide"
A new (June 2001) compendium of useful information and fixes.
More essential reading. You are encouraged to add to this guide to asssist
future observers.
Located on the control room bookshelf.

C) http://www.mso.anu.edu.au/observing/40in/DirectIm/40in/
This contains some basic 40" observing info. In particular, a list of what
to check when you arrive at the telescope.

D) http://msowww.anu.edu.au/computing/cicada/cicada/
The online Cicada User’s Manual

E) And the WFI web pages:
MSSSO:  http://msowww.anu.edu.au/observing/wfi/index.shtml
AAO  :  http://www.aao.gov.au/local/www/cgt/wfi/wfi_pfu.html
 The AAO page contains QE curves or the CCDs.

F) Other Hardcopy Manuals in the Control Room
"CICADA User’s Manual" - white folder on 40" control-room bookshelf
  Probably the same as the Cicada web pages, but best to use D above.
"40 inch Telescope ETS - A Short Users Manual" - located as above.
  A useful guide to operating the ETS.
  Only exists in hardcopy.
"A Short User’s Guide to the 40-Inch and its CCD Camera System"
  An old manual. Not entirely relevant to WFI but still useful in parts.
  Now contained in the "40 Inch Telescope Observer’s Technical Guide" folder

G) http://msowww.anu.edu.au/observing/tc_manual/
 An online "Telescope Command Reference Manual". More technical than the
 average user needs. Use the "40 inch Telescope ETS - A Short Users Manual"
 instead (see F).

H) Additional Notes for Shobbrooks manual
Some additional or alternative notes to add to the Shobbrook manual.
Running CICADA:
  -See additioinal notes below
Filling the dewars:
  -Press the big red STOP button on the dome console to prevent
   errant telescope movement.
  -Remove (or replace) the lens-cap BEFORE filling the dewar to avoid (minor)
   LN2 spillage from the camera dewar.
  -Need a step by step procedure for pressurising the small LN2 tank??
  -Need a step by step procedure for refilling small LN2 tank from large 
   LN2 tank??
Flat fields:
  Dome flats
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  -Do these BEFORE filling the dewar to prevent major LN2 spillage.
  -Dome at azimuth=~70deg. Telescope at ZD~=-70deg gets flat screen in place.
  -Use dome lights (tungstens only!) or preferably sunlight by slightly
   opening the upper shutter.
  -Dome flats are not good. Use twilight and dark sky flats. [Terry Bridges]
Focusing the Telescope
  -See additional notes below
Autoguiding
  -If the autoguider PC has to be restarted:
    -When asked for a password, just click "cancel".
    -After windows starts open "vncviewer for WFI guider" icon.
     The "VNC server" is m40slave:0 . Password is in the back of the
     40" CCD Temp Log Book. You will need to scroll down the "Maxim Dl"
     window to access the "Guide CCDs - WFI" chooser.
Data archiving
  -the DDS3 DAT drive is now on monsoon (since Nov 2000).
  -mt rewoffl  rewinds and ejects the tape
  -How to skip over a tape file if you want to read or extract the 
   second, etc file??
Shutdown
  -Press the big red STOP button when not using the telescope to prevent
   errant telescope movement.
Initialising CCD Hardware
  -this should be done as a last resort, though there is some disagreement
   on this!
Shutter priming
  -See additional notes below

****************************************************************************

3/ GENERAL INFORMATION

Some useful information, most of which doesn’t seem to appear anywhere else.

BASIC DATA
==========
WFI chips:
Eight 2k x 4k (2048x4096) CCDs in a 2x4 mosaic.
Each sees 13’x26’ (arcmin) making a 52’x52’ field.
Pixels are 15micron giving 0.375"/pix (on the 40in at f/8)
Gaps between CCDs are ~20-30arcsec.
Gains are ~1.5-2.1 electron/ADU
RONs  are ~3.5-5.5 electrons 
 (To get Gain & RON follow procedure in  "40 Inch Telescope Observer’s
  Technical Guide")
The awesome SDSU controllers read out the entire array in 55 seconds!!

A full array image is 140Mb in size.
One CCD is 17.5Mb
The /data/monsoon1 disc on Monsoon holds almost 100Gb - About 4-8 days data.
A DDS3 125m tape holds fractionally over 18Gb compressed
 (ie using allocate mt1)
Writing to tape takes ~11.5min/Gb (~3.5hrs per full tape). So don’t get
caught out on your last night, save early!

See also the AAO and MSSSO WFI pages.

CICADA, GIT & Ximtool
=====================
General
-------
Strategies to deal with CICADA.

Cicada has a tendency to hang, usually during readout, and sometimes
for no obvious reason (even if you are doing none of the bad things listed
below).

The only remedy is to restart it. To do this:
 - In the Observers Window menu select actions|quit_observing_window
 - In the CICADA menu select Start_Observing|Exit_CICADA 
 - From the command line do:
   - psef |grep cicada
   - Look for cicada processes. Ignore *_svc. Kill others with
     cicada_cleanup -p 0
     cicada_cleanup -p 1
     cicada_cleanup -p 2
     cicada_cleanup -p 3
   - Restart using "cicada &"
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In general restarting solves Cicada problems, but it’s a pain so...

Follow these next practices for relatively trouble-free operation:-

 Pause - DON’T use ’pause’. This crashes cicada so badly you need to logout
         to restart! (apparently, but I never dared try it) 
 NumLock - Keep NumLock untoggled. It interferes with ximtool (and GIT?)
          operation. In particular, it prevents you using right-mouse
          scrolling to change brightness/contrast, and inactivates the
          ximtool menus. 
 Initialise Hardware - advice is to use this as a last resort. (Doesn’t
          appear to cause any trouble tho, despite comments to the contrary)

 Avoid:
  -Using ABORT. You’ll often then need to exit cicada and restart.
  -doing too much (processor or memory intensive stuff) on monsoon during
   readout. In particular avoid:
    -Beginning or ending a tar command during readout (during exposing is OK)
    -Doing much in Netscape (on-line banking is bad!)
    -Copying images (and other operations) in iraf
 Could do these things from murky but its way slower.
 (For 6 CCDs (104Mb image) the limit might be ~400Mb (as shown on the
  Observers window at "Memory:???MB"))
  -leaving the little "graphics keystrokes" window open during readout
  -changing regions (in regions window) during readout [This may not be true?]

During readout you CAN do these:
 -change filter, change exposures, change duration

GIT (Graphic & Imaging Tool)
----------------------------
GIT (presently) has a problem with displaying mosaiced images. It displays
them OK on readout but it cannot set sensible scaling parameters to allow
you to calculate star profiles, get single line plots, etc. The ximtool
window just goes all black or white and displays a single value.

To overcome this limitation do the following:
-untoggle NumLock
-select options|start_private_ximtool
-select options|preferences :
  -select category "General"
  -untoggle "Mosaic MEF files in Cicada mode"
  -enter the "MEF extension list", ie a list of which CCDs you want available
   for loading into the private ximtool.
   Note that if you are only using CCD numbers 1,2,7,8 (say) their MEF image
   extension numbers will be 1,2,3,4. ie CCD number and extension number are
   different things.
  -set "Maximum Cicada images" if necessary
-The list of extensions you have requested will appear in the "image list"
 window. Click one and it loads into the private ximtool.

Now you can get star profiles, cross sections, stats, etc. But when the next
image is read out it will automatically be loaded into the private ximtool.

But avoid leaving the little "graphics keystrokes" window open during readout
or GIT will crash out.

Ximtool
-------
North is right, East down.
1 pixel = 0.375arcsec

To move a star  N dec offset on ETS is -ve
To     "        S dec        "         +ve
To     "        W RA         "         +ve
To     "        E RA         "         -ve
 (This is better seen with a diagram)

Astigmatism leads to elliptical star images when defocused (see Focusing
below)

Screen Preferences for GIT and Ximtool
--------------------------------------
Select the monitor for these in options|preferences|general
Common practice puts GIT and Ximtool on screen 1.

Other
-----
Binning
If you change the binning, it may not change back again when you reset
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it to 1 x 1, even though the regions window shows it as 1 x 1.
Watch the file sizes: should be 271440 blocks (full 8xCCDs?)

Bleeding
If readout shows bleeding on brighter stars on some CCDs and bias changes,
restart cicada.

Wrong Frame Size
If there is an error message about ximtool having the wrong frame size,
check that there is not an old cicada ximtool process running:
ps -ef | grep cicada  will show it

Many Red Error Windows
If lots of red error windows appear from cicada, and restarting impossible
or doesn’t work, try logging out (and back in). That can fix it. If the
error messages involve SDSU, then probably need hardware init (from action
menu): if such error message reported when cicada is restarted, may need
two hwinits. Do the hwinit right after restarting cicada.

COMPUTERS
=========
  mosaic  (in rack)   runs controllers
  monsoon (on desk)   does rest - cicada
  murky   (in office) is a bit slow.

Data is stored on monsoon in /data/monsoon1/cicada/username

FOCUSING
========
This is difficult to maintain. There is backlash in the mechanism. And it’s
pretty temperamental. But then just wait till you’re 38 years old!

I found the best method was:

1/ At the beginning of a run (or if focus is lost completely)
    Use Cicada’s semi-automatic routine under actions|do_focus_sequence...
    Follow the prompts and/or read the Cicada manual.
    Move the focus by 0.03-0.05 units between each image, starting at
    about 31.70. When do_focus_sequence is done set the focus position
    with the bottons on the round control paddle

2/ From now on use the telescope’s astigmatism. Star images are elongated:
     NW-SE => focus too high: Press out [display decreases]
     NE-SW =>   "   too low :   "   in  [   "    increases]

3/ Check star profiles too as you go. Out of focus => lots of scatter
   in the profile, of course.

...but then I was only taking short exposures (1-3 mins). Maybe you could
use the autoguider image to maintain focus with long exposures? See also the
Shobbrook manual.

It takes a couple of nights to get the hang of focusing.
Approach a focus position from the same direction to remove backlash. Otherwise
get double and/or smeared images.

Typical focus values range from 31.65 - 31.88

OTHER
=====
Readout speed
 Use fast readout for broadband imaging when there is a choice.

CCD temperature
 This appears on the Cicada observers window
 (from 158-165K for TB). Was ~183.0 for my run.

Filter control
 Select instrument_control|Filter:F_40 to open the filter control
 window. To initialise, hit "get filter position"

Dewar vacuum
 Watch the vacuum gauge - rises about 1E-07 per day.
 Probably OK up to about 1E-04.  LN2 hold time is about 12 hours.
 If much less, dewar needs pumping (can be done cold in daytime).[TB]
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CCD GUIDER SYSTEM
=================
I had no trouble with autoguiding, just used all the settings that were there.
The following are Terry’s notes. [AJ]

To disable completely, turn off the switch near the mains plug boards
on the north side of guider box, low (on telescope)

GSFIND
------
This shows outline of the main and guiding CCDs relative to GSC
stars. Can start from cicada|tools menu or directly from command line.
Then drag to enlarge the window.

Choose monitor from cicada|options|preferences|general. Display on
monitor 0 to see a green outline against a black background.  On
monitor 1 the outline and the sky are black [OK for me on monitor 1, AJ].

Put in the field coordinates and magnitude limits for stars (< 12 for 5 sec 
exposures).

Set position angle = 90.

Move CCD outline with the LMB - gives (RA, dec) coordinates of the detector
center.

Put cursor on star and hit spacebar to see the star highlighted in table.
Also gives (x,y) position of selected star in the focal plane.

Procedure
---------
[needs editing? go ahead...]
-Select a guide star and the guide CCD.
-Set telescope, *open shutter*.
-Now go to the autoguider console.
 VNCviewer is the guider program to choose from desktop. Maxim is the
 autoguider program itself, similar to the one on the DBS.
-Choose "Guide CCDs - WFI" from the menu bar at the bottom of the
 window. Choose which guide CCD you are using: same orientation as in GSFIND.
-In the "Maxim CCD" indow click the guide tab, enter the exposure time and
 declination.
-Take an exposure with guide CCD: Click "expose" then "start".
-Wait for exposure to read out in big window.
-Move the star where you want it in the guide CCD field:
 Use telescope offsets on round "box" to offset telescope;
 North pulls the star *down* on guide window,
 East  pulls the star *right*.
-When star is centered (or where you want it), left-click on it, then
 click on Track, then click Start.
-After it reads out it will create a little box in the upper left-hand
 corner where you should see the star centered (roughly).
-Wait a bit to make sure telescope is tracking OK (no huge jumps in
 star in guide window).
-When telescope tracking ok, close shutter and start the real
 exposure.

**If you don’t see any star in guide window, make sure shutter open!!**

Restarting Guider PC
--------------------
The Autoguider PC will ask for a password, just click "cancel".
 -After windows starts open "vncviewer for WFI guider" icon.
 The "VNC server" is m40slave:0 . Password is in the back of the
 40" CCD Temp Log Book. You will need to scroll down the "m40slave"
 window to access the "Guide CCDs - WFI" chooser.

Hit VNCviewer - this downloads display from m40slave (= m40spare).
Should see icons for WFI GS selector and Maxim. Run Maxim. Get the main
gui up by hitting the CCD control toggle button on the upper
menu bar.  Go to setup/restart (don’t worry about the "controller
off" message).  Need to scroll window up and down to access the
bars at the top and bottom.  Don’t forget to put in the dec in the
main gui.

Settings for guider:  make sure x,y axes enabled. Aggressiveness 4
is OK. X speed 10, Y speed 4.83, x axis cal time 1, y axis cal time 3.

On the guider display: all RA, dec buttons push the image.
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TELESCOPE & DOME
================
**Red Emergency STOP buttons**
 One is on dome console
 One is on electronics rack in control room

Typically, you will run the telescope from the control room while observing
and from the dome when starting-up/closing-down, setting up for dome-flats,
filling dewar, showing-off to visitors, etc.

To transfer control TO dome:
 1/ On ETS PC select Configuration|configure. Toggle Dome Control to manual.
 2/ Go to dome.
 3/ On dome console: switch to slew/set
 4/ Move telescope, dome and floor as necessary
 5/ Hit big red STOP button if filling dewar or stopping observing.

To transfer control TO control-room:
 1/ Hit "emergency-stop reset" button (illuminated beside STOP button)
 2/ Ensure floor is fully down
 3/ Switch to auto
 4/ Go to control room
 5/ On ETS PC select Configuration|configure. Toggle Dome Control to automatic.

Telescope
---------
Telescope RA tracking sometimes drops out. Just redo the tracking command
to restart.

SDSU Cooling
------------
The SDSU controllers are cooled by the NESLAB cooler (downstairs in corridor
through library on the left)

If controllers get hot, probably means NESLAB has failed.
Check temperature of controller heat sinks occasionally - touch them.

CAMERA SHUTTER
==============
The shutter is badly designed. At large easterly hour-angles (>~4hrs) it
fails to reset. Recognise this by the star trails on an 
image (trails on CCDs 1-4 trail up, on CCDs 5-8 trail down). There will be
a ramp in the signal across the CCDs too. [need an example image here]

To fix, you will need to prime the shutter manually.

You can listen to the shutter operation (loud CL-LICK on open and close)
with control room door open. A failed shutter sounds different, a woosy,
fainter click. You’ll just have to listen! [need an example sound file here]

Priming the shutter
-------------------
Transfer control to the dome.
Move telescope to ~-45deg dec, HA=2.5hrs East. Move floor up to the level
of step 5 on the concrete stairs. This gives access to the big electronics
rack on the side of the telescope tube.

Follow the procedure in the "Observers Technical Guide" and/or Shobbrooks
procedure.

But then test the shutter is working again:
 -return prime switch to NOR
 -toggle mode switch to manual
 -toggle display switch on
 -toggle shutter switch open and closed to test.
  (Don’t forget to wait 8 seconds for the shutter to reset after closing)
 -Return all four switches UP before resuming observing.

Shutter Priming Delay
---------------------
The shutter takes a few seconds to prime, so need to **wait** 8-10 seconds
after closing the shutter (eg after acquiring guide star) before exposing. 

IRAF
====
WFI produces mosaiced images. In iraf need to specify the extension number in



WFI/40inch Help Notes http://www.mso.anu.edu.au/observing/40in/WFI_40inch.html

8 of 9 16/05/05 11:48 AM

the filename, as below.

Hopefully you’ve used IRAF before!
If not see http://msowww.anu.edu.au/computing/lun/lun35/lun35.html
 Set the terminal type as xgterm (at the prompt after mkiraf)
 and edit login.cl (or loginuser.cl) to set
   set stdimage = imt4096
   set imtype   = "fits"

Then:
 ximtool &   :brings up an ximtool to display images in.
 cl          :starts iraf

And:
 display filename[#CCD] 1

 imcopy filename[#CCD][xmin:xmax,ymin:ymax] outfile.fits

 imexamine filename[#CCD][xmin:xmax,ymin:ymax]
  image operations: v does plot from two cursor input positions
                    r gives radial profile of star, fwhm etc
                    a gives mag and fwhm etc for star, no plot

Even for a single CCD readout or a small region readout, need
the extension filename[1]

Use the mscred package in iraf to reduce mosaiced images.

ds9, saotng are nice alternative display tools. ds9 can handle
mosaics.

3/ TROUBLESHOOTING
==================
If stuff goes wrong...
Here are some possible causes. Solutions are in these notes or somewhere
in the sources listed above. Sorry, I didn’t have time to finish this quite
the way I would have liked. But I’m sure you’ll manage :)

First, follow the suggestions above to keep Cicada as stable as possible.

In control Room
---------------
My object doesn’t appear on Ximtool after readout?
 -Cloud
 -Dome is blocking view
 -Dome shutter blocking view
 -Camera shutter failure

I see streaks on my image?
 -Camera shutter failure
 -Initialise hardware (a last resort)

I can’t analyse images (star profiles, stats, etc) in ximtool.
The image just goes to a single value!
 -start a private ximtool in GIT.

Cicada has hung?
 -Exit Cicada, cleanup, restart Cicada.
 -Stop processor/memory intensive processes
 -Avoid using abort
 -Don’t use pause

Lots of Red Error Windows, Can’t Stop Them!
 -Kill Cicada from the command line, cleanup and restart

I can’t point the telescope more accurately than 20arcsec?
 -Tough! The telescope only points to within about 20arcsec
 -But, use buttons on round focus/guide/set paddle. Use set or guide speeds.
  With practice this becomes fairly accurate (to within a few pixels).

Ximtool menus are inactive
 -untoggle NumLock

I can’t change brightness/contrast using left mouse scrolling?
 -untoggle NumLock

New images keep loading into my private Ximtool?
 -turn off automatic loading of images by toggling the "cicada mode"
  button under the GIT options|preferences|general menu.
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  (This is suposed to work, but doesn’t)

My star images are elliptical
 -focus telescope

Focussing is difficult
 -too bad!
 -try focusing from same direction to take up backlash

There is bleeding on stars & bias has changed
 -restart cicada.

I can’t see my guide star (while setting up guiding) 
 -Open the shutter!

I can’t find the "Guide CCDs - WFI" chooser window
 -scroll down in the m40slave window

Autoguiding doesn’t seem to be working accurately
 -set the declination correctly on the "guide" tab in the Maxim CCD window

In Dome
-------
Dome doesn’t follow telescope?
 -Check dome position encoder (high on the western wall) is flashing its
  green LEDs at you. If not restart ETS (select file|shutdown, then startup
  at the prompt).
 -Put dome in auto mode on ETS (select configuration|configure)

Telescope pointing is bad
 -Calibrate the pointing
 -Reset the time (Phone 1-1194)

Telescope doesn’t move
 -ensure floor is fully down
 -Fault in ETS (Call technical support?)

Telescope moves unexpectedly by itself
 -Press big red STOP button on dome console, or on electronics rack in 
  control room

Shutters don’t move
 -press shutter|stop button and try again (Listen for the relays clicking
  downstairs)
 -If upper shutter doesn’t close it needs to be driven fully open (onto its
  springs) first.

LN2 leaking from filling tube?
 -Tighten the various nuts on the tube

LN2 leaking from camera dewar at high ZD angles?
 -Remove lens-cap before filling camera dewar
 -do dome-flats before filling camera dewar

LN2 small tank pressure low?
 -small tank needs filling from large tank (call technical support?)
 -pressurise small tank with N2(or air?) line (How?)

SDSU controllers feel hot
 -Water cooler has failed. Check it and restart it, if necessary.

Dewar vacuum rising or focal plane temperature not holding
 -pump dewar (call technical support?)
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LOCATION BASED SOLUTIONS FOR ONLINE MAPPING Home | Contact Us

ADELAIDE CANBERRA DARWIN MELBOURNE PERTH BRISBANE SYDNEY HOBART

 

   NEW SOUTH WALES MAP  

Buy this map & Integrate into your website

Back To Normal Map

THE LOWEST PRICE IN AUSTRALIA - GUARANTEED ! (All prices below inclusive of GST)
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KINGSTON
512MB
SD card

$66

BILLIONTON
BLUETOOTH
Headset for
Mobile Phone

$68

PRINCO
BLANK DVD
4 speed
(50 pieces)

$21

RITEK
Blank DVD-R
4 speed
(50 pieces)

$29.80

©1999-2005 Street-directory.com.au. All rights reserved. This site is developed by Virtual Map (Australia) Ltd
Disclaimer - User Agreement - Copyright - Privacy Policy

Canada Ritek Ridata Disks
Cheap prices high quality 4x,8x,12x 
Paypal. Fast service and shipping. 

Blank Dvd Ram Media
Buy DVD-Ram media for less. Order
now and receive free shipping. 

Duplication.ca
Sale: up to 20% off! Audio, video, and 
data supplies 

blank 4x 8x DVD-R 18¢
Ritek 8x G05 29¢ G05 White 31¢ 4x
DVD 18¢ 4x White 18¢ Piodata 25¢
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How to get to Siding Spring Observatory
From Sydney
Coonabarabran is about 500 kilometres north west of Sydney and Siding Spring
Observatory is about 40km from Coonabarabran. Most people travel to Coonabarabran
either by air or car, though other modes of travel (train, bus) are possible for the
adventurous or those with time to spare.

Travel options
For detailed information on travel between SSO and Sydney, please refer to the
AAO’s Travel and Accommodation page.

Travelling by road - some advice
It is worth reminding people who travel to or from Coonabarabran by road of the
main risks, which are: 

The standard of even the main highways in NSW varies from excellent to
potentially dangerous and the journey from Sydney to Coonabarabran
involves mainly secondary roads. There are several places where road
conditions change rather suddenly and can catch drivers unaware, especially
if they are travelling fast.
Some stretches of road pass through countryside frequented by kangaroos
which constitute a serious traffic hazard, especially in twilight and at night. Try
to ensure that you start your journey early enough to avoid them when
approaching Coonabarabran.
The road journey between Sydney and Coonabarabran is quite long (around
7 hours). Drivers should be well rested before they embark on it, and should
also stop for short rest breaks along the way.

From Mount Stromlo Observatory

By Air
There are no air services between Canberra and Coonabarabran but check the
AAO’s Travel and Accommodation page for air (and other) services between Coona
and Sydney.

By Car
Stromlo staff and students travel by car from MSO to SSO. It should be possible for
you to share a car with someone else going to SSO for an observing run. The trip
takes about seven hours, so be prepared to share the driving and read the above
warnings about driving on N.S.W. country roads.

If you have your own hire car, ask anyone at Stromlo for advice on directions to
SSO.
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AAO Travel and Accommodation
Want to book your travel for your next observing run? Use our Travel Booking Form.

Travel between Sydney and Coonabarabran

Coonabarabranis about 500 kilometres north west of Sydney. Most people travel to Coonabarabran either by air or car, though other modes of
travel (train,bus) are possible for the adventurous or those with time to spare. For some helpful advice on places along the route to Coonabarabran
and Siding Spring, please go to our Librarian’s information on the Road to Coona

By air: Either via Dubbo Airport, which is the closest main airport in the area, or Coonabarabran Airport*
*NOTE: BIG SKY EXPRESS has suspended it flights to Coonabarabran until further notice. A review is planned for April 2005, and any
developments will be posted here.

If you require further assistance please contact the Travel Officer.   
  
 

Dubbo:
The next closest airport is Dubbo, which is currently only serviced by Qantas (code sharing with Eastern Airlines.) Details of services and
charges can be found on their web site (you can also book on-line): www.qantas.com.au

Getting to Siding Spring from Dubbo Airport: 
If you want a taxi booked, please let us know on the travel form and we will arrange it. The taxi fare is now $AUD  350 each way and takes
about two hours.

You can also arrange a hire car. It would be wise to do so in advance. (See the warnings below relating to car travel.) Thrifty Car Rental
operates out of Dubbo airport. Further details on their web page: 

By car:
      Road travel notes are available here.
It is worth reminding people who travel to or from Coonabarabran by road of the main risks, which are:

The standard of even the main highways in NSW varies from excellent to potentially dangerous and the journey from Sydney to
Coonabarabran involves mainly secondary roads. There are several places where road conditions change rather suddenly and can
catch drivers unaware, especially if they are travelling fast.
Some stretches of road pass through countryside frequented by kangaroos which constitute a serious traffic hazard, especially in
twilight and at night. Try to ensure that you start your journey early enough to avoid them when approaching Coonabarabran.
The road journey between Sydney and Coonabarabran is quite long (around 7 hours). Drivers should be well rested before they
embark on it, and should also stop for a short rest breaks along the way.

It is possible to hire a car in Sydney to do your round trip to site. The prices for the main hire car companies vary slightly but for under 5
days $60.00 to $70.00 is about average per day, plus, in some cases, an additional kilometre charge.
The AAO usually books hire cars through Red Spot Car Rentals, or Avis Car Rentals. Both companies deliver to where observers are
staying in Sydeny, and pick up the returned vehicle, for no additional cost (within a 10Km radius of the nearest rental office). Their rates are
also fairly competative, with Red Spot averaging at $42 per day. 
Alternatively, Bayswater Car Rentals is even cheaper, however clients must pick up the vehicle in person at the Kings Cross office, and
they are not open on Saturday afternoons or Sunday all day. The Travel Officer can book the car if instructed to do so on the Travel Form

 
By train:

The CountryLink division of State Rail offer a linked train/bus service to Coonabarabran, this has the longest journey time but the
train leg through the Blue Mountains is very picturesque. The service departs from Sydney Central Railway  Station, arriving in
Lithgow 2hrs and 20 mins later. In Lithgow meet the coach to Coonabarabran, which takes between 5hrs to 5hrs and 25mins. The
total cost is $AUD119.00 return. A combination train/coach ticket can be purchased as one ticket from the CountryLink office.
The website for CountryLink is www.countrylink.nsw.gov.au
(Note: Currently, the website does not include a complete schedule for the train/coach between Sydney and Coonabarabran.)
For international visitors, you will find information on international agents for CountryLink on their website. These are listed in the
‘Bookings’ section under ‘International’. You are able to book the ticket through an agent closest to you.
For Australian observers, the bookings phone number within Australia is 13 22 32
The current schedule is as follows:
TO COONABARABRAN:
MONDAYS:
Sydney to Lithgow; 7.10 - 9.30
Lithgow to Coonabarabran; 10.00am - 3.25pm
TUESDAYS, WEDNESDAYS, THURSDAYS:
Sydney to Lithgow; 7.10am - 9.30am
Lithgow to Coonabarabran; 10.00am -2.50pm
FRIDAYS:
Sydney to Lithgow; 7.10am - 9.30am
Lithgow to Coonabarabran; 10.00am -2.50pm
SATURDAYS:
No Service
SUNDAYS:
Sydney to Lithgow; 4.00pm - 6.45pm
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Lithgow to Coonabarabran; 7.05pm - 12.15am
TO SYDNEY:
MONDAYS
Coonabarabran to Lithgow; 12.35pm - 6.05pm
Lithgow to Sydney; 6.25pm -8.50pm
TUESDAYS, WEDNESDAYS, THURSDAYS
Coonabarabran to Lithgow; 1.00pm - 6.05pm
Lithgow to Sydney; 6.25pm - 8.50pm
FRIDAY
Coonabarabran to Lithgow; 9.50-2.50pm
Lithgow to Sydney; 3.05pm-5.45pm
SATURDAY
No service.
SUNDAY
Coonabarabran to Lithgow; 1.00pm - 6.05pm
Lithgow to Sydney; 6.25pm - 8.50pm

Top of AAO Travel

Home Contact Us Sitemap Feedback Privacy Statement

© Anglo-Australian Observatory 2004, PO Box 296, Epping NSW 1710 Australia

travel@aaoepp.aao.gov.au

26 October 2004
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Accommodation Facilities at Siding Spring
Accommodation on Siding Spring Mountain is at The Lodge, which is run by the
Australian National University. Bookings must be made well in advance of your
observing run.

The current Lodge tariff is $113.30 (including GST) per day, including meals,
and can be paid with a Credit Card (VISA/MASTERCARD/BANKCARD), in
Australian dollar traveller’s cheques or Australian currency. Personal cheques
drawn on an Australian Bank are accepted.

Partners can stay at The Lodge (1 or 2 larger rooms are available) for an
additional charge (this covers the extra meals and linen required). There is also
a self-contained cottage on the mountain for families; enquiries about its
availability should be made directly to The Lodge staff (Tel   +61   2   6842  
6246,    Fax   +61   2   6842   6252).

Lodge staff are usually able to cater for special dietary needs or preferences,
but prior arrangement should be made. Alcoholic beverages may be consumed
at The Lodge, but strictly on a BYO (Bring Your Own, there is a bottle shop in
Coona) basis. Two meals are prepared each day - a breakfast/lunch (you
choose depending on your body clock - just let the kitchen staff know the night
before) and dinner served before twilight each day. There is also a small kitchen
available 24 hours a day where Lodge guests can make their own tea, coffee or
breakfast if they choose. A "midnight lunch" is normally provided for observers
to have with them at the telescopes.

The Lodge reading room has a range of recreational reading matter, including
the latest newspapers. There is a small library of videos for those cloudy nights
as well as a pool table and dart board in the recreation room. A washing
machine, dryer and ironing board are also available.

SSO Accommodation Booking Form

This form uses JavaScript and cookies, so will not work if you have disabled
either of these in your preferences. You will need to turn these features back on
and reload this form.

 

NB: This service is for observers external to RSAA only.
RSAA staff should follow the internal admin procedure.

 

Please enter your name (required): 

Please enter your full e-mail address (required and where the system will send 
auto-replies): 

Is your host institution in Australia or a foreign country? (required) Australia
foreign country

Please specify the name of your host institution (required):

Please enter your arrival details (required) — Time:   : 0000 Date:   -   -
   (dd-mmm-yyyy)

Please enter your departure details (required) — Time:   : 0000  Date:   -
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  -    (dd-mmm-yyyy)

If you are flying into Coonabarabran please give your flight details:

Do you need a taxi to pick you up from the airport? Yes No

If you are flying out of Coonabarabran please give your flight details:

Do you need a taxi to take you to the airport? Yes No

Do you need to book accommodation for more than yourself (e.g. partner, 
children)? Yes No

Please enter the names of any other guests accompanying you 
(comma-separated):

Please specify any special requirements (i.e. dietary needs etc.):

Submit Booking Request  Reset Form
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After hours support - Siding Spring Observatory

The telescopes operated by the ANU (RSAA) at Siding Spring (2.3m, 40", 24", 
16") are covered after hours by the following arrangements:

A member of ANU SSO Technical Staff is present at the Observatory until 
18:00. This person can be contacted in the 16" dome or on the mobile
phone number posted in each dome.
A member of ANU SSO Technical Staff is on-call from 18:00-22:00 each 
working day. This person’s name and contact details are posted in each
dome.
A member of ANU SSO Technical Staff is on-call from 11:00-23:00 at 
weekends and public holdays EXCEPT that there is no support during the 
Christmas and Easter holidays

Computer problems at the SSO telescopes are covered by an informal
arrangement as follows:

If possible, first consult with the on-site SSO Technical Staff member
The following staff have agreed to offer advice by phone, but no later than 
10:30 pm. On occasions and at their discretion, they may offer further
assistance. If problems arise before 10:30 pm, call the staff listed in the
order on the following list.
Jon Nielsen
Greg Wilson
Bill Roberts
Peter Young
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